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Chapter 1 – Introduction 

Video: Acquiring Excel 2016 and Information on Installation and Upgrade 

Toby: Hello and welcome to our course on Excel 2016. My name is Toby and I am in your 

instructor on this course. I’m based in the UK and I am a Microsoft certified professional and 

one of my main specialties is in Microsoft Excel. In fact I’m a MOS Excel specialist.  

Now I’m sure you’re keen to get started on learning Excel and we’re going to get started on it as 

soon as possible but I do have some very important things to tell you about in this section. If 

you’ve used Excel before it will still be a good idea for you to follow through this section. You 

may be able to avoid the very last part where I talk about how to acquire and install Excel. If you 

already have Excel installed you probably don’t need that part. But I’d like you to stick with me 

for most of this section. 

First of all then, who is this course for? Well primarily I’ve written this course for people who 

are completely new to Excel. Now I do assume that you have a good basic knowledge of 

Windows and I do assume that you’re familiar with some of the terms I’m going to use in terms 

of operating a modern Windows PC. You’ll understand things like keyboard shortcuts and you 

might even be using a touch device. I’ll come back to touch devices in just a moment. 

If you have used a much older version of Excel, say pre-2007, you might also find this course 

particularly useful because since those early versions of Excel a lot of things have changed. For 

example, there’s no longer a menu system. We now use a Ribbon. 

If you have used more recent versions of Excel, say Excel 2010 or Excel 2013, the changes in 

Excel 2016 are mainly in more advanced topics. So in things like BI, Business Intelligence, and 

in pivot tables. There are not really many changes that affect the basics of Excel. There are one 

or two new features as you’ll see early on in this course but most of the features at the basic to 

intermediate level have not changed substantially from Excel 2013 to Excel 2016.  

Also, if you’ve used another spreadsheet product and you’d really like to learn Excel many of the 

features of that other spreadsheet product will probably be very similar to Excel. So for example, 

you’ll be familiar with the ideas of rows and columns and cells. But it is important that you 

follow through this course systematically because it’s the details where products tend to differ. 

And whereas in another product you may be able to say add the values of some numbers in a 

column in one way in Excel it might well be completely different.  

So really this course is aimed at complete newcomers, people who have used other products but 

want to learn Excel and people who have used much earlier versions of Excel than 2016.  

Now if you have used a more recent version of Excel I will try to point out at various times 

where the main new changes are so that you can pay particular attention to those.  
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The next very important point is that particularly with Excel 2016 as with the rest of Office 2016 

you now have versions of Excel which are different on different devices. So you have the 

conventional desktop copy of Excel, either the PC version which is the version we’re using here, 

or the Mac version. But you also have versions of Excel that can run on devices such as tablets 

and that can also basically run in a browser, what’s called the Office Mobile Apps, and 

specifically here the Excel Mobile App. This course is about the desktop version of Excel, if you 

like, the conventional version, the version that some people call the full fat version of Excel, the 

one with everything in it. The mobile apps are very good, particularly if used on mobile devices 

but they are still cut down versions of the desktop apps and it’s the desktop app that we’re 

looking at in this course. 

Given the number of devices that you can now run Excel on it’s not surprising that you may well 

be considering operating Excel using a touch device, using your fingers rather than using a 

keyboard or mouse. On this course I am primarily using a keyboard and mouse. I will 

demonstrate some items using touch. The device I’m recording this course on handles both 

keyboard and mouse and touch. And in fact you can also use gestures in front of the screen, 

although it’s rather difficult to record those on a course like this. But primarily I’ll be using 

keyboard and mouse.  

Now from this point onwards in this section I’m going to be talking about the requirements to 

run Excel 2016 and how you can acquire it. So if you’re already running it you may not need to 

watch the section beyond this point. I still recommend that you follow it through because 

hopefully the information I’m going to give you and the links I’m going to be indicating will be 

helpful to you.  

Just before you leave if you’re going to though just point out that I’m running on Windows 10. 

So I’m going to be using Excel 2016 on Windows 10 on this course. 

Now the system requirements for Office get more complicated every time I look at them. And 

because there are so many ways that you can get Office and therefore Excel now, so many 

different configurations there are a lot of different system requirements. Looking at the list here 

you have sort of five routes really. You have the Office 365 subscription plans whereby you 

basically buy a subscription to Office 365. It gives you some online facilities and in most cases 

you get the downloadable desktop applications as well, although not in all cases. So make sure 

that if you’re going to use an Office 365 subscription to follow this course that you do get the 

downloadable Excel 2016. 

You can buy the Office 2016 Suite. So you can buy a suite of desktop applications which is only 

the desktop applications. You do get one or two other things as well. You get things like Cloud 

storage, come back to that later. 

You can also run Office 2016 and therefore Excel 2016 on certain Office server products. And 

you can still buy Office standalone applications. So for instance, you can just buy Excel 2016 as 
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a standalone application. You don’t have to get it as part of Office, although an awful lot of 

people do.  

So let’s suppose you decide to buy an Office 2016 Suite that will include Excel 2016. Amongst 

the options are Office, Home and Student 2016 and the requirements listed there include the 

available operating systems, Windows 10, Windows 8.1, Windows 8, Windows 7.1. If you’re 

still on Vista or XP I’m afraid you’re out of luck as far as Excel 2016 is concerned. You’re going 

to need to upgrade your operating system. At the time of recording, of course, Windows XP is 

already obsolete and of course Vista’s days are numbered now as well. 

So the first thing to do is to check that your hardware is up to running Excel on its own. If you’re 

going to buy the standalone product or Office 2016 in one of its various configurations and then 

you also need to make sure that you have a suitable operating system.  

Now something to bear in mind, whenever I show you pages like this one from Microsoft.com or 

Office.com is that these pages by the time you see this video have probably been changed and 

updated. So you always need to go to the relevant link in order to get the latest information. The 

link itself of course may change. So my advice usually is to go to Microsoft.com and use the 

Search facility and in this case you’d search for system requirements for Office to see the latest 

version of this information. 

So if you haven’t got Excel 2016 yet how do you get hold of a copy? Well, first of all you check 

that your hardware and your software are up to the job, as I indicated just now. Then you either 

buy a copy or you get a free trial version. You can buy a copy from your local computer store 

probably. You can buy copies online either from Microsoft themselves or from other well-known 

online retailers and I’m sure you know who I’m talking about. Or you can get a trial version. 

There’s a try for free version here for home or for business. So let’s say I try for free for home 

and that gives us the option to try Office 365 for free. Now I won’t keep saying this but I will say 

it just this once more. Don’t forget, these pages may well have changed by the time you come to 

use this video and this trial offer may also change. But basically at the time of recording this it’s 

fairly typically a one month free trial based on Office 365. So that’s a pretty good deal. And if 

you crack on with it you can probably get through this course in a month, including doing the 

exercises and then you’ll be fully confident in Excel before you actually spend money on it. 

One thing that I certainly won’t be covering on this course is how to install and activate Office 

2016 or Excel 2016 on your device. There are so many different options now that you really need 

to go to Microsoft.com to check that. For example, if you go to Office 365 Frequently Asked 

Questions and scroll down there, there are a couple of very useful sections here. There’s a 

section on Office trials which will tell you about the setup for trials, the steps you need to take to 

sign up for a trial, for example. And then further down on this page it’s got sections there such as 

How do I install Office, How can I install Office on my Mac and so on. So the instructions you 

need are there embedded within these pages with links to various other locations on 
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Microsoft.com or Office.com. That’s a much better source for information about installing 

Office or Excel than I can provide. And of course you should always looks for the most up to 

date information.  

So from this point onwards I’m going to assume that you have Excel installed. And from my 

Windows 10 desktop what I’m going to do is go down to the Search box down there and start 

typing Excel and there is Excel 2016. Note desktop app. It’s the desktop app that we need. And 

when Excel 2016 starts up you should see something like this. Now I’m going to explain this 

screen to you a little bit more in a couple of sections time and that’s where we’re going to carry 

on and start using Excel but I’ve got one or two other things to explain first and the first of those 

is the location and use of the course files and the exercise files that we’re going to be using 

throughout this course. And that’s what we’re going to cover in the next section. 

So the first thing you need to do is to make sure that you can start up the Excel 2016 desktop app 

and that you can see something like this. That’s the end of this section. I’ll see you in the next 

one. 
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Video: Exercise Files 

Toby: Hello again and welcome back to the course.  

What you’re looking at at the moment in File Explorer is a list of the course files that are 

provided as part of this course. There are quite a few of them, right about 45. This list may not be 

absolutely accurate but it should be pretty close. And it’s a rather strange looking list of files but 

as you work through the course these are the files you may want to refer to if you want, for 

example, to try the things that I do during the course.  

Some of the files, for instance Business Expenses.xlsx, goes through a number of versions. You 

can see them numbered there, 2, 3, 4, 5, 6, and so on. And these versions of each file correspond 

to the development of the file during the course. So we start off with Business Expenses.xlsx. 

We do a certain number of things to it in the course and I save that as Business Expenses 2. A 

little bit later on we do some more work, that’s Business Expenses 3 and so on. You should 

normally be able to match the version of the file to the particular work that we’re doing during 

the course. By looking at the top of the screen you’ll see the particular file name of the file that 

I’m working on. 

I do strongly recommend that you keep the original somewhere safe because if you do work on 

one of these files and something goes wrong, you break it, you do something, you can’t really 

figure out what you’ve done wrong. It’s always good to be able to go back to the original. 

Now this second folder, the Exercise folder, contains the exercise files for the course. And in 

essence these correspond to the nine exercises that I set during the course. Now there are one or 

two slight complications there. For instance, for Exercise 6 there are two files. There’s a PDF 

and an XLSX. And for Exercise 2 and Exercise 9 I provide you with the A file to start you off 

and the B file is my sample answer. In all other cases 1, 3, 4, 5, 7, and 8 the file that I provide 

there is my sample answer to the exercise. Once again I strongly suggest that you keep the 

originals of all of these in case something goes horribly wrong and you want to refer back to the 

original. 

That’s it. Make sure you get both lots of files downloaded and you know where they are. I’ll see 

you in the next section. 
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Chapter 2 – What’s New 

Video: New and Improved Features in Excel 2016 

Toby: Hello again and welcome back to our course on Excel 2016. In this short section I’m 

going to talk to you a little about what’s new in Excel 2016. Now of course for those of you who 

are new to Excel you won’t really know what’s old in Excel 2016 so this may not really help you 

very much. But for those of you who are looking for an update let me just give you a brief 

overview of what is new. 

The page that I’m looking at now is on Office.com and it lists the new and improved features in 

Office 2016. If you work your way through the contents of this page you’ll see that many of the 

features apply to Excel. And in fact some of the major features which are specific to Excel are 

really at a much more advanced level than the level we’re going to in this course. So for 

example, there are some much improved features in relation to what’s called BI, Business 

Intelligence, and in relation to pivot tables. But there are also some new chart types and we’ll be 

looking at charts later on in this course.  

And a particular new feature which is pretty much across the board in Office 2016 which is the 

Tell Me feature. Another broadly available feature is the extension to the available Office 

Themes and I’ll be looking at that quite early on in this course. 

Many of the other features such as those related to Sharing and features such as Smart Lookup 

we’re either going to look at much later on or in a later one of our series of courses or in one or 

two cases such as Smart Lookup it’s probably a good idea to try it out yourself early on in your 

use of Excel 2016.  

So there are a few of the key points which have broader application. If you want to see the new 

and improved features specific to Excel, if we click on Excel here that takes us to this page 

which gives us information about the six new chart types and then about those more advanced 

features, Get and transform, One click forecasting, 3D Maps. And then those specifics that I’ve 

already mentioned, one of them being Tell Me which we’re going to look at a little bit later on in 

the course, Smart Lookup which you might want to read up about and try out for yourself. You’ll 

find it on the Review Tab on the Ribbon in Excel 2016. You’ll know what I mean by that a little 

bit later on. And then we also have details of the new Themes. Again, we’ll be looking at that in 

a little while on this course. 

So there’s some useful information there about what’s new in Excel 2016. Some of it really 

won’t mean much to you at the moment but hopefully by the end of this course quite a bit of it 

will. That’s the end of this section. I’ll see you in the next one. 
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Chapter 3 – Using Touch 

Video: Overview of Principles of Using Touchscreen 

Toby: Welcome back to our course on Excel 2016.  

Now before we actually get started on making an Excel workbook I want to talk very briefly 

about the use of a touch device. Now those of you who intend to follow this course using a touch 

device, either all of the time or some of the time, need to know one or two very important things 

before we really get started and that’s what I’m going to cover in this section. 

Now before I go any further I should point out we are dealing with the full desktop Excel 2016 

application. There is a specific cut down version of Excel designed for use with touch devices, 

with devices with small screens such as phones and small tablets. That’s not the version of Excel 

that we’re using here. We’re using the full desktop application. But you can use it with touch.  

Now as I’m going to show you in the next section if I wanted to create a new workbook I would 

click on one of these templates, in this case I’m going to click on that blank workbook template 

there, and it’s going to create a new, empty workbook. Up in the top left hand corner of the 

screen there’s something called the Quick Access Toolbar. And one of the commands that you 

should see on this toolbar is this little picture with a little finger pointing at a button. And if I 

click on the little arrow to the right of it it lets me switch between the two modes of using Excel, 

mouse mode which is the mode I’m going to be using almost all the time and touch mode.  

Now what touch mode does, as it tells you there, is that it gives you more space between 

commands and then Excel is optimized for use with a touch device. If you’re going to use a 

touch device and follow the course with a touch device mostly it will be absolutely fine but I do 

suggest that the very first thing you do once we start up Excel and start creating workbooks is to 

switch to touch mode.  

Now look what happens to this Ribbon along the top of the screen here when I switch to touch 

mode. Look at all of those commands. Everything is spaced out more. In fact the commands that 

you can see seem to dramatically change. They perhaps haven’t changed quite as much as you 

think they have but they’re definitely more spaced out. And the reason they’re more spaced out 

is it enables you to operate Excel with your fingertips. Having that extra bit of spacing makes it 

much easier to target the particular commands that you’re trying to use.  

Now there are some other differences as well when you employ touch mode. For instance, these 

little rectangles within the main window here called the cells of the workbook, if I click on one 

of them with the mouse which is what I’m going to do here you see the cross cursor there. If I 

click that cell is selected. You notice the little rectangle with it. Now let me select a different cell 

but this time I’m going to use my fingertip. I get a different selection marker there. I get that 
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rectangle but with the two little circles, one on each corner. So that gives me a completely 

different selection shape.  

In addition let me select a different cell again but this time instead of just tapping with my 

fingertip I’m going to tap and hold. Watch what happens. I get a bigger square if I hold for long 

enough. Now when I release my finger I not only have that cell selected but I have what’s called 

a mini toolbar, a set of the tools that I’m most likely to use having selected a cell. And on that 

mini toolbar, the right hand end I have a little dropdown arrow. And if I tap on the dropdown 

arrow I get what’s called a contextual menu. Now these are features associated with using touch 

in Excel 2016. There are more of them and I’ll talk about more of them later on but I do suggest 

that if you are going to use a touch device soon as we get started switch to touch mode and you 

will see some different behavior in terms of things like the shape and size of that mini toolbar, 

how selections look and so on. But generally speaking you’ll be able to follow the course fine 

but some things as you’ve seen here will look just a little bit different. 

Having said that if you have a straightforward choice between touch and mouse and keyboard I 

do suggest you use mouse and keyboard because it’s much easier to be accurate and that’s the 

approach that I’m going to be using almost all of the time. 

And one final point is that with the release of Excel 2013, not 2016, there was a blogpost on 

Office.com explaining in quite a bit of detail how touch can be used very effectively with Office, 

including Excel, and I still think that’s a very good source of information if you want to find out 

more about how to use touch with Excel. It started out with 2013 but it applies equally to Excel 

2016. So if you want to find out more about that that’s a very good place to look. I haven’t seen 

an equivalent post for Excel 2016 at the time of recording this course. Of course somebody at 

Microsoft may bring one out. And of course there are various other independent posts by people 

about how to use touch with Microsoft Office software. 

That’s the end of this section. Please join me in the next one. 
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Chapter 4 – Getting Started 

Video: Creating and Saving a Workbook 

Toby: Welcome back to our course on Excel 2016. 

As I mentioned before I’m actually using Windows 10 here. And before we start to create a 

workbook and before we actually start work in Excel I’m going to pin Excel to the Windows 10 

taskbar to make it easy for me to start Excel. Now depending on which version of Windows 

you’re using, Windows 7, Windows 8, 8.1, you may want to pin Excel to the taskbar or maybe 

put a shortcut to Excel onto your desktop. Now if you’re not sure how to do those things go to 

Microsoft.com, search on those. There are various links there to explain how to do it. 

In the case of Windows 10 if I just click in the Search box down at the bottom here and start 

typing Excel I soon see Excel 2016. If I right click on that one of the options is Pin to Taskbar 

and I now have a little icon on the taskbar which I can use as a shortcut for starting Excel. Let me 

now click on that icon and Excel starts. 

Now first of all on the left I have a Recent Files list and you’ll see that the recent files list is 

actually empty. So all intents and purposes this is the first time that I’m using Excel on this 

device. If I already have some workbooks, perhaps workbooks that I’ve got from somebody else 

or workbooks that I’ve created in an earlier version of Excel I could use this Open Other 

Workbooks option here but I’ll come back to that a little bit later on in this section. 

Now what I’m actually going to do in this section is to take you on a sort of whistle stop tour of 

creating and saving one or two workbooks in 2016 just to give you a sort of general idea of how 

the whole thing works. Now if I want to create a workbook, a new workbook, which is going to 

be almost the first thing that I do I can start with one of these what are called templates on the 

right. Now if you look at that template, for example, the one I’ve highlighted, Academic 

Calendar. If I were to select that it would give me the option of creating a workbook which can 

be used as an academic calendar and much of the content, much of the structure of the workbook 

that I needed will be contained within that template. Now I am going to come back to templates 

later on so I’m not going to worry too much about them at the moment. What I’m going to do is 

the very first option. I’m going to choose here Blank Workbook which will give me a blank 

workbook. However, a couple of things first. 

First of all I suggest that if you haven’t used Excel before or you’ve only used a very old version 

of Excel one of the first things you do is to take this tour of Excel. I’m not going to go through it 

now. I’m going to leave you to go through that yourself. But it is a very useful tool. 

The other thing that I’m going to do before we create our first workbook is I’m going to sign in 

to an account. Now this is a particular aspect of using Office in general and Excel in particular 
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that gets a lot of people very confused so I’m going to try and briefly explain it here clearly 

enough that you know which account you need to sign in with. 

First of all why do you sign in to an account? Well there are a couple of reasons. Probably the 

main reason is from a licensing point of view and of course Microsoft like all other software 

providers are very keen to make sure that users of the software are properly licensed. So 

generally they want you to sign into an account and then they know who you are and particularly 

that you’ve paid for the software that you’re using. But there are other reasons as well and one of 

them is that to give you access to your Cloud storage, your OneDrive account with Excel 2016 so 

that you can securely and safely save workbooks online so that you can share them with other 

people or in fact with your own other devices. It’s important to sign in securely with an account 

as well. So there are good reasons for signing into an account.  

Which account you sign into very much depends on the nature of your Excel 2016 application. 

If, for example, you bought Excel either as a standalone product or as part of Office 2016 you 

may just sign in with a regular Microsoft account. But if you’ve got Excel 2016 as part of Office 

365 or perhaps as part of your employer’s Office 365 then you need to make sure that you’re 

signing in with an appropriate account that gives you access to the license which you’re using to 

run Excel 2016.  

Now in my case this copy of Excel 2016 is provided via an Office 365 business account so the 

account is in the name of my employer, Toby A. and as an individual person with a license 

within that corporate Office 365 account. I’m just TA. So I’m going to sign in as TA within my 

company.  

Now if all of this sounds like mumbo-jumbo you want to find out more about it. If you click on 

this Learn More link here it gives you access to a pretty good explanation of the sort of licensing 

and Microsoft account factors and explains what you need to do and why you need to do it 

largely. So have a read through there if you’re not clear on which account to use and why you 

use an account at all. But I am now going to sign in as me. 

So put in my email address. But before I go any further you’ll see that email address quite a bit 

actually during the course. I should point out that is not a monitored email address. I don’t reply 

to emails on that email address. So it’s not even worth trying to send me an email because I 

won’t reply to it. It’s only used to access this Office 365 version of Excel 2016. 

So having put in my email address, now my password. And once I’ve successfully signed in as 

you can see at the top right there you can now see my name and my email address. Now it is 

important to realize that I’m not restricted to only running this using one account. So I could 

have this set up to run a number of accounts. So say colleagues that share a PC can each log in 

with their own account to use this instillation of Excel. But I will generally during this course 

stick with that one account from now on. 
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So it’s finally time to create a workbook. We’re going to create a blank workbook. We’re 

creating it from this screen which is called the Start Screen. That name will be important a little 

bit later on. So I’m going to click on Blank Workbook and I get a blank workbook.  

Now the workbook is in effect a set of worksheets and by default in Excel 2016 you get one 

worksheet when you create a workbook. And the name of the worksheet is on this tab at the 

bottom. It’s just by default called Sheet 1.  

Now below where it says Sheet 1 you’ve got a thing called a Status Bar and I’m going to tell you 

about that in a later section. And above the sheet, the sheet is this whole rectangular area here, 

there is an Entry Bar and there is the Ribbon and above the Ribbon you have what’s called the 

Quick Access Toolbar. Now all of these I’m going to be covering in the coming sections in quite 

a bit of detail. For the moment I just want to concentrate on putting some data into the worksheet 

itself.  

Now before I do I hope you remember me telling you, those of you particularly who are using 

touch, about touch and mouse mode. Make sure that you’re in mouse mode if you’re using a 

mouse because you get more commands on the Ribbon and you’re going to find it’s a little easier 

to be accurate when you’re using mouse and keyboard. 

Now looking at this worksheet it’s arranged in a sort of grid and the grid is made up of horizontal 

rows. The rows are numbered. So Row 1, Row 2, Row 3, the numbers are down the left hand H 

there. And there are many rows that you cannot see. You can see numbers 1 to 39 there. But if I 

scroll down you can in fact have thousands of rows thousands and thousands of them. They go 

on apparently forever. 

The columns are vertical and they’re referred to by letters normally, A, B, C, D, E, F, G. 

Although in fact you can switch to numbering those as well but the default is to use letters. When 

you get to Z whoever invented Excel said I’ve got to Z I’ve got to stop there and somebody else 

said, “No, no. Let’s call the next one AA, AB and so on.” And again you can have thousands and 

thousands of columns. 

Now at an intersection of a row and a column you have something called a Cell. And the top left 

cell there, the one that’s currently selected, you can see the border around it, is the cell A1. We 

normally refer to it by its column letter A and its row number 1. So this, for instance, is cell L5 

and this one is G7. 

Now the first thing that I’m going to do rather unexcitedly is to put some data into this 

worksheet. And when a cell is selected to put say a number into it all I need to do is to type the 

number on my keyboard. So what about 23? Now that number having appeared, you’ll notice 

that the cursor is still flashing to the right of the three within the cell and in order to work in 

another cell I need to select another cell. So let’s select the cell next to it, H7, and let’s put a 
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different number in H7. Let’s put in there 19. Again let’s click in I7, put a different number in 

there, 62, and so on.  

In a cell you can put numbers, words, you could show the date, you can do arithmetic, you can 

add stuff up, and you can also format the cells as we’ll see later on. You can change the color of 

the characters, the numbers in this case. You can put a border around the cell. You can do all 

sorts of exciting things with cells. And we’ll be covering those later on in the course. But for the 

moment all I’ve done here is to put a number in each of three cells. 

Now generally speaking when you’re working in Excel and you’re making workbooks each 

workbook can be made up of one or more worksheets. You are going to want to save what 

you’ve done. You are going to want to save your work. 

So the first thing I’m going to do now is to save this workbook. Now in order to do that we go 

into what is called Backstage View or just Backstage. And to access Backstage View we click on 

this word File up here. It’s actually the left most word above the main body of the Ribbon. So 

click on File and it takes us into this Backstage View. And one of the options there is Save As. 

Clicking on Save As as in general with Windows software gives me a facility to save the work 

I’m doing, in this case the workbook as a file and I can save it in one of a number of different 

places. Now this is where things get a little bit more complicated in that exactly which places 

you have available to you will not be the same as the places that I have available to me. Because 

my Excel is via a company 365 account I have a OneDrive location I could save it to, I have a 

SharePoint site I could save it to, I have a personal OneDrive I could save it to, I can also save it 

to this PC. And on this occasion I’m going to save it to this PC. 

Now I mentioned to you earlier on the demo files, the course files that I’m using. I’m going to 

save this in an empty version of that demo file, that course file folder and then during the course, 

as you’ll see, I will build up to the selection of files that you’ve seen already much earlier on in 

the course. And these of course are files that you have access to so you can see these files.  

So from this PC I’m going to browse to that particular folder. So I use a standard Windows File 

browse there and there is the empty folder where I’m going to save this particular workbook. 

Now the default file extension for an Excel workbook is XLSX and I’m going to call this one, 

not a very exciting name I know. I’m going to call it Demo 1. Now it’s quite okay to put spaces 

in file names. Some people don’t like them but I don’t mind them at all. Having put the name in I 

click on Save and my workbook is now safely saved. Not only is it safely saved but if you look 

at the top middle of the screen you’ll see that the name I’ve given it is now displayed at the top 

middle of the screen. A workbook when you create a new one gets a default name like Book 1 or 

Book 2. Once you’ve given it your own name then that’s the name it’ll stick with from now on 

unless of course you decide to change it later on. 

So I’ve created a workbook and I’ve saved it and I’ve put some numbers in it. The numbers are 

rather unexciting. They’re not doing anything useful at the moment. But let’s suppose I’ve 
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finished work for the moment. One option available to me now is to close this workbook. It’s not 

a good idea to leave workbooks open. Somebody might come along, lean on your keyboard, 

accidently put some numbers in there. 

To close the workbook if I go back into Backstage View again one of the option there is Close. 

So let me click on Close. That workbook is closed. And now note that Excel is still open but I 

have no workbook open. The area that was occupied by the workbook and its single worksheet is 

now blank. And this is the point at which we’re going to resume in the second half of this getting 

started part of the course. So, please join me for that. 
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Video: Opening a Workbook 

Toby: Welcome back to this second section on getting started with Excel 2016. 

In this section I’m going starting off exactly from where I left off in the previous section. I 

closed the workbook that I just created but left Excel running. If I now wanted to reopen that 

same workbook, if I go into Backstage View and click on the Open option you’ll see that this 

particular page in Backstage View, the Open page, features on the right a list of recently opened 

workbooks. And of course my list of recently opened workbooks now has one workbook in it. So 

in order to open Demo 1 again I just select it and the workbook is opened and the cursor is 

exactly where I left it when I closed this workbook earlier on. 

What I’m going to do now is to select a number of cells and I’m actually going to select from the 

cell G7, the one with 23 in it, across to J7 which is where the cursor currently is. Now there are a 

number of ways of doing this and one of the ways is to click in G7 and then just move the cursor 

across with the mouse held down and then let go when the cursor is over J7. And I now have 

multiple selection. I have selected four cells. And one of the options on the Ribbon in the Editing 

Group, now the Ribbon is this big rectangle of commands here, and there’s a group on the right, 

Editing, and one of the options in there is AutoSum. And if I click on the right hand arrow to the 

right of AutoSum and select Sum watch what happens. What happens that is in that fourth cell, 

J7, I see the sum of the contents of the other three cells. So you can now see Excel doing 

something useful for me. It is now storing the total of the contents of the other three cells.  

Now one very important aspect of what’s just happened is that if I change the number in any one 

of the first three cells it will automatically update the total. So let’s click into that 19 cell again, 

H7 that contains 19, and I’m going to change the value from 19 to 79. Now in many ways the 

simplest way to change 19 to 79 is to select the cell and just type 79. Having entered that if I now 

click elsewhere, anywhere else within the sheet, my 79 value is accepted and note that the total, 

the sum, has been changed from 104 to 164. So the value in J7 has been updated. And in fact the 

value of any other cell that depends on the value in H7 will be updated automatically as well. 

Now one of the things you may not be happy about is you may be squinting at the screen saying, 

“I can barely see those numbers. They’re so small.” If you refer now to the bar at the bottom of 

the screen, it’s called the Status Bar, I mentioned it earlier on. At the right hand end of there is a 

Zoom control and the zoom control takes the form of a bar. It’s got a minus at the end and a plus 

at the right and it says 100%. I can actually zoom in on my worksheet to make everything look 

bigger. Now this is only how things look. It doesn’t physically change the size of the cells. It just 

makes them appear bigger or smaller. And of course you can adjust this zoom control to suite the 

particular situation that you’re in. 

If I want to zoom in to make things appear bigger if I click on the plus sign once I’m zoomed in 

to 110%. Let’s do it again and again and again and so on. And I can zoom in as far as I like to 
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make things look bigger and easier to follow. If I had a lot of information in a lot of cells I may 

want to zoom out to be able to see more of the contents of the worksheet. 

I’ll be looking at the zoom control in more detail later on but once you have zoomed in if you 

need to move around to the left and right or up and down to see other content in the sheet you 

have these two scroll controls. You have a scroll control at the bottom that lets you move from 

left to right and you have a scroll control on the right that lets you move up and down.  

If you want to reset everything back to 100% zoom all you need to do is to double click in the 

middle of the zoom control and it goes back to 100%. 

Having made some changes to this workbook I will normally want to save the changes. I don’t 

want to do a Save As. I’m not going to save it with a new name. I’m happy with the name Demo 

1 for the moment. I just want to save my work. There is an option in Backstage View, Save, but 

there is also a Save button on the Quick Access Toolbar at the top left. If I hover over there it 

says Save. Click on Save and this latest version of the workbook is now saved. 

On this occasion I’m not going to close the workbook. I’m going to leave it open. I’m aware of 

the dangers of leaving it open. But I’m also going to create a new workbook. Now there are a 

number of ways of creating a new workbook. One of them is to go into Backstage View and 

click on New. And you can see a list of templates very similar to the list we saw before but now 

we’re on specifically a new page. I’m going to once again choose a blank workbook. So click 

Workbook and I’ve now got a new blank workbook. Its name defaults to Book 2. And what I’m 

going to do on this workbook is to put the names of the months of the year in it.  

So there’s the first one. I’ve just typed the name in. Let me type in the second one. Now I’m 

going to go back to the first one and I’m going to use that little blob in the bottom corner of the 

selection box there and I’m going to drag down for a total of twelve cells. Watch what happens. 

What Excel 2016 automatically does for me is to do what’s called a Series Fill. Now I should 

warn you that some of these things people give different names to but this is a series fill and it’s 

already realized from what I put in the first two cells that I wanted to do a series of months. So 

the fact that I typed January, February it said, “Oh what you want here is March, April, May, 

June, July, etcetera.” If when it did what it did, it did something I didn’t want to I have a facility 

where I can automatically undo what it has done.  

Now the Undo button is one of the buttons that’s usually on the Quick Access Toolbar and it’s to 

the right of the Save button. So there’s Save and there’s Undo. And I’m going to undo that 

autofill. Perhaps I thought, “No that’s not what I intended.” But I then say, “Oh hang on a 

minute. That is what I intended.” To the right of the Undo there is a Redo, Redo Autofill and that 

redoes what just happened. So I’m back to where I was before now. 

Let me just summarize the current situation. At the moment we have Excel 2016 running and we 

have two workbooks open. We have Demo 1 open with saved changes and we have a second 
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workbook open. It still has its default name of Book 2 and the changes in that, the sequence of 

month names, hasn’t been saved. So let’s close Book 2 and see what happens. And on this 

occasion I’m going to use the Close button up in the top right hand corner here. Excel says, “Do 

you want to save changes to Book 2?” I do so I click on Save. I browse to my course files folder 

and I’m going to call this book Monthly Accounts.xlsx. Click on Save and that book is saved and 

closed. If I now want to close Demo 1, remember that I have saved these changes, if I use that 

Close button up on the top right again, as soon as I click on Close it’s all closed and I’m not 

asked anything about saving changes because there are no unsaved changes.  

Now when I’ve closed Excel I’m back to my Windows 10 desktop again. If I use the Excel icon, 

the shortcut down there on my Windows 10 taskbar Excel opens. I see the start screen. And note 

now that my two workbooks appear in the recent files list. And if I want to open one of them 

again all I need to do is to click on it to open it and continue to work on that particular workbook. 

Well I’ve really given you a whistle stop tour of some of the main features of Excel in this 

section and the previous one. We’re going to now have a few short sections with some very 

important information, more background information about using Excel, some of the important 

features that you’re going to need throughout the rest of the course, and then we’re going to 

come back and look at each of the aspects of Excel that you’ve seen already in a lot more detail 

and we’ll start to look at even more features of Excel. But that’s it for this section. I’ll see you in 

the next one. 
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Chapter 5 – Using Help 

Video: Online Help and Contextual Help 

Toby: Hello again and welcome back to our course on Excel 2016. 

In this section we’re going to take a look at Help and there is actually a lot of very useful help 

available when you’re using Excel 2016 but virtually all of it is online help which means you do 

need to be connected to the internet in order to take advantage of the help. 

Now first of all very simply to access the Help system you will normally see somewhere around 

about the top right hand corner of the screen a little question mark icon, Microsoft Excel Help, 

takes me into Help. 

Now the Help system is a browser based system. So it runs in a little web browser. As you can 

see there Excel 2016 Help little Search box. I’m just going to make that a little bit bigger.  

Now let’s suppose I want help on Series Fill, something that we did a little bit earlier on in the 

course. Type the term in there, click on the little Search button and it comes up with a number of 

topics related to filling data automatically in worksheet cells. I go to the first one. It takes me to a 

Help page. What do you want to do? It gives me a list of all the things I might want to do in 

relation to Series Fill. If I choose one of those it will either take me to a point on this page or 

sometimes to another page within the Help system. And then I can use the Browse buttons to go 

backwards and forwards through the available help.  

There is a Home button that takes me back to the Help home. There is a Print button where I can 

print a particular Help topic and there’s also this button which will give me larger text on Help. 

So if you have a problem reading to Help of a particular size, let’s try that Series Fill again. At 

the larger size all of the help appears larger and then of course I can shrink it down again if I 

want to.  

So that’s the basics of using Help in Excel 2016. When I finished using Help I can click on 

Close. 

Now there is a keyboard shortcut for bringing up Help in Excel 2016 and you use the F1 key. So 

let me press the F1 key now and that’s an alternative way of bringing up Excel 2016 Help. 

So let’s see what happens now if I try to get help when I’m not connected to the internet. I’ve 

disconnected. I’m going to click on Help and the message I get is: Help is only available online. 

If you’ve used an earlier version of Excel there was always some kind of offline help available 

but there is now virtually nothing available with Excel 2016. So you really do need to be 

connected to the internet in order to get any significant amount of help.  
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Now the expression I used there was any significant amount of help. There are some other ways 

in which Excel 2016 can help you even when you are not online. This is not really the Help 

system but there are various features, some of which you can enable or disable, which can help 

you. For instance, if I hover over a command and my settings are correct I can get what’s called 

a Screen Tip and a Screen Tip can explain to me what a particular command can do. We also 

have a new feature in Excel 2016 that we’re going to look at a little bit later on which is the Tell 

Me feature and there is this box at the top of the Ribbon, Tell me what you want to do, which is 

also a type of help that can be very useful. But in terms of formal help itself you do need to be 

online. 

Now I mentioned earlier on in this section that you’ll normally see that question mark icon 

towards the top right of the screen. Sometimes you don’t. I don’t know whether it’s Microsoft’s 

intention to restore that situation. If you don’t you can always hit the F1 key of course. The 

situation in which you’ll see that question mark is when you are working in some dialogues in 

Excel. You will be able to access contextual help. 

Now let me just explain what I mean by that. Let’s suppose I open up one of the dialogues, the 

one related to font settings, for example. Don’t worry if you’ve got no idea what I’m talking 

about here because I’m going to explain this later on. This dialogue lets me choose the font for 

text and to do things like decide whether it’s going to be bold, the size of the font and so on. And 

many of the dialogues that you use in Excel 2016 have that little question mark icon. Now it is a 

Help icon. If I click on Help not only does it access the Help system but it gives me contextual 

help. It goes straight to a topic which relates to the dialogue that I’ve clicked Help from. So in 

this case it’s gone into a changing the color of text Help topic. 

Now of course I can still use the Help here in the usual way. So if I wanted to search for 

something unrelated to the color of text or anything else to do with text I can carry on use Help 

in the normal way. And then of course when I finish I close the Help by clicking on the Close 

button on the browser. 

So that’s pretty much it for Help at the moment. I’ll be using it now and again during the course. 

Make sure that you become familiar with it. Having said that let’s just try one other thing here 

which you might find useful. If I go into that Help and type “Getting Started” there are quite a 

few topics in here related to getting started with particular aspects of using Excel. Now the ones 

that you can see here first in the list are ones that are really quite advanced topics, things like 

Getting Started with 3D Maps. But for any topic that you want to find out about it’s always 

worth searching the Help to see if there is any sort of getting started or introductory help related 

to that topic.  

Anyway that’s it for this section. I’ll see you in the next one. 
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Chapter 6 – Excel Options 

Video: Personalizing Your Use of Excel 

Toby: Welcome back to our course on Excel 2016. 

In this section we’re going to look at the very important subject of Excel Options. And Excel 

Options are used basically to customize and personalize your installation of Excel and your use 

of Excel. Now in the very early stages of learning Excel many of these options won’t really mean 

very much to you so we will come back to them from time to time later on and I’ll explain the 

options you need as we go through the balance of the course. But before we really get started 

with Excel you need to make sure that a few basic options are setup in the way that you need 

them to be. 

Now although Excel Options will appear at various points during your use Excel 2016 the 

conventional way to access them is from Backstage View. So the first thing I’m going to do is to 

go into Backstage View and one of the pages is Options. It’s the second one from the bottom 

here. And that brings up the Excel Options dialogue.  

Now this dialogue is made up of a number of pages and the first page is General, I’ll come back 

to that in a moment, then we have Formulas, Proofing and so on. And most of these pages we 

won’t really be looking at at all until later stages of the course. But we are going to start with two 

or three of them and in particular we’re going to start with the General page. 

Now I’m going to cover the items on the General page in a sort of haphazard order but there is a 

reason for doing them in the sequence that I’m going to go through them. 

So I want to start with this section, Personalize Your Copy of Microsoft Office, and this selection 

will actually affect the whole of Microsoft Office, not just Excel. First of all your username. 

Now your username will be particularly important if, for example, you are working with others 

on documents and you’re adding comments, you’re annotating, workbooks, etcetera and you 

want to keep a track of who has made whatever comment or even who has made changes to a 

workbook then these can be identified using the username that you’ve set up here. By default it 

gets the username associated with the account that you’re running Excel under but you can 

change that name. Some people use a nickname rather than their real name here.  

Note the checkbox under there to say always use these values regardless of sign in to Office. So 

if you want to use those values whichever account you’re signing into Office with then you just 

check that box. 

Now there are then two settings which also relate to Office in general. That’s the Office 

Background and the Office Theme. Now I currently have the Background set to No Background 

and the Office Theme set to Colorful. My settings are primarily set that way in order to make it 
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as easy as possible for you to see what’s on the screen but you may choose to go for something a 

little bit more dynamic than this.  

One very important point here, let’s suppose that I change the Background to say Underwater. 

You won’t see any particular change happening. And in fact whatever changes you make when 

you are adjusting the Excel Options are only activated when you click Okay. So I’m currently set 

on Underwater Colorful. Just take a look at the top right hand area of the screen when I click on 

Okay. You might just about see there some fishes and various other underwater creatures 

appearing there. It’s a bit difficult to see with the Colorful setting. It’s a little bit easier if I 

change from Colorful to White as my Office Theme. Don’t forget the Office Themes were 

extended in Excel 2016. Let’s click on Okay and you can see the Underwater background there. 

Now the Background and the Themes have varying levels of, if you like, in your face-ness and 

generally speaking they’re quite subdued. But you may want to choose something that suits your 

particular style. 

Now I want to go up to the top of the General page and look at User Interface Options. I 

mentioned earlier on in the course Screen Tips as a sort of help in Excel 2016. And if I hover 

over one of the entries on this page, that one for example, a Screen Tip comes up. Show Mini 

Toolbar on selection. And there is also under that what’s called a Screen Tip Description. So if 

you like some fuller information about the Screen Tip. 

No although in the early stages of using Excel you’ll probably find these very useful they can be 

quite annoying because they can get in the way of things. And when you’ve been using Excel for 

a while you’ll probably get to the point that you don’t really need them. You can switch them 

off. In fact when I’m recording this in many ways it would be better if I switched them off 

because quite often they get in the way of what I’m trying to show you but I am keeping them 

switched on because I think the tips themselves are very useful in the early stages of learning 

Excel.  

Now the way that you control them is using this Screen Tip Style setting here. Show feature 

descriptions in Screen Tips. Supposing I change that now and say Don’t show feature 

descriptions in Screen Tips what do you think would happen if I hovered over that top option 

again? Well of course you still see the whole thing. Don’t forget you have to click on Okay. Now 

if I hover over a command on the Ribbon all you see is the name of the command. It just says 

Merge and Center. Let me go back into options again. Let’s say change that back to Show 

feature descriptions, click on Okay. I’m going to hover over Merge and Center again. Now I get 

Merge and Center and the description. And once again that’s an option that you may want to set 

very early on in your use of Excel and may want to change later on when perhaps the Screen 

Tips become unnecessary for you. 

And one other thing. If you look down at the bottom of the General page, the very bottom option 

there, Show the Start Screen when this application starts. We’ve seen the Start Screen several 
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times already on the course. If you don’t particularly need to see the Start Screen, if you’d like to 

open straight into Excel disable that option and you won’t see the Start Screen anymore. And 

you might want to just try that just to get used to using Excel Options and then if you do want the 

Start Screen you can switch it back on again.  

Now one other option that I’d like to mention early on or in fact one other group is this section 

When Creating New Workbooks. Now it may well be that you want to start all of your 

workbooks with a particular font, perhaps a particular font size, perhaps you need the text to be a 

little bit bigger or you’d like it to be a little bit smaller. You can adjust that here. The other thing 

you’ll notice here and this may be of interest particularly to those of you who’ve used a much 

earlier version of Excel, the bottom option there, Include this many sheets, says one. That 

controls how many empty sheets you get when you create a new workbook and by default it’s set 

as one, as I mentioned earlier. In much earlier versions Excel it was always three. But if you’d 

like to get three or some other number every time you create a workbook you can change that 

there. 

Let’s now turn our attention to the Save page. There are a couple of very important things on the 

Save page. One of them near the top there is Save AutoRecover information and by default that 

is checked. That means that at the interval you select there by default it’s ten minutes. What 

Excel does is to save a copy of your work so that if something goes horribly wrong, for example 

if you’re working on a PC or some other device that doesn’t have a battery or indeed if your 

battery just goes flat in the middle of doing some work you don’t lose what you’ve been doing. 

At least you only lose it back to the last auto save. I strongly recommend that you have 

AutoRecover set because it does mean that you won’t lose hours of work in the event of, for 

example as I said, a power cut or something like that or even a software or hardware failure of 

some other sort. 

The other useful setting here is this one, Default local file location. If when you want to save to 

your computer, not to the Cloud but to your computer you want to by default save in a particular 

location you can set that location here. As you can see Excel has used a default local file location 

as its default. So change that if you’d like to. 

The third page that I’d like to look at now is the Language page. You need to make sure that you 

have the language that you use or languages that you use setup. I use English (United States) and 

English (United Kingdom) more or less 50/50 but English (United States) is set as my default. 

You can add additional languages if you’d like to. There’s a very, very long list of languages 

here. 

And the other thing to bear in mind is that some people, including me in some case, work in a 

situation where they may be working on a workbook which is in one language but their language 

is a different language. So for instance, I might edit a workbook which has information in 

Spanish and I may want to, for example, Spell Check in Spanish. But I’d like all of the display, 

http://www.simonsezit.com/


Learn Excel 2016 for Beginners: Master the Essentials 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 
 

the Help information and so on, in English because I am an English speaker. So you have the 

Editing Languages at the top. If you like the languages that you’re using within the workbooks 

but then here Choose Display and Help Languages. If you’d actually, for example, like to work 

on an English workbook but your mother tongue is French then you may want to set the Editing 

Language English and the Display and Help Language at French. But do make sure that you 

have your language or languages set correctly. 

So they’re the things I’d like you to make sure that you have set correctly before we go any 

farther. Of course you’ll potentially change some later on. Make sure they’re okay. That’s the 

end of this section. I’ll see you in the next one. 
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Chapter 7 – The Ribbon and Toolbars 

Video: Basics of Using the Ribbon 

Toby: Welcome back to our course on Excel 2016.  

In this section I’m going to cover the use of the Ribbon in some detail. If you’ve used a relatively 

recent version of Excel before you may be pretty familiar with the Ribbon and you may well not 

need to go through this section at all. If on the other hand you haven’t used the Ribbon before or 

you’ve used a much older version of Excel, maybe one of the early versions that used the 

Ribbon, or you want to find out about Key Tips or Auto-Hiding the Ribbon then I suggest you go 

through this section because I’m going to try to cover it fairly thoroughly to give you all of the 

basic things you need to know to get the best out of using the Ribbon. 

The Ribbon is this rectangular area here. And above the rectangular area there are individual 

words or phrases and these correspond to the Tabs. The Ribbon is actually made up of a number 

of Tabs. Now you can’t see all the Tabs here at the moment. Some of them are only shown under 

certain circumstances. And you can in fact add your own Tabs. But the ones you see here are the 

basic default Tabs. A couple of exceptions. On the left the word File there as you know gives 

you access to Backstage View. Technically it’s not really a Ribbon Tab at all. And on the right 

we have the new Tell Me feature. So in fact the Ribbon I’ve got here has seven tabs: Home, 

Insert, Page Layout, Formulas, Data, Review, View. If you see a different list to that all will be 

revealed later to explain why that is. 

Now one thing to notice straightaway is that Home is highlighted. We say that the Home Tab is 

selected. But on the Ribbon you see a lot of grayed out controls. Most of those are various types 

of command. They’re ways of doing certain things to your Excel workbooks. But on the Home 

Tab they are currently all grayed out. And the reason they’re grayed out is that you couldn’t 

actually use any of them at the moment. And the reason you can’t use them at the moment is 

because I don’t have a workbook open.  

Now let me open one of the recently opened workbooks. So let me go into Backstage View. 

Let’s try Demo 1 again. And you see that the controls on the Home Tab on the Ribbon are no 

longer grayed out. You could actually use those commands. And in fact if I click on a couple of 

the other tabs, let’s look at the Insert Tab, they are not grayed out either. Let’s go to Page 

Layout, Formulas. Now when you get to Formulas there are one or two, there’s one there, a 

command that’s still grayed out. Now the fact that that’s grayed out means that I couldn’t do 

whatever it does at the moment with my current situation. 

So let’s go back to the Home Tab then and let’s see what we can do. Let’s suppose I type in the 

currently selected cell the word Hello. Now having typed Hello if I click on the Enter tick there 
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next to the Formula Bar now I’m going to go up to the B command here, the one that I’ve 

currently got selected, Bold. I’m going to click that and it makes the text in that cell bold.  

Now the commands on each tab of the Ribbon are divided into groups and the groups are 

separated by these tiny little thing vertical lines. So on the Home Tab you have a Clipboard 

Group, a Font Group, note the names at the bottom of the groups, an Alignment Group, a 

Number Group, and so on. On the Insert Tab you have a Tables Group, an Illustrations Group, an 

Add-Ins Group, and so on. And within each Group you have individual Controls. So for instance 

on the Page Layout Tab in the Themes Group you have a Themes button, a Colors button, a 

Fonts button, and an Effects button. So you have a structure to the Ribbon. You have the Ribbon, 

you have the Tabs, you have the Groups, you have the Controls. 

So let’s look now at some of the other aspects of these Controls. There are very many different 

types and if you take, for example, the one on the left of the Home Tab, the Paste button, it’s 

actually a two part button. Many of them are two part buttons. I’ve currently got the cursor over 

the top half of the button and you notice the Screen Tip there, Paste. Control-plus-V is the 

keyboard shortcut. And then there’s that Screen Tip description. We talked about these earlier in 

the course. Add Content on the Clipboard to your document.  

Now the lower half of the same button, with the arrow, is actually a dropdown which gives us a 

selection of Paste options. And this selection will be dependent on the exact situation that you’re 

in. So depending on what you’re Pasting into and what you’ve got on the Clipboard you’ll get a 

selection of options there. 

Now some of the other buttons like this Cut button here, for example, is straightforward, simple 

button. To the right in the Font Group we have a Font selection dropdown list here. So if I click 

on the arrow I have a list of all the fonts available on my device that I can use. And to the right of 

that I have a list of available sizes. Now sometimes as with this Font Size list although you have 

a number of available sizes, so as you can see here 8, 9, 10, 11, 12, 14. If I selected 12 that’s fine 

but I can actually type in a size as well. So I could type in 13 if I wanted 13 point. So you’re not 

necessarily limited to the sizes in the actual button. 

So the Controls correspond to various types of commands. Some of them are simple click 

buttons. There’s dropdowns, there’s split buttons and so on. And during the course we’ll be 

looking at these many different types of Control and Command. 

Now if you take the Font Group here, for example, there are quite a few commands in there that 

enable you to, for instance, make text bold or italicize it underline it. And as you’ve already seen 

you can change the font you use and the font size and so on. So you have a whole selection of 

buttons and options. But in the bottom right hand corner of the Font Group there is a tiny little 

button that’s called a Dialogue Box Launcher. And if I click on the Dialogue Box Launcher, 

that’s that one there, it brings up a conventional type of dialogue. It’s a Format Cells Dialogue 

and the Font Page within that dialogue is selected. So if rather than use all of those individual 
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buttons you want to use a dialogue like this one, as I say a much more conventional type of 

Control in Excel, you can certainly do that. And many people, including me, sometimes prefer to 

bring up a dialogue and make a whole load of settings at once. And then obviously once I’ve 

made all my selections I click OK to activate them or if I changed my mind, I want to start again, 

I can use the Cancel button to cancel. 

Note the question mark there which will normally take me through to online Help on the 

particular dialogue, possibly the selected page that I’m using at that time.  

Sometimes, let me just cancel this. Sometimes if you go to a regular command like this one, 

Conditional Formatting, you get a dropdown list of possible options. If I go to say Manage Rules 

here I get a dialogue that enables me to manage my Conditional Formatting rules. So there are 

many situations in which dialogues appear and they in turn will have many options and are 

sometimes a better option or a more convenient option than using the individual commands on 

the Ribbon. 

Let me just close that one. 

Let’s move on to some of the ways of using the Ribbon that you may not be familiar with even if 

you’ve used it before.  

The Ribbon takes up quite a bit of space and quite often when you’re working in Office 

programs in general, Excel in particular, space is at a premium and you may want or need to use 

some of the space that’s occupied by the Ribbon. One of the complaints that’s often made about 

the Ribbon is that it takes too much space on the screen. The top right hand corner of the Excel 

window there is a button. It’s Ribbon Display Options. And if you click on Ribbon Display 

Options there are three. There’s Auto-Hide, Show Tabs and Show Tabs and Commands. And by 

default Show Tabs and Commands is selected. That’s basically seeing all of the detail of the 

Ribbon. 

If I switch to Show Tabs watch what happens. The Ribbon itself is no longer visible and all I can 

see is the Tabs. Now you may think that’s going to be a little bit problematic because you think, 

“Well how the heck do I find all of the commands that I need?” You’d normally use this option 

when you’re already fairly familiar with where everything is on the Ribbon. And you don’t need 

to be able to see the Ribbon to find the things that you want. 

So for example, let’s suppose I wanted to make the word Hello in I10 Italic. I know it’s on the 

Home Tab in the Font Group. So all I need to do is to click the Home Tab and then as if by 

magic the Ribbon appears. I find the command I want, in this case the Italic command. Watch 

what happens when I click on Italic. That’s italicized. I could underline as well if I wanted to, do 

anything else I want to it. And as soon as I finish what I’m doing the Ribbon disappears again 

and gives me that space back. 
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Now if at any time I want to switch back to the Ribbon being shown all the time I choose the 

third option.  

Now an even more extreme option is Auto-Hide Ribbon and this hides the Ribbon and the Tabs. 

Now you may think it’s actually quite difficult to do anything at all without being able to even 

see the Tabs but in fact all you need to do is to click up here at the very top and the Tabs and the 

Ribbon itself will reappear for you to do something.  

So let’s say switch off the underlining here and switch off the Italic again and then as soon as 

I’ve finished the Ribbon is hidden once I’ve completed the operations I am performing there. 

You might use this option, for example, if all you want to do is to enter some data into the cells 

in a workbook or to use features whereby you don’t need the Ribbon at all. Believe me it will 

happen from time to time. And then at whatever point you finish with that it’s very 

straightforward to go back to one of the other settings because you still have up here the Ribbon 

Display Options button. You can click on that and you could, for example, go straight back to 

showing Tabs and Commands again. 

Now let me look at a couple of other useful features of the Ribbon. I’ve already mentioned going 

into Touch Mode if you’re using a touch device. Don’t forget the button there that lets you 

switch between Mouse Mode and Touch Mode. And of course in Touch Mode everything is 

spaced out more for your fingers. 

And another very useful feature, particularly for people with certain types of disability but in 

many cases for people who prefer to use a keyboard to using a mouse there is a very useful 

feature that’s known as using Key Tips. Now if you want to operate the Ribbon and its 

Commands using the keyboard rather than the mouse the problem you have is knowing what all 

of the keyboard shortcuts and key sequences are.  

Now if you press the Alt key, just press it and release it, you are given a set of single key stroke 

ways of accessing the Tabs on the Ribbon. In fact if you look above those you’ll also see some 

numbered keys for the Quick Access Toolbar. We’re going to be looking at the Quick Access 

Toolbar in the next section.  

But let’s suppose I now want to go to the Page Layout Tab. I don’t want to use the mouse. All I 

need to do is to press the P key on the keyboard. That not only takes me to the Page Layout Tab 

but it also gives me a set of single and double key combinations that enable me to operate the 

Commands on this Tab. So if for example I wanted to check or change the orientation of the 

pages here if I press the O key it actually operates the Orientation key and then I can choose 

using the up and down arrows whether I want my pages to be Portrait or Landscape Orientation. 

And when you’ve finished using this particular feature if the Key Tips are still visible you can 

just press the Alt key to hide them again. 
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In the early stages of using Excel 2016 the Tabs that you see there and the Commands on those 

Tabs are probably going to be plenty for the kinds of things that you’re going to be doing. But 

there are other Tabs, as I mentioned before, and in fact you can even create your own Tab and 

put your own Groups and Commands on it. 

Now we’re not going to go into this customization of the Ribbon here but I am going to talk 

about customization in relation to the Quick Access Toolbar in the next section. And on the basis 

of that you may want to try to experiment with a little bit of customization. Let me just show you 

where that happens. 

If you click on the File Tab to go into Backstage View and go into Options one of the pages there 

is Customize Ribbon. And from there not only can you customize the Ribbon from the point of 

view of adding your own Tabs and so on but you can also, for example, make some Tabs visible 

or invisible. So for at the moment if you look at these checkboxes down here the Developer Tab 

is not shown. If I check that now you’d also see a Developer Tab. 

So that’s all of the basics about the Ribbon for now. One thing I haven’t gone into is the new 

Tell Me feature and I’m going to cover that in a couple of sections from now. Although it’s on 

the Ribbon it works in a subtly different way really to the rest of the Ribbon. And as it’s a new 

feature I’ve set aside a separate short section for that. 

So that’s the end of this section. I’ll see you in the next one. 
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Video: Quick Access Toolbar 

Toby: Welcome back to our course on Excel 2016.  

In this section we’re going to look at the Quick Access Toolbar which is a toolbar I’ve pointed 

out a couple of times before. It’s in the top left hand corner of the main window and it’s used as 

the name implies for quick access to a small number of commands.  

Now by default you will see a small selection of commands displayed there. Let me just hover 

over the ones here. There’s a Save, an Undo Underline. Now the reason it says Undo Underline 

is because the last thing that I did on this sheet was to underline something and therefore to do an 

Undo that’s the thing I would be undoing. In fact if I click on the little dropdown to the right 

there it’s got a list of the last few things that I’ve done. So I can either Undo one of them or I 

could go back and Undo more than one of them. It’s not highlighted at the moment but there is a 

Redo button which will be available if I’ve undone something I’ll be given the option to redo it if 

I change my mind. There’s then the Touch/Mouse Mode button that we’ve used earlier in the 

course and then a couple of other buttons. 

If I click on the dropdown at the right it gives me a list of the available buttons. And the ones that 

are ticked are the ones that are currently visible. If I wanted to say show an Open button as a 

Quick Access button, if I just click on Open that’s available. If I decided that I wasn’t going to 

be regularly switching between Touch and Mouse Mode I could make the Touch/Mouse Mode 

button invisible as well. 

So that’s a very simple way of customizing what’s shown in the Quick Access Toolbar.  

Now if we go back to that menu you notice at the bottom there is a command there, Show Below 

the Ribbon. Some people prefer to have the Quick Access Toolbar below the Ribbon. One of the 

reasons is that if you’re doing something where you’ve set up some Quick Access Commands 

rather than have to move the cursor across the Ribbon to get at your commands putting the Quick 

Access Toolbar just above the workbook, the worksheet that you’re working on, makes it a 

slightly less onerous task going up to the commands. Let me just show you what happens. Show 

Below the Toolbar puts the Quick Access Toolbar there. And then when you’re working on a 

worksheet you can very quickly and easily get to the Quick Access Toolbar. And of course it’s 

very straightforward to put it back above the Ribbon again. 

Another very simple customization, let me click on that again, is to go down to where it says 

More Commands. And you may recall me saying in the previous section that I’ll give you a very 

quick demonstration of customization of the Quick Access Toolbar. It’ll give you some clues 

about customization of the main Ribbon. 

Now at the moment if you look on the right you can see the commands that are currently shown: 

Save, Undo, Redo, Quick Print, Print Preview, and Print Open. One thing you can do is to 
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change the sequence of those. So supposing I wanted to put Open to the right of Save. If I select 

Open and use this little up arrow here, Move Up, put it into the position to the right of Save, 

that’s below it in the list there, click on OK. If you look at the Quick Access Toolbar now you 

can see that Open is to the right of Save. So you can change the sequence of the commands like 

that.  

And the other thing you can very easily do is to add a Command to it.  

So let’s suppose that I wanted to add the Command to make something Bold to that. If I look at 

the list on the left which has a list of popular commands I can look for the one I want which is 

the Bold command. I can’t see it there so let me just look down at, I know it’s on the Home Tab 

and in fact there it is, Bold. If I select Bold and click on Add it’ll actually be added to the Quick 

Access Toolbar. So let me click OK and as you can see I’ve now got a Bold command on the 

Quick Access Toolbar. 

Now that’s a very straightforward example of customization. If you feel like trying to customize 

the Ribbon I’ll leave that to you at the moment. 

After you’ve been using Excel 2016 for a while and particularly if you’re going to do some kind 

of routine repetitive jobs it’s a good idea to take a look at what’s on the Quick Access Toolbar 

and work out if a little bit of customization there may help you to do the job that you’re trying to 

do. 

And just one or two other very quick points here. If you are customizing the Quick Access 

Toolbar or in fact if you’re customizing the Ribbon there is a Reset button on each page in Excel 

Options. So if it all goes horribly wrong or you want to go back to where it used to be there is a 

Reset button, Reset Default Settings. And in the case of the Quick Access Toolbar you can 

actually associate a specific Quick Access Toolbar layout with a specific document. So if you’d 

worked out which commands you need to work on a particular document and you want to set the 

Quick Access Toolbar up in that way just for that document if you look above the list on the 

right you’ve got two options there For All Documents or just for in this case the document that’s 

currently open which is Demo 1.xlsx. So if I made this selection here for a customization every 

time I open that document my Quick Access Toolbar will take on that custom layout. 

So that’s it on the Quick Access Toolbar. I’ll see you in the next section. 
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Video: Tell Me Feature 

Toby: Hello again and welcome back to our course on Excel 2016.  

In this section we’re going to take a look at the new Tell me feature. I think it’s important to 

cover this early in the course because you should find it quite helpful, particularly if you’re new 

to Excel. And even people with quite a bit of experience might well find useful things in this new 

feature.  

Now before we look at Tell Me in detail I’d like to talk about Help a little bit more. I mentioned 

it before. I showed you how to bring up Help. I’m going to press the F1 key now to bring up 

Help. One of the things that’s going to become more and more of a feature of Office, I think, is 

that one day you will look at Help and it will say one thing and the next day you look at it and 

you have a completely different list of topics. It does tend to be much more dynamic than it used 

to be. And particularly if you’re using Excel via Office 365 you may get a few surprises. Now 

Help, today, on Excel 2016 Help contains very different things to what it contained yesterday. 

And amongst the things that are in there there is a Get Started category and within the Get 

Started category there’s a What’s New in Excel 2016 for Windows and within that, that’s a page 

or similar to a page that we looked at earlier. If you go down there you will find a description of 

the Tell Me feature. 

Now generally speaking it’s always worth having a look at Help for any new feature that I 

introduce to get, if you like, Microsoft’s official view of that feature. Having said that, the level 

at which topics are covered in the Microsoft Excel 2016 Help is a much less detailed level than 

the coverage that I give you. 

Let’s just go back Home again within the Help and again going back to Get Started there is 

actually Excel 2016 training and there are, for example, a couple of courses there. One of them is 

a Create your first workbook. Click on Go to course and it actually takes you through a relatively 

short course on Excel 2016. Again that’s well worth a try. 

Now if I do a Search on Help now for Tell Me, first of all I do things quickly with Tell Me and 

as you can see there’s a link there with a frame from a Microsoft video about Tell Me and a very 

small amount of printed information below it. So again, make sure you take a look at the Help on 

these topics although quite often it is very limited. 

So let’s now try the Tell Me feature.  

The first thing I’m going to do is to click in that Tell Me box. I’m going to type the word Bold. 

Now when I’ve typed Bold it basically gives me three options. Now it won’t always be exactly 

three but in this case three is good because it really gives me three types of options generally.  
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Now the first option is that it will actually give me access to the Bold command. Of course 

we’ve used the Bold button already. It’s in the Font Group on the Home Tab. We used it to make 

the word Hello bold much earlier on. And if there is a command that either matches what I’ve 

typed or seems to closely match what I’ve typed or involved in some way one or more of the 

words that I’ve typed then it will offer me that command. So in this case it offers me access to 

the Bold command.  

It also offers me access to Help on that subject. So let’s have a look at the Help on Bold. 

Now as with much of the online Help in Excel 2016 I don’t find it particularly impressive 

because I’ve sort of like the first item there to basically something like how to make something 

bold. Now there is help buried away in this long list of links that would help me to do that but I 

would have to dig around a bit to find it. But how successful, how good the links are in Help is 

very variable and sometimes you get some very good help and some very good links. So in this 

case the help on Bold would perhaps be a little bit awkward. 

The third option was Smart Lookup on Bold. And what this does is to basically lookup the term 

for me and get me some help. Let’s look at a better example of something where I might want to 

do a Smart Lookup. 

Let’s suppose that I’m doing some statistical work in Excel and I want to find out what Standard 

Deviation means. So what I’m going to do is type in the term Standard Deviation. Now you 

notice it offers me a couple of links related to commands which are available. It says Get Help 

and the third option is Smart Lookup. So let’s click on Smart Lookup. It opens a panel on the 

right called the Insights panel and then it gives me a number of links to helpful information about 

Standard Deviation such as, for example, a Wikipedia link and some Bing image search results. 

So I’ve got useful information on the right there where I can find out more about what Standard 

Deviation means. 

Now in terms of actually executing a command let me try something different there. Let’s not 

have Bold. Let’s try Insert Table. Now with Insert Table selected you can see a whole list of 

potential commands that involve something like inserting a table. Now that one you see that has 

the word Table in one of the commands, Data Table. Format as Table has got Table in it. Insert 

has got the word Insert. But right at the top is the actual command with literally the name Insert 

Table. So it gives me the one that’s closest to the term I’ve entered first. That’s Insert Table. And 

if I click that now it will do exactly the same thing that would have happened if I had pressed 

Insert Table from the Ribbon in Excel 2016. So that gives me direct access to whatever Insert 

Table does and it does exactly the same thing as Insert Table. 

So there we are. That’s a bit of a whistle stop tour of the options in Tell Me. Be using it from 

time to time in the course. I suggest you give it a try. I think particularly in the early days you’ll 

find it a very useful feature. 
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That’s it for this section. I’ll see you in the next one. 
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Video: Mini Toolbars and Contextual Menus 

Toby: Hello again and welcome back to our course on Excel 2016. 

In this very short section we’re going to take a look at Mini Toolbars and Contextual Menus. 

Now apart from using the Ribbon and the Quick Access Toolbar there are various other ways of 

accessing commands that are relevant to a particular situation or a particular action. And 

typically in a situation you may call up what’s called a Contextual Menu. Now it’s called 

Contextual because what’s on it is in the context of what’s going on at that time. 

So looking at this Demo 1 workbook here, for example, if I right click on it up comes a 

Contextual Menu. It has commands on it which Excel thinks are the most likely ones that I’m 

going to want to use at that time: Cut, Copy, Paste Options, and so on. Note also the Smart 

Lookup there.  

And then above the Contextual Menu there is a Mini Toolbar which gives me one click access to 

some of the things that I might want to do. So for example, I may want to switch off Bold. Well 

there’s a simple button there, a Bold button. Click on that and the text Hello There is no longer 

bold.  

So that’s the Contextual Menu and a Mini Toolbar.  

Now there is another version of that available. Let’s take a quick look at that. 

If I want to select the text Hello and as you’ll see later on that is quite different from selecting the 

whole cell that the word Hello is in. That is the cell J10. If I click to the right of Hello in the 

Formula Bar and then go back and hover over the cell you will see that I can click in and the 

cursor is now flashing in the cell. If I now click with the mouse, drag across the word Hello and 

release the mouse button I’ve made a selection within a cell, in this case the word Hello. And 

what comes up is an even minier toolbar, a tiny little mini toolbar, a toolbar on select. And some 

people like those, some people don’t. In fact some people don’t like toolbars in general because 

they tend to get in the way of things. But that’s another way of bringing up a little mini toolbar 

that you can use in some situations, for instance to just quickly be able to make something Bold 

or Italic or change the color of some text. 

Now here’s a little exercise for you to do. It’s not one of the sort of proper exercises on the 

course. But look at Excel Options and see if you can find the option to disable that feature. So 

that if you make a selection like that, a word within a cell, you don’t automatically get a Mini 

Toolbar popping up. The first thing you need to do is to make sure that you can make a selection 

so that you do get it and then disable it. And then if you want to keep it you can enable it again 

afterwards. So that’s a little exercise for you to do. 
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Now the next thing I’m going to do is a little bit of touch. So I’m going to go up and switch into 

Touch Mode and I’m going to tap on the Hello cell again to select it. So tap with my finger. 

That’s a straightforward selection. Note that I get a Mini Toolbar. Now if you don’t see that 

when you tap just tap and hold and you’ll get that Mini Toolbar. And having got the Mini 

Toolbar all you need to do is to tap on the dropdown on the right and that brings up the 

Contextual Menu for touch use.  

That’s the end of this section. I’ll see you in the next one.  
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Video: Status Bar 

Toby: Hello again and welcome back to our course on Excel 2016. 

We’re now going to take a very quick look at the Status Bar which is at the bottom of the Excel 

2016 workspace. 

It’s actually pretty straightforward to control the Status Bar. What I’m going to do is to put the 

cursor down over the Status Bar, right click on it and you get this long Customize Status Bar sort 

of menu. And it’s a list of all the things that can appear on that Status Bar. Now everything that’s 

ticked can appear. And you may look at that list of ticked things and say well there seem to be 

about 20 things there but I can only see half a dozen. Some of the things if they’re ticked will 

still only appear if they have a certain value. Whereas some of them will give an indication 

whatever their value. So for example, if you take the very top one, Cell Mode, the current Cell 

Mode is Ready. Now if you look at the Status Bar, bottom left hand end, Ready, you can see that 

the Cell Mode is Ready. Don’t worry about what Cell Mode means at the moment, just take it as 

Ready. There are then a couple of options, Flash Fill Blank Cells, Flash Fill Change Cells. We’ll 

come back to those later on. Signatures, Information Management Policy, etcetera. A whole list 

of things, many of which are ticked and some of which are not. 

Now let me tick one of the ones that isn’t. I’m going to tick Caps Lock. And if I tick Caps Lock 

then Caps Lock would show on the Status Bar if I actually enabled it. So let me now press the 

Caps Lock key on my keyboard and you can see that Caps Lock is now showing as On. If I click 

the Caps Lock key again, switch it off, then you don’t see it any longer. If I didn’t have Caps 

Lock ticked here then you wouldn’t see whether Caps Lock is on or off. I hope that’s an 

adequate explanation. So really the ticks say do I want to see an indication of this thing or do I 

not want to see an indication of this thing. Now I don’t normally need to see Caps Lock on the 

Status Bar so I don’t normally have that checked. 

The next item along to the right of Ready on my current Status Bar is an indicator of whether I’m 

currently recording a macro. That’s recording a set of instructions for later use and reuse. Now 

that’s ticked. So I’ve got an indicator there that indicates that it’s not recording. And the little 

symbol that you can see down there on the left is the not recording symbol. If I started recording 

a macro then that symbol would change to show that I was recording a macro. 

So basically the Status Bar you customize to show the things you do and don’t want to see. Even 

with some things that you say I do want to see that you won’t see anything unless it’s got a 

particular setting or a particular status. At the right hand end of the Status Bar, so that’s the very 

bottom of the list, we have the Zoom percentage which is shown. Currently 106%. Not quite sure 

why I’ve got it on 106 but I have. Then the Zoom Slider. If you didn’t want to see the Zoom 

Slider you could switch it off again. And then three buttons which correspond to the description 
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View Shortcuts. And in fact these give us a way of toggling between different ways of viewing 

this worksheet. Let me just click to get rid of that list.  

The shortcut that’s currently highlighted is the Normal shortcut. That’s the normal view of my 

worksheet. If I click the next one, Page Layout, it will show me the pages on my worksheet as 

though I were printing them on sheets of paper. So it will actually show me how they’re divided 

up. And you notice how with the current arrangement three of the numbers would appear on one 

page and one on the next. 

And to the right of that is a related view, what’s called Page Break Preview, which shows that 

breakdown of pages more clearly based on the data and based on the sheet. So I could actually 

adjust the settings for my pages, for instance to make sure that all those numbers appeared on the 

same page. 

Now we’re going to look more at View settings later on but they are the basic settings on the 

Status Bar. And as with all these other settings and tools that we’re going through once you’ve 

been using Excel for a little while make a point of going through those and make sure that 

you’ve got them set correctly for you. 

That’s the end of this section. I’ll see you in the next one. 

  

http://www.simonsezit.com/


Learn Excel 2016 for Beginners: Master the Essentials 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 
 

Chapter 6 – Entering and Editing Data 

Video: Basics of Entering and Editing Data in a Workbook 

Toby: Hello again and welcome back to our course on Excel 2016. 

In this section we’re going to start to look in more detail at how to enter and edit data in Excel 

2016 and then I’m going to set you your first actual exercise on the course. 

Now before I start I am once again going to be basically working with mouse and keyboard. I 

will refer to touch once or twice. If you are using a touch device you’ll either need an onscreen 

keyboard, so you’ll get the equivalent of this, or if you have an external keyboard for your touch 

device you need to have that setup because we’re going to be entering quite a bit of text and 

numbers during this and subsequent sections.  

Now the other thing to bear in mind is that in this and the next few sections I’m really going to 

concentrating on getting the numbers in and formatting them in the sense of making sure that 

dates look like dates and so on. The actual cosmetics, how pretty what we’re doing looks, is 

something we’re going to come back to later on in the course.  

Now the first thing that we’re going to do is to start work on a new workbook and to make a new 

workbook, you’ve already seen how to do that. You can also use a Keyboard Shortcut. The 

keyboard shortcut is Control-N. So there is my new workbook and what we’re going to put in 

this workbook is we’re going to do a very simple monthly electricity account. 

So the first thing I’m going to do is to save the book with the name Monthly Electricity. There 

we are. And now what I’m going to do is to enter the months of the year. Now you’ve already 

seen that we can actually use a Series Fill feature here. I’ll come to that again in just a moment. 

The first thing I’m going to do is just select a cell, it doesn’t really matter which one at this stage, 

and I’m going to type in the first month of the year which of course is January. Now when I’ve 

finished typing January if I press the Enter key two things happen. First of all I leave that cell 

and that cell has its value January in it. But also notice that the selection, the cell selection goes 

to the next cell below and that lines me up well for typing in February. Now if after you’ve typed 

you press the Enter key by default the cell that’s selected next is the cell below the one you’ve 

just typed in. But if instead of hitting the Enter key I’d used the Enter, the tick mark on the 

Formula Bar, and if I used that now after typing February watch what happens. February is 

entered but I’ve now still got the same cell selected. So although I’ve got the same content my 

next selection is different depending on how I terminate entry of data into a cell. If I now want to 

go to K10 I can of course click in K10, enter March and of course now I’ve got the same options 

but also I can terminate entry in a cell by just clicking anywhere else on the sheet. 

So it’s important to recognize that when you’re entering data what happens after you’ve entered 

that data depends on essentially what you do at the end of the data entry. 
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Now the next thing I want to do is to use the feature that we saw before to get all of the months 

of the year in quickly without having to type them all. So I’ve selected January. I’m going to use 

the little symbol at the bottom right hand corner of the border there, drag down the requisite 

number of months, release, and I have all of the months of the year. 

Now notice that when we get down to September and November and December they’re actually 

slightly too wide to fit into the available space and they spill over apparently into the next 

column. Now in fact they’re not in the next column at all and September, for example, is wholly 

within the K16 cell. But because we haven’t told it otherwise what happens when something is 

too wide for the cell is that Excel lets it just display over the next one.  

Now one way of getting round this is to make column K wider and there are a couple of ways of 

doing this. One way of doing it is if you hover over the top of the column over the K itself you 

see that down pointing arrow. If I move to the right until it becomes a vertical bar with two 

arrows, one pointing at each side, and click with the mouse I can actually drag to make that 

column wider. And I can drag it to pretty much any width that I like.  

As an alternative to that, let me just put it back. In fact I’ll overdo it and make it really far too 

narrow. With that column selected if I go up to the Home Tab and the Cells Group and the 

Format button at the bottom of that there is a dropdown and one of the options on there is 

AutoFit Column Width. And if I select AutoFit Column Width then it will automatically choose 

a column width whereby everything in the selected column, column K in this case, fits 

comfortably within the column. 

Now in fact you can apply that command to more than one column at a time. So if I’d actually 

put data in columns K, L, M, and N, for example, I could select all four columns and use that 

AutoFit feature and all four columns would have their width suggested to accommodate the data 

contained within them. 

What I’ve done now is to make a mistake in the spelling of September. And having entered the 

data and got the column width sorted out I look at it and I think, “Oh dear I’ve spelt September 

wrongly.” To correct an error if you just click on Setmember in this case and started typing you 

would overwrite everything that’s in that cell. Now if I don’t want to overwrite it, I just want to 

correct the bit that’s wrong, I’ve got a couple of options. One option is just to press the X button, 

the Cancel button next to the Formula Bar and it goes back to what it said before so I can recover 

what was there before. The other thing I can always do, remember, is an Undo. So there’s always 

the Undo option. Of course if I press the Undo button too many times, such as here, and undo 

that correction I made or the change that I made to the column width don’t forget I’ve always got 

the Redo button and that will redo the column width for me. 

But let’s go back to having the September error. So I’m going to Redo the September error now. 

If you want to just edit within a cell there are a couple of options. I find the simplest way to do it 

is to select the cell and then click in the Formula Bar and do the correction actually in the 

http://www.simonsezit.com/


Learn Excel 2016 for Beginners: Master the Essentials 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 
 

Formula Bar. So I’m actually looking at the Formula Bar as I’m typing here. Some people prefer 

to just click and then click the cursor within the cell, so in this case the K16 cell, and basically 

look at the cell as they’re typing. I find it easier to use the Formula Bar. 

By the way if you don’t like the Formula Bar you can actually disable it. You might want to have 

a little exercise now, give you a little extra job to do. See if you can find in Excel Options where 

the option is to disable the Formula Bar. If you have trouble finding it it’s on the Advanced Tab 

in the Display Options. But if you want to get rid of it, perhaps to give yourself a bit more space, 

you can. I tend to use it so I tend to keep it onscreen pretty much all the time. 

So I’ve got my list of months. I’m just going to do a little Save here to save my work. Of course 

I’ve got AutoSave on anyway but just to be extra safe. 

Now what I’m going to do against January is to put in the cost of electricity in January. So I’m 

going to type in 124, hit the Enter key and you can see 124 as the cost. Now, one of the most 

noticeable things is that when you enter text such as January by default it is left aligned. When 

you enter numbers, by default, they are right aligned in the cells. So as I enter these costs, hitting 

the Enter key each time, the numbers are right aligned. However they don’t look much like 

amounts of money. They just look like any regular numbers. And when you are entering 

numbers there are many, many options for what the numbers actually mean. And one of the 

things we’re going to do here is to actually indicate that these numbers are amounts of money. 

So let me go back and click on 124 and what I’m going to do on this occasion is to right click 

and I’m going to choose Format Cells from the Contextual Menu. The first page, the first tab 

within dialogue is selected. It’s the Number Tab. And you can see that by default is taken 124 as 

a general format number. Note the little tip there. General format cells have no specific number 

format. Now supposing I want to make it a currency amount. Let me click on Currency. Now in 

this case because I’ve got myself setup to be using U.S. currency, I’ll tell you more about that 

later on, it gives me a sample of what the number will look like if I choose this setting. Note the 

sample there. Dollar symbol, 124.00. It gives me an option to change the number of decimal 

places. It also gives me an option to change the symbol that’s being used from a U.S. dollar 

symbol to just about any other symbol there is. And it gives me a choice of showing negative 

amounts using either a minus symbol or red or a number in brackets, the sort of accountancy type 

formats. I’m going to stick with the defaults here, click on OK, and 124 is now displayed as 

$124.00.  

Now if I now want to apply that same format to the other two numbers there I can select both of 

them. I could perform exactly the same operation. It’s worth noting that I can access that Format 

Cells Dialogue from a variety of places. Another one is up on the Ribbon on the Format button, 

the bottom part of it in the Cells Group on the Home Tab there is a Format Cells button link 

there, opens the same dialogue. I could do exactly the same thing again, change the currency to 

the same settings. I can in fact also apply it to the cells that I haven’t yet put amounts into or 

http://www.simonsezit.com/


Learn Excel 2016 for Beginners: Master the Essentials 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 
 

indeed to the whole of column L. If I selected column L, click on again Format, Format Cells. 

There’s a difference this time because when I’ve selected column L I’ve selected a load of cells. 

Three of them are in currency format and the rest will still be in the same format they were in 

before which was that general format. When you make a selected the covers different formats 

then when you bring up the Format Cells Dialogue Excel doesn’t know which of those to show 

so it basically indicates that you have a multiple selection by not showing any specific format. 

And what I would need to do now is to make all of the relevant selections. So if I said Currency 

and I say the symbol I want to use is the dollar symbol everything seems to be okay. Two 

decimal places, click on OK. Now that format has been applied to all of those cells. And if I click 

say in the amount for April and just type say 97.5, press the Enter key, then that is automatically 

formatted with that currency format that I’ve now applied to all of those cells. 

So finally then I filled in the rest of the month electricity costs there. I’m going to Save that and 

that’s the end of this section. I’ll see you in the next one. 
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Video: Exercise 01 

Toby: Hello again and welcome back to our course on Excel 2016.  

It’s time for the first actual exercise on the course. This is Exercise 01. And what I’d like you to 

do is to create a workbook which shows the monthly averages for rainfall, maximum 

temperature, a minimum temperature for where you live or work. Now the figures I’ve included 

in my version of this workbook are for the area where I live in north Yorkshire in England, so a 

very temperate climate. The rainfall doesn’t vary very much over the year. The maximum 

temperature is highest in July, 20.8 degrees Celsius. The lowest maximum temperature January, 

December. The high is 6 degrees Celsius. And then the minimum temperature, the lowest 

minimum temperature we get around the New Year. So we get about 0.9 average in December, 

January, February.  

So you need to get the figures for where you live. Make sure that all three of them are one 

decimal place figures. So if you look at my rainfall for April. If I just typed 50 in there I’d get 50. 

I wanted you to make sure that it always gives you that one decimal place. If you’d rather do the 

rainfall in inches or any other units for that matter that’s fine. If you’d rather do the 

maximum/minimum temperature in degrees Celsius, Fahrenheit, Absolute, or any other 

temperature scale that you’d like to use that’s up to you. But in all three cases I’d like you to do 

these one decimal place. Don’t worry about making anything look pretty. We’re going to be 

doing a lot of work on this particular exercise later on in the course. 

My sample answer is in the usual place. That’s it for this section. Please join me in the next one. 
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Video: Formatting Dates 

Toby: Welcome back to our course on Excel 2016. 

By now I hope you’ve completed Exercise 01 okay. In this section we’re going to carry on 

looking at entering and editing data. And in particular in this section I’m going to spend quite a 

bit of time looking at Date Formatting. Now dates are very often important in your worksheets 

and looking at the formatting of dates is actually a good way of finding out more at formatting 

data in Excel as well. 

Now in order to demonstrate this I’m going to start by creating another new workbook. I’m 

going to put in this workbook details of some business expenses. Now for the moment I’m going 

to work near the middle of this worksheet. It doesn’t really matter where you work because you 

can always remove and add rows and columns later on a worksheet if you need to. But I’m going 

to type in one of the cells, let’s say M9 here, 3/9. Now what does 3/9 mean? Well if you were 

Microsoft Excel you might take a good guess at it. Perhaps it means 3/9, it’s a fraction. Perhaps 

it’s a part number, a part code of some sort. Or perhaps it’s a date. Depending on where you are 

in the world if it’s a date it could be March the 9th or it could be the 3rd of September. And when 

you’re dealing with dates local is very important. But it’s also important to understand that there 

are many different formats, many different ways in which people show dates. 

Now in order to see what Excel makes of 3/9 let’s just click somewhere else. Let’s click in N9. 

And it’s taken it as the 9th of March. But notice I have 3/9. It thinks that’s the month number and 

then the day number. But it’s actually taking it as the 9th of March. So why has it done it that way 

round?  

Now in order to see why dates come out on your device in the way that they do we need to look 

at something in Control Panel. So make sure that you can locate Control Panel on your Windows 

device. And then we need to look at the Region Setting. Now I’m telling you this now because 

whatever I’m doing in this section on dates may look quite different to you on your machine 

because you may have different settings to make. It doesn’t really make any difference to how 

the whole thing works in terms of Excel but it will make a difference to what you see in the 

workbooks, the worksheets that I’m showing you if you’re trying to work along with me. 

Now the first thing is in this Region Dialogue my location is United Kingdom. But my formats 

are set to English (United States) formats. So for dates and times the formats I’m using are these 

and how various dates and times look in these formats, there are some examples of those in the 

lower part of this screen. So for instance my short date format is Month/Day/Year. So when I 

typed in 3/9 as an even shorter date Excel takes that as Month/Day and then when it displayed it 

back to me it displayed it back to me as 9-March. So it took the three as the month and the nine 

as the day. Now whatever happens on your device it’s going to be largely governed by your 

setting that you’ve got for the region on your device. 
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Now if you’re in the U.S. you’re probably going to use the same setting as me. You’re putting up 

your location set to U.S. as well. Somewhere else in the world, including the UK and much of 

Europe, you’re probably going to want your short dates the other way around. But be aware of 

what the settings are on the machine because generally speaking they’re not set totally 

dependently in Excel. You can change the settings but by default Excel picks up its regional 

settings from your Control Panel settings. 

So let me now see what happens if I put in a longer version of a date in cell M10. This time I’m 

going to put in 3/10/15. How do you think that’s going to come out? Now what it’s done, first of 

all, is, is recognize it as a date. And because I didn’t specify a century it assumes that it’s the 

current century. So it’s put the year as 2015. But it’s left it in that 3/10/2015 format because my 

Date Format is U.S. date format. That’s Month/Day/Year. 

But notice that with those two the way the date appears is very different and it’s important to 

understand what’s happened there. 

Let’s look at the first one again and this time I’m going to go into the Format Cells Dialogue and 

just have a look at what Excel 2016 made of that. And what it made of it is actually quite 

surprising. There is in the categories here a category of Date but it hasn’t used the category of 

Date. It said this is a Custom category. It’s sort of a date because it’s using D for Day and MMM 

for Month but it’s not really strictly treating it as a date. It’s treating it as if you like a string of 

characters that happens to be made up of two parts of a date, the day and the month.  

But notice it doesn’t say Month first then Day. It says Day and then Month. And I could in fact 

here change that format manually to switch it around. But if I look at the second date, that has 

been interpreted as a date. And an example of the date is on the right there, the sample. That’s 

the one I entered. There is the Date Category selected on the left and the type is the top one on 

the right. And apart from the format there which is basically Month/Day/Year there is also an 

asterisk. And what that asterisk means is that this is a date which will change according to the 

regional date and time settings on the device where you’re looking at this workbook. So if you 

were opening this workbook in say the UK or somewhere else in Europe or perhaps in Australia 

or New Zealand then it will interpret the date in the way that I intended. So it will interpret it as 

March the 10th even though if you were looking at 3/10/2015 as a UK format you’d say that was 

the 3rd of October. 

So if you want to use dates which will actually be interpreted according to the locale where the 

Excel workbook is opened you need to make sure that you use one of these asterisk formats. And 

that again is one of the reasons why I’m telling you this pretty early on in the course. Dates can 

cause people all sorts of problems. It’s important to understand that you can set up dates which 

are if you like internationally safe and will be interpreted according to the format of the machine 

that they’re opening. 
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Now if you wanted to change this date format, supposing I wanted to change that M10 content to 

be this nice long date format here. Let’s choose that one which is still a stared format. Click. 

Now you see you’ve got Tuesday, March the 10, 2015 and that’s absolutely fine because I intend 

it to be March the 10th and not the 3rd of October.  

In fact if I go back to the contents of M9 I could apply the same format there. Let’s call Format 

Cells from the Ribbon this time. Let’s make it a Date Format. Let’s choose that, click on OK and 

that’s fine. Note that it is assumes that as the year wasn’t specified it’s meant to be this year, 

2015. 

Now earlier on I showed you how to format a whole range of cells. So let’s format column M to 

be Date Format using that same long version with the asterisk there. Now let’s try typing some 

different things into the cells in column M. What about 11/4? Let’s see if you can work out what 

that’s going to be. Well it’s going to be Wednesday, November the 4, 2015.  

Now what I want to do is to just go back and reduce the width of column M and make a point 

about this. In some situations if you have data to display, and this is particularly true for dates, 

and they just won’t fit you can get a string of hash symbols. Now that doesn’t mean to say that 

the value in the cell is invalid in some way because in fact if I clicked say in M9, if you look in 

the Formula Bar you can see the contents of M9. Not in its full format of course, in the Short 

Date Format, but you know that there’s valid content in the cell. But in order to see that valid 

content you may have to in this case increase the width of that column. Now as you saw before 

one way of doing that is to do an AutoFit Column Width and then everything will be fine. But 

you will often see that, particularly with formats like Long Dates. 

Now another useful thing to observe there is that if you wanted to edit the date, Wednesday, 

November 4, 2015, and you wanted to change it from November the 4th to say September the 11th 

you may be looking at that thinking, “Oh my what day of the week was September the 11th?” and 

you’re trying to work out what the day you should type first. Well, if you use the Formula Bar 

version here then you can edit the date in its short format even though it will be displayed in the 

long format. So if I wanted something like say September the 11th I could put the day is 11, the 

month is 9, tick, and of course it’s a Friday. So again a useful thing to know about working with 

dates. 

And one other important point to make here is that although you can apply all sorts of formats to 

all sorts of data that you are entering and editing there are of course many situations in which 

you can’t apply a format to something. So for instance, if you take this text, Train Fare York to 

London, and I wanted to format that as a date I really wouldn’t get very far. So I click on Date, 

click on OK and of course it won’t do it for me. If I had a number like 19,763 and I tried to 

format that as a date it actually comes out as 2/8/1954. Now you may think now in what way did 

that nice long number there come out as a date in 1954? Well the reason is because dates are 

stored as the number of days since a date in the past. So don’t necessarily assume that because 
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something doesn’t look as though as in this case it’s a date that it can’t be interpreted as so by 

Excel. So that’s really just a word of warning. But clearly again if I take Taxi to International 

Chemicals HQ and tried to format that as say currency that wouldn’t work either. So you can’t 

do everything but sometimes you’ll get taken by surprise with some of the formats that do appear 

to work in Excel. 

That’s it for this section. I’ll see you in the next one. 

  

http://www.simonsezit.com/


Learn Excel 2016 for Beginners: Master the Essentials 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 
 

Video: Formatting Numbers 

Toby: Hello again and welcome back to our course on Excel 2016. 

I’m starting this section with the Business Expenses workbook that I created in the previous 

section and I’m going to look first of all at some of the other available formats in Excel 2016. 

Then I’m going to turn my attention back to entering and editing data and point out some other 

very important things about that. 

Now given that this is supposed to be an expenses sheet if I wanted to now start putting in the 

costs against the train fare York to London on Monday, March the 9th, I’m going to say that it 

was 127.50. So I’m going to put in 127.5. Now look what’s happened. Because I inadvertently 

had left a Date Format on that cell I come up with that really strange old date. So what I will 

normally need to do is to make sure either before I enter data or after enter data that I’ve selected 

the right sort of format.  

Now if I had put 127.5 in the next one, well actually it’s the taxi fare so let’s not go too far. Let’s 

say 32.5. If I’d put that in that cell bear in mind that I haven’t formatted this cell as a Date Cell. 

It just stays as 32.5.  

32.5, let’s look at what format has been assigned by Excel. It actually has assigned the General 

Format and it will very often assign the General Format. Now there are many number formats 

that can be applied to a cell with a number in it. So for instance I could assign a Fraction Format. 

Watch what happens if I apply the Fraction Format to that. I can choose the number of digits. I 

can choose whether I want it as say eighths or sixteenths or quarters. Supposing I wanted to do it 

as halves. Note the format isn’t applied until I click on OK and it becomes 32½.  

Let’s format it again. This time I’m going to try Scientific Format. Note that I can choose the 

number of decimal places. Let’s stick with two decimal places. Click on OK and it becomes 

3.25E+01. That’s 3.25 times 10 to the 1. 

Let’s try another one. Now this time I’m going to apply a Counting Format. Notice that each 

time I change the category I have a different set of options on the right. So in the case of 

Accounting Format I can choose the number of decimal places and I can choose the symbol. If I 

were say a U.S. based accountant I may generally work in U.S. dollars but I may have clients 

around the world and for each client I would need to use the accounting symbols that are 

appropriate to that client. 

So I’m going to stick with the default here, decimal places two, symbol dollar. Accounting 

Format is actually very similar to Currency Format. The main visible difference is that the 

currency symbol appears on the left of the cell. But also the way that negative amounts are dealt 

with is a standard way. So click on OK and I’ve now got $32.50 with the dollar currency symbol 

on the left of the cell. 
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Now could I apply that format to the figure above? Now bear in mind that I typed in a number 

there earlier on. It was converted to a date by Excel because the cell already had a Date Format 

applied to it. Let’s try changing that now to Accounting Format. Now watch carefully what 

happens here because if I select Accounting Format all seems to be okay but the symbol says 

None and the reason is that when Excel applied Accounting Format it looked at that cell and say 

that it already had a number in it although it was formatted as Date. And because there was no 

symbol, no currency symbol it stuck with none. So I need to be careful that I select my dollar 

symbol, click on OK and now I have my format applied.  

Now I’d like to talk about a couple of the other formats now. Let’s go back into the Format Cells 

Dialogue. Towards the bottom of the list of categories, you’ve already seen Custom Category 

where you can actually make up your own formats. That’s out of scope for the course, certainly 

in these early stages. There are some custom formats already there and of course you can use 

those. And it’s pretty straightforward to create your own. But as I say that’s not something for 

this stage of the course. 

But I want to look at Special because depending on your locale you may have some special 

formats. Now I’m not going to go through any of these in detail at the moment but it’s worth 

being aware of them. And it’s also worth being aware of the fact that although you can apply 

these formats to cells what actually happens in the case of each format will depend not only on 

the format itself but also on what’s in the cell. So if I apply Zip Code Format to the description 

of the expense, Train Fare York to London there, click on OK, nothing really happens because as 

far as Excel is concerned that can’t be a zip code so it just doesn’t really do anything in this case. 

If I applied that same format to $127.50, don’t forget I typed a number in there, and applied Zip 

Code Format to that watch what happens. It does actually turn it into what it considers to be a 

reasonable go at that zip code. Of course I typed in 127.5 so it’s called it zip code 00128. So you 

have to be really careful about these formats in terms of what happens with many different types 

of cell content. I’m just going to undo that one. 

Now as I mentioned earlier the available special formats depend on locale. So let’s just go back 

into Format Cells again and click on Special. I’m going to change my locale to, so let’s go for 

French (France) and I get a nice long list of available special formats there as well corresponding 

to various French special formats. 

So that’s Special. 

I want to talk about a couple of other very specific format options here now. I typed 7.2 in cell 

O13. I can format that as text. Now if I format it as text it’s absolutely fine. 7.2 can be text. You 

will notice there’s something unusual about it because it’s aligned on the left in the cell. But I 

won’t be able to use that in the same way for calculations as I could say a currency figure of 

32.50. It is treated as text and of course text can contain numbers as text but it’s a very important 

distinction that it is treated as text in this case. 
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The other format that I could apply to that 7.2, again a very important one to be aware of, is 

Time Format. If I click on that as time it comes up with the rather mysterious time of 4:48. Now 

you might think how did it turn that into 4:48? Well the answer to that question is going to sound 

a little bit implausible but believe me it is true. The way that Excel stores times is that it stores 

the time as a fraction of a day. So in this case when it sees something like 7.2 it takes the 0.2 as 

the time. Now the 0.2 is a fifth, 0.2, of a day. So it divides 24 hours by 5 and comes up with 4.8 

hours and that corresponds to a time of 4 hours and 48 minutes. So that’s where 4:48 comes 

from. So because of this way that Excel stores times 4:48 is a fifth of a day and therefore it 

corresponds to a numeric value of 0.2 of a day. 

Now when you’ve got something in Time Format you have a number of important options. So 

here, for instance, you can choose the Time Format for the locale. Let’s go back to English 

(United States) and notice how it is on a twelve hour clock. So we have 1:30 PM Note the PM 

marker there. So let’s click on OK and what it comes up with, a fifth of a day, of course that’s in 

the morning. So it’s 4:48:00 AM.  

If I wanted to do it on the 24 hour clock, go back into Format Cells again. Let’s choose the next 

format which is 13:30, that’s 24 hour clock format. That’s 4:48. If I apply that format to a cell 

and then I’m going to now type in that cell 2 PM what do you think will happen? I formatted the 

cell as 24 hour clock and I’ve typed 2 PM what do you think that’s going to say when I tick it? 

That’s right, 14:00. Excel looks at 2 PM and it says yep that looks like a time to me but the 

format applied to this cell is 24 hour clock format so I’m actually going to display it as 14:00. So 

Excel is pretty clever at that sort of thing. 

The next thing I want to talk about in this section is editing the contents of a cell.  

Now I’ve selected cell N9 and the contents of N9 are displayed in the Formula Bar. To edit those 

contents I can either go up to the Formula Bar and edit away in the usual way. I normally use the 

keyboard so I’d use the arrow keys to go left and right and the Backspace key to delete what’s to 

the left of the cursor, the Delete key to delete what’s to the right of the cursor. If you want to 

work within the cell and you may want to do this for example if you don’t use the Formula Bar 

or haven’t got it displayed at the moment. If you just double click somewhere within the cell the 

cell basically comes to the forefront. It looks as though the contents of O9 have been deleted 

there. They haven’t. It’s just the contents of cell N9 are now in front of those. You can use the 

arrow keys to go left and right. I can even go beyond the range of N9. I can go way off to the 

right. I could delete the word London and change it to say Bristol. And then when I finish I can 

either click elsewhere or I can use the tick mark next to the Formula Bar and my changes are 

saved. 

If I’m using Touch it’s pretty much the same situation. Instead of a double click you do a double 

tap. You may want to make the screen a bit bigger if you’re going to do editing on a worksheet 

with as many columns and rows as this displayed. So let me just stretch this out. Now let me 
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double tap on cell N12 and you can see I’ve got a cursor off to the right there. I can tap 

somewhere else, do my editing using my onscreen keyboard or my external keyboard if I’m 

using one, and other than that it works pretty much the same way that it works when you’re 

editing with a touch device anyway. 

And the next thing is pretty similar with touch or mouse and keyboard as well. If I want to delete 

individual characters within the contents of a cell I first of all need to make sure that I’ve got a 

cursor there. I can do this of course using either the Formula Bar or within the cell. As I’ve got 

the cursor in cell N12 here and I’m using touch at the moment I’ll demonstrate this with touch. 

It’d be the same with a keyboard. Press the Delete key and it’s the character to the right of the 

cursor that’s deleted. So press Delete once, that character is gone. If I want to delete the character 

to the left I use the Backspace key. If on the other hand I select a cell, let me select M10 using 

touch, and all I’ve got is the cell selected. Note I haven’t got a cursor within the cell. I can tell 

the cell is selected because I get a border. When I’m using touch I get those two little circles as 

well. If I now press either the Delete key or the Backspace key I will delete the whole contents of 

the cell. So let me press the Backspace key and the whole contents of that cell is deleted. 

And that’s it for this section. I’ll see you in the next one. 
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Video: Exercise 02 

Toby: Welcome back to our course on Excel 2016.  

It’s time for Exercise 02. Now I have here Exercise 02a.xlsx. This is the starting point for this 

exercise. And the content of this workbook is a list of opening hours for a public facility and 

they’re the opening hours for 2015. I want you to update them to the opening hours for 2016 and 

there are a number of changes to make. One of them is to change from using the 12 hour clock 

with AM/PM to 24 hour clock for all of the opening hours. So where it currently says 8 AM to 5 

PM it should say 08:00 to 17:00 and so on. And I also want you to change the closing time on 

Saturday from 8 PM to 7 PM. 

And then as an additional challenge what I’d like you to do is where it says Opening Hours 2015 

along the top there change that to say Opening Hours 2016. 

Now that Opening Hours sort of heading at the top there may look a little bit strange to you. The 

cells at the top are merged and we’ll talk about merging cells later on. But in the meantime you 

only really have to think about cell A1.  

So that’s it. 24 hour clock, closing an hour earlier on a Saturday and we’re changing from 2015 

to 2016. My answer to that is Exercise 02b.  

That’s the end of this section. I’ll see you in the next one. 
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Chapter 9 – Backup and Recovery 

Video: AutoSave, Recover Unsaved Workbook, and Create a Backup Copy 

Toby: Welcome back to our course on Excel 2016. In this section I’m going to look at Backup 

and Recovery. 

There are various aspects of Backup and Recovery and the first one I want to look at is the 

question of losing your workbooks. If you, for example, work on a laptop and the only copy you 

have of your workbooks is on your laptop and you’re away from home and your laptop is stolen 

or you lose your laptop and the only copy you have of those workbooks is on the laptop then 

you’re going to be in big trouble. If you store your workbooks in the Cloud then to a large extent 

this is no longer a problem, although there are intrinsic dangers there as well which I’ll refer 

back to later. But if you save your workbooks on the device and that’s the only copy you have 

then you really could finish up in quite a bit of trouble. 

Now you have a number of options but basically you need to keep a backup copy of each of the 

workbooks that has any value to you on a different device to the one that you work on them with. 

Now this might be an external hard drive, perhaps just USB drive that plugs into the device but is 

then kept somewhere separately or if you have access to a computer network you may transfer it 

onto another device on the network. But it is very important that that backup copy of each of 

your workbooks is on a different device so if the original version is lost or stolen you still have a 

backup copy available. 

Now I’m not going to go into how to setup a sort of backup regime on this course but you should 

get into a routine process for backing up your workbooks. Perhaps you just take a backup of each 

workbook at the end of each working day or even after you’ve worked on a workbook you put a 

copy of it on a different device. The most important thing is that you make sure that if the worst 

did happen, so if your laptop was stolen, for example, that you have a recent enough copy that 

you wouldn’t face a huge problem restoring the content of the stolen workbook. 

Now the next situation to consider is one where Excel or your device fail. If this happens you 

may have been working on a workbook for a period of time, made a lot of changes, enter some 

data, the device fails. Perhaps the electricity fails or Excel itself crashes. Potentially you’ve lost 

all of that work. As I mentioned earlier on in the course you should normally have AutoSave 

enabled. You do that from Backstage View in the Excel Options. On the Save Page one of the 

options there, Save AutoRecover information, in my case every 10 minutes. That’s the default. 

Ten minutes is the figure that I normally stick with. It means that at worst case I’m going to lose 

9 minutes and 59 seconds worth of work. If you find that the AutoSave process, perhaps if 

you’re working on a very big and complex workbook, is actually slowing things down too much 

for the time that it takes to happen you may want to increase that figure. If you do of course, if 
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you do go up to I think the maximum is 120 minutes then potentially you could lose that much 

work. So only really increase that number if it’s giving you some problems. 

There’s an option below that, Keep the last AutoSave version if I close without saving. That’s a 

very interesting option because most of us at some stage when we’ve closed a workbook or 

perhaps a document in another program such as Word when it says, “Do you want to Save 

changes?” most of us at some stage have said No accidentally and gone, “Oh no I made all those 

changes and then when I closed it I said No to saving the changes.” Well nowadays if I have 

made some changes say to one of my workbooks and I accidentally close without saving 

changes, let me just cancel that. When you come to do an Open at the bottom of the page here 

you’ve got this option, Recover unsaved workbooks. And you see the Tool Tip there, Open a 

recent workbook that was closed without saving. That gives you the option of getting at those 

versions, the ones where you’ve lost work because you closed without saving. 

So that little group of options are very important. Let me just go in there for one other thing. 

Back to the Save Page again. AutoRecover file location. The AutoRecovery files are saved in 

this location by default, my username TobyA. Here your username will be in your version of 

that. If you’d like to save those somewhere else then you can change that location. 

Now there’s one other aspect of Backup which is something that I used to do. I don’t any longer 

but I used to. I know some people have done it in the past, some of them still do. And that is that 

there is a facility in Excel to always save a backup copy of a document when you save the 

document. But this copy is saved in the same location so it doesn’t fulfill the same purpose as 

having, for instance, an offsite backup or a backup on a different device. So this approach just 

saves a copy with a particular name in the same folder as the workbook itself. Some people quite 

like this approach. And all you have to do with this is when you do a Save, let’s suppose I take 

my Business Expenses spreadsheet here and I do a Save As but with this, with my Save As if I 

go to the Tools dropdown to the left of the Save button and into General Options one of the 

options is Always create backup. Click on OK, click on Save, I’m only replacing the existing 

version. Now what you’ll notice is I have a new file there called Backup of Business 

Expenses.xlk. So that is a backup version of my workbook. So I’ve got a local backup copy that I 

could go back to if I need to. 

The last thing I’d like to mention here is in relation to Cloud storage, and I did say I’d come back 

to this point. Cloud storage is fine. You need to make sure that your Cloud storage provider takes 

backups of your work so that you know that you have backup copies. It’s a good idea to know 

how frequently those backup copies are made as well. The other thing to bear in mind, 

particularly say if you had a failure and you needed to go back to a backup copy and you are 

relying on Cloud storage is whether or not you always have your Cloud storage available. So if 

you sometimes or frequently work offline, so you have no internet access, just think what would 

happen if you needed to get to a backup copy of a file and you didn’t have internet access. Now 

for many of you you may say well I’d just wait until I got internet access. There’s not really a 
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problem. But it’s just worth thinking through the consequences of that and whether that could 

create you a problem in some situations. 

Okay so that’s it on Backup and Recovery. I’ll see you in the next section. 
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Chapter 10 – Fill and Series 

Video: Working with Fill and Series 

Toby: Hello again and welcome back to our course on Excel 2016.  

We’ve already looked at filling a series of cells a couple times already in the course. We looked 

particularly at filling a series with the months of the year. But in fact many times when you’re 

working with Excel you’ll find that the data follows one or more distinct patterns. 

Now let me just quickly do again something we’ve done a couple of times already. I’m just 

going to type January in that cell and this little block, this little icon, the bottom right hand corner 

of the board here it’s called the Fill Handle. And if I pull the Fill Handle across, let’s just go to 

there say. You’ve already seen that you get the months of the year. Let me just Undo that, go 

back to just having January. But this time instead of pulling across with that Fill Handle what 

I’m going to do is to select the cells up to R4. So I’m going to hold the Shift key down, press R4 

and all the cells between G4 and R4 are selected. Now what I’m going to do is I’m going to go 

the Fill dropdown in the Editing Group on the Home Tab and I’m going to select Fill Right. And 

what happens this time instead of getting the months of the year is that I get the same cell 

content, in this case the word January, in each of those cells. So that isn’t a Series Fill that we 

refer to. It’s really just a Fill, a Fill Right. Now let me Undo that yet again.  

There is a Keyboard Shortcut for Fill Right that you’ll probably find yourself using quite a bit. 

It’s Control-R. Let me do Control-R here and that gives you a straightforward way of doing a 

right fill. But in that case what you’re doing is effectively copying the contents of one cell into a 

number of other cells.  

Let me just go back. Let me Undo that yet again and I’m going to type February in H4. Again 

I’m going to select G4, put the Shift key down. Now I’m going to do my right fill again, Control-

R. What do you think is going to happen? That’s right. You still get January in every cell 

because basically with my left most cell selected I select the range of cells I want to fill and 

basically it goes left to right filling those cells. 

Now similarly if I were to hold the Shift key down and click in G14 I could do a Fill Down 

which is Control-D or let me just Undo that, click in G4 again, use the Fill Handle to drag down 

and I get my sequence of months again. 

Now it’s important to realize that you can’t only fill right and down. You can also do up and left. 

Let’s suppose I put the word Hello here. And if I wanted to basically have Hello going up the 

sheet. Say I’m starting here in U23. If I select a cell above that, go to the Fill dropdown and do a 

Fill Up that works the same. And in fact if I click in M10 with the Shift key held down, so I’ve 

got a rectangular selection, I could do a Fill Left and so on. So you can basically work in any 

direction on the sheet. And of course you can do Series in any of those directions as well. So if 
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instead of Hello in this first cell here I’d put January I could use the Fill Handle to go left and 

then I could even use the Fill Handle to go up. So as you can see you can build some pretty 

sophisticated patterns.  

Now the examples that I’ve used here have been relatively straightforward. And now I want to 

look at something a little bit more complex and we’re going to use a very important Series 

Dialogue for this example.  

So in cell H30 I’m going to type a date. I’m going to type a date of the 3rd of January 2015. Let’s 

suppose that I want to do a Series, a sequence of cells in row 30 staring on the 3rd of January 

2015 but I want to have the step as 17 days, a very strange amount. Now to work out what those 

individual cell values will be, well 17+3, the next one would be the 20th of January and then 

another 17. That sounds like the 6th of February and so on. But it becomes a little bit complicated 

to keep going up in steps of 17 days. Well one way that you can do this is to use the Series 

Dialogue. And if I click on that Fill dropdown again there’s an option, Series and then it’s got a 

dot-dot-dot. Now whenever you get a dot-dot-dot on an option on one of these menus from the 

Ribbon it means you’re going to see a dialogue if you click on that. And in this case you have the 

Series Dialogue which lets you build very sophisticated series on your worksheets. 

So, first of all do we want to go in rows or columns? Well I’m going to go in rows. I’m going to 

go across the row. What type of series is it going to be? Is it going to be a linear series? Is it 

going to be a growth series, something that’s getting bigger? Is it going to be a date series? Or is 

it some sort of AutoFill? Now what I’m going to do is to make this a date series and the date 

units I measure are going to be days. But the step value here is going to be 17 days. So I’m going 

to build a series that goes up 17 days at a time. 

Now the step value basically says, “Where do I want this series to stop?” Now I’m going to 

randomly choose a date. I’m going to say I want it to stop on the 31st of October 2015 and there 

it is. Notice as I pointed out earlier in the course that where the columns aren’t wide enough to 

accommodate those dates I get the hashes. Let’s select all of those cells. Let’s AutoFit the 

column width so you can see them all properly. And there you are. Starting at the 3rd of January, 

20th of January, 6th of February, 23rd of February, and so on.  

Now it is true that pretty much any series that you can do with a Series Dialogue you could 

actually setup to do using the Fill Handle type approach. But it can get quite complicated and 

you’ll quite often find the Series Dialogue is a more convenient way of doing things. You can 

very simply, for example, just do a series of numbers. It doesn’t have to be dates or months or 

something. If I had a two in this cell and a five in this cell, let me now extend those with the Fill 

Handle, then I still get a series of numbers increasing three at a time. So I can do that without 

using the Series Dialogue but the Series Dialogue often makes it much more straightforward 

thing to setup. 
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Another point to make here is that, let’s go back to that left hand one. Let’s put 100 in there. If 

you’re using Series Dialogue, let’s say that you’re doing in this case rows linear and your step 

value instead of being three as it was just now you made minus six and said stop when you get to 

minus-100 that’s fine as well. And you can of course count down dates as well. 

So that’s it on Fill and Series Fill. In the next section we’re going to take a look at Flash Fill. So 

please join me for that. 
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Video: Flash Fill 

Toby: Welcome back to our course on Excel 2016. In this section I’m going to take a look at 

Flash Fill. 

You’ve already seen how to use Fill and Series Fill. In the last version of Excel a feature was 

introduced called Flash Fill. And this adds a lot of intelligence to Fill and I’m going to 

demonstrate it first of all with a straightforward example. 

I’ve got a list here of what IMDB says at the time of recording this are the top 50 movies of all 

time according to the votes of their subscribers. And in column A I’ve got the name of the 

movie. In column B I’ve got the year of release. Now let’s suppose that I wanted to make a 

column C where I put the name of the movie with the year of release in brackets afterwards. So if 

for instance I go in here to C2 and type in and then I put a bracket and I put the year of release 

afterwards. And then I go down to the next cell and start typing the same thing again. Watch 

what happens as soon as I start typing. I’m just going to type the T of The Godfather. Now as 

soon as I type something which is different from the The Shawshank Redemption what Excel 

does is to look at the columns there, A and B, to the left and it tries to work out if it could make 

what was typed in C2 out of what’s in A2 and B2 and it says yes I can. I can put the contents of 

A2, a space, a left bracket, the contents of B2, and a right bracket. And if I applied the same 

principle to row 3 it would say “The Godfather (1972)”. Once its done that it then basically 

forecasts or predicts what all of the others are going to look like and puts them in there in 

effectively in gray, in a sort of provisional well this is what I think you want. And if you look at 

that and you say, “Yep that’s exactly what I want in fact” all you need to do is to press the Enter 

key and all of those cells are filled in for you. 

Now if at this point it had done the wrong thing and I realized I had set this up perhaps in the 

wrong way and it wasn’t going to work I could press the Escape key and then it wouldn’t save all 

of those forward. But let’s press the Enter key and there you are. Everything is done. Now that 

can be a real time saver, particularly if you have long lists of some things and you want to 

combine them in that way. 

There are limitations on what you can do using Flash Fill but it’s pretty good at joining things 

together. Now let me just quickly demonstrate to you that it’s pretty good at splitting things apart 

as well. 

So let’s see what Flash Fill can do with extracting the family names from this class register. 

Family name is column B, the starting name, that’s the family name, comma, first name or given 

name is column A. So let’s start with John Beale. His family name is Beale. Now let’s try Milly 

Clayton. And as you can see it’s coped with that very well. It’s got all those family names sorted 

out okay so I’ll go with that. And what about first name? And once again it’s fine with that as 

well. So that’s separated out the family names and the first names in my class register. 
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That’s it. That’s Flash Fill. I’ll see you in the next section. 
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Chapter 11 – Viewing and Printing 

Video: Workbook Views, Zoom, and Freeze 

Toby: Hello again and welcome back to our course on Excel 2016. 

In this section we’re going to look at Viewing in Excel 2016. You’ve already seen a few aspects 

of that but I’d like to fill out a bit more of the detail. And the first thing we’re going to do is to 

select the View Tab on the Ribbon. 

Now the left most group on the View Tab is the Workbook Views Group and there are actually 

four options here: Normal, Page Break View, Page Layout View, and Custom Views. Now 

Custom Views are out of scope for this course so we’re only going to look at Normal, Page 

Break View and Page Layout View. I mentioned the three of these earlier on in the course and 

those three option correspond to the three buttons down towards the right hand end of the Status 

Bar. So you can actually use those buttons to switch between the three views.  

Now in reality you can work in any one of the three views. There are a few restrictions and 

constraints and most of the time most people use Normal View but you may sometimes find it 

convenient to use the other two.  

Page Break View is very often used to preview printing. So let’s suppose you wanted to print out 

this list of the top 50 movies and you wanted to see how it was going to be on paper. And if you 

look at this particular example you can see the big Page 1 in the middle there. If you look 

towards the bottom of it you’ll see a blue dashed line which indicates a page break. And in fact 

that’s one of the reasons it’s called Page Break View. You can see where the page breaks would 

occur if you just printed this worksheet now with the current printer settings. 

Now as far as printer settings are concerned we’re going to look at those in the next section. And 

the page breaks when you are printing a worksheet from a workbook will depend not only on 

how much data you’ve got on the sheet of course but things like the font size in use and the size 

of the paper you’re printing on to the orientation of the paper. Are you using landscape or 

portrait orientation, for example? So there are many factors that come into the determination of 

where pages break. And the issue of page break is one of the ones we’re going to be looking at 

particularly in the next section. 

The third option, Page Layout View, gives you some very straightforward facilities for adding 

headers to pages and for adjusting margins and so on. So you can use that if you like to fine tune 

how the pages are going to look when you print them. 

Now we’re going to cover those printing options and the many aspects of Page Layout View in 

the next section as well. 
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So for the moment let’s go back into Normal View and let’s take a look at the Zoom 

functionality. 

Now I demonstrated to you a couple of times earlier on. You have the Zoom Slider down there in 

the bottom right hand end of the Status Bar and you have a number of ways of using the Zoom 

Slider. You can either click and hold the slider, slide it backwards and forwards to adjust the 

view or you can use the minus button there which effectively zooms out, plus button to zoom in 

or you can just click on that number there, the zoom level. Now if you click on that you get this 

little Zoom Dialogue. And the Zoom Dialogue lets you zoom to a specific magnification, 100%, 

200%, etcetera. Then you click on OK and you’ll see your worksheets at that particular 

magnification. And then you have options there for those fixed sizes or in fact you can click in 

this box and type in a custom magnification.  

There is another option on there, that’s Fit Selection. Let me just cancel here for the moment. I’m 

just going to zoom out. Let’s suppose that I selected the title and say the first 25 movies, made a 

selection, and now what I do is say Fit Selection, click on OK and it will zoom to the selection I 

made, the top 25 movies. 

The corresponding controls on the Ribbon there for that are in the Zoom Group. So you’ve got a 

Zoom button, you’ve got a 100% button which will zoom the document to 100% and you’ve got 

a Zoom to Selection button as well. 

Now of course if you’re using a touch device of course apart from those controls you can use 

pinch and stretch to achieve zoom. So let me just pinch this particular sheet now and of course I 

can stretch it out as well. 

And then one other thing I’d like to show you here is Freezing Panes. 

Now it’s not immediately apparent from this straightforward list of movies but you can get 

problems where you have many columns of data and perhaps quite structured rows and columns 

that as you scroll up and down and across a sheet you can lose header information. Let me give 

you an example here. 

Here we just have two columns, title and year of release. And if I scroll down as I get to the 

movies further down the list you see that I’ve lost the header. Now in this case it’s not very 

difficult because it’s pretty obvious that column A is a title, column B is probably a year of 

release. But if you had other information such as, for example, director and photographer you 

may not know which column was the director and which column was the photographer and 

maybe which column showed the person in charge of special effects and so on.  

Now what you can do is that you can Freeze rows and columns of your worksheets to make it 

easier for people to understand the data. And let’s suppose that I wanted to Freeze, in this case 

just the top row. In the Window Group on the View Tab there is a Freeze Panes button with a 
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dropdown. And I’m going to choose first of all Freeze Top Row and you should just about have 

seen a little line appear at the bottom of the top row. The top row is now frozen. Watch what 

happens as I scroll now. You see that the title remains in place. 

Now you should also be able to see that if I had many other columns of information, such as 

director, location of filming, photographer, producer, and so on that would soon go off the right 

hand end and as I scroll left and right across the sheet I would lose the name of the movie. Well 

supposing I wanted to keep the top row with the headings and the name of the movie. So I want 

to keep the top row and the left most column. Let me first of all stop freezing the top row. So I’m 

going to click on Unfreeze Panes there. And then I click in the cell that is below the rows that I 

want to freeze and to the right of the columns I want to freeze. So I want to freeze just the top 

row so I’m going to click below the top row. And I want to freeze just the left hand column. So I 

click to the right of the left hand column which means I’m going to click in cell B2. So that’s 

below the top row and to the right of the left most column. Now I go back to Freeze Panes and 

click on Freeze Panes. It’s now frozen row 1 and column A. And as I scroll about, move about 

within the sheet, you’ll see that they stay frozen. 

So that gives me the facility to keep headings and other identifiers in view. Whenever I’ve had 

something frozen I can unfreeze it with an Unfreeze Panes there from the menu. And also there’s 

an option there to just freeze the first column. So I’m going to Unfreeze Panes on this worksheet 

and that’s freezing panes. 

That’s the end of this section. I’ll see you in the next one. 
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Video: Printing 

Toby: Hello again and welcome back to our course on Excel 2016. 

In this section we’re going to take a look at printing and the time is almost certain to come when 

you’re going to want to print out one or more of your worksheets. And one important point I 

need to make at the outset is that exactly what you can do when you’re printing will to some 

extent depend on your printer. Now modern printers attached to most people’s home or work 

PCs tend to be very capable but if you have an older printer then some of the things that I’m 

going to talk about in this section may not be possible for you. 

Now the first thing I want to point out is that when you print something, supposing I just printed 

this worksheet, the top 50 movies worksheet, what Excel prints by default is just the content of 

the cells that have got something in them. It doesn’t print sort of thousands of columns and 

thousands of rows that are empty. So you don’t have to worry too much about thinking well if I 

hit the Print button am I going to get all this empty stuff printed as well. Having said that you 

also can have very tight control over what is printed. So if I wanted to print those empty columns 

I could. I’d just have to do one or two things to achieve that. 

Now the next thing to point out is that as with many other things related to Excel there is a sort 

of default, straightforward, one click version and that’s what we’re going to look at first. And 

then you have the option of selecting some specific features for printing and making the print 

happen in a certain way. 

So one very quick option for printing is on the Quick Access Toolbar if you’ve got this button 

enabled. You will see that mine says Quick Print and then in brackets afterwards it gives the 

name of the device that it would print this worksheet to if I just clicked this Quick Print button. If 

you have the Quick Print button enabled on your Quick Access Toolbar you should see a Tool 

Tip similar to that. But in your case it will give the name of either your printer or some other 

option for printing. I’ll explain what I mean by that in a moment. 

So one option is to click and it will print but that’s not quite the option I’m going to go for 

because what I’m actually going to do is to go into Backstage View and then go to the Print Page 

because I want to explain some of the settings on the Print Page. I very rarely just hit the Quick 

Print button because I almost always need to check the Print Settings on this page in Backstage 

View.  

Now first of all on the right I have a preview of how my print would look if I just hit Print now. 

There is a big Print button there which would do the equivalent of what that Quick Print button 

does on the Quick Access Toolbar. So if I just hit that button now what I would see on my 

printer is what’s on the right. Just below and to the left of the page on the right there is a little 

Page Control. So it currently says Page 1 of 2, current page. So it means I would see two pages. 

There are just four movies on the second page. Most of them fitted on the first page. So I 
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probably wouldn’t like that anyway. I’d probably want to squeeze everything onto one page but 

I’ll come back to that in a moment.  

So that’s my Print Preview on the right. That shows me what I would see. Now let’s look at this 

left hand column. It’s got the word Print at the top and that Print button. I want to go through 

these main options. 

First of all the number of copies, well it defaults to one but you can either type a number in or 

you can use the roller buttons to go to the number of copies that you want. And below that we 

have Printer. Now when I showed you the Tool Tip for the Quick Print button now I pointed out 

that it said HPPSE2500 Series Printer. That’s my default printer from this work station. And 

when you hover over the print device that’s going to be used you will often see a Tool Tip like 

that. Now if I click on the right, this little dropdown arrow on the right, you’ll see that I’ve 

actually got a choice of devices to print to. And you will also have a choice of devices to print to. 

Only that one in my case is physically a printer. I have a number of other print devices, none of 

which are physically printers. So I have a fax device. I have an option to print to PDF. So I could 

actually print this into a PDF file, a file in Adobe PDF format or a Microsoft XPS document. 

That’s Microsoft’s equivalent of PDF. Or I can send it to OneNote 16 which is basically 

OneNote 2016. Also if I want to add a printer, perhaps a network printer to use a different printer 

I’ve got an Add Printer option. And I also have the option of printing this straight to a file. 

Now I’m going to stick with the physical printer at the moment but it’s important to recognize 

the other options that you have on your device. 

Now depending on the print device that I’ve chosen I will often see a Printer Properties button 

here. If I click on that it normally brings up a dialogue that lets me set my printer properties. 

Depending on the printer that you’re using the dialogue will say different things. Mine’s quite an 

old color printer so I have a few pages of options here where I can do things like check the color 

management settings, specify the paper quality, and then I can look for affects like whether I 

want things to be printed actual size, whether I want them to be zoomed or percentage of normal 

size and so on. And I can also choose things like the orientation, portrait or landscape. I’ll come 

back to that in a moment. And then I can also choose any specific color settings. But for the 

moment I’m not going to change any of those options. I’m going to go with the defaults. Exactly 

what you see here will depend on your printer. It’s very unlikely to be the same as mine. 

So moving on down the settings, the next setting is which sheets do you want to print? By 

default it says Print active sheets. I’ve only got one worksheet in this workbook so it’s only 

going to print that one active sheet. But I could say Print entire workbook and then it would print 

every sheet in the workbook. I could also make a selection on the sheet and I could say Print that 

selection. Now in that way if I wanted, for example, to print some extra sheets or perhaps I just 

wanted to print part of this list, say the top 30, I could select those first and then say Print 

Selection. 
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I can also set up what’s called a Print Area and I could fix this as a selected area on my 

worksheet and I could print the print area. In fact you could also have an option here to say 

Ignore the print area. So if I’d set up a print area, which is a separate operation, I could at this 

point say ignore it.  

Now if I’ve looked at my preview and it covers many pages I can also specify here that I only 

want say the first two pages, page one to two. And then I could also say whether I want the pages 

collated or not. So if it was a ten page print and I wanted six copies. Do I want the copies 

collated or not?  

At the moment I have portrait orientation. I could switch to landscape orientation. Let’s try that. 

Look what happens in our preview. It’s still two pages but now it’s in landscape orientation. 

I choose the Paper Size. In the UK and Europe it defaults to A4. If you’re in North America you 

may have your default paper size set to Letter. So you have a default but then you can change to 

an alternative size if you want to.  

You can also change or set the margins. Now you can do that here but you can also do it using 

Options on the tab. And I’m actually going to show you that a little bit later on. So we’ll come 

back to that in a moment.  

And finally we have here No Scaling. Do you want to scale, so print the sheets at their actual 

size, or do you want to fit the sheets on one page, shrink the printout so that it fits on one page? 

Now this is one of the things that isn’t necessarily available with your printer. It will to some 

extent depend on the capabilities of your printer but it’s normally possible. You note how it’s 

managed to fit that on to one page. Of course it’s done it by making all the print a lot smaller. If I 

go back to portrait it’s one page but it’s obviously shrunk it all slightly to fit it. 

So the other options down here include Fit all the columns on one page or fit all the rows on one 

page. If you choose either of those it’ll concentrate on getting either columns or rows on one 

page but the others may sort of spill over. And you also have some custom scaling options here if 

you want to adjust the whole thing to fit a certain number of pages, for example. 

So there are many, many options there. And exactly what you get will to some extent depend on 

your printer. But basically when you’ve made all of those selections what you then need to do is 

to just hit the Print button and you will get, hopefully, the printout that you’ve requested. 

So let’s just look at a couple of other options. Let’s go back into the worksheet itself now and 

let’s go to the View Tab again and switch to Page Layout View.  

Now having gone into Page Layout View let me just zoom out a little and you see that many of 

the pages here are grayed out. These will not actually be printed. But when you’re in Page 

Layout View you can actually do quite a bit of the work you would do in Normal Excel View. So 

for instance I could add more movies to my list here. And you notice how the grayed out pages 
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say Click to Add Data. So you can work in Page Layout View. Now there are certain things you 

can’t do but there are some things that you can do very well. Let’s go back to 100% again. 

Now I mentioned just now when we were looking at the Print Page in Backstage View that you 

could set margins. Well you can set margins in Page Layout View. If I select the Page Layout 

Tab on the Ribbon one of the options is Margins. If I click on Margins I have a set of standard 

margins. So Normal, Wide, Narrow. I can also set Custom Margins. Let’s suppose that I’ve 

decided here to set Wide Margins. Now you probably noticed the change in the margins now. 

But not only can I go back in there if I want to and see that I’ve got Wide Margins set, you can 

select it on the list there. But I can also in Page Layout View manually set the margins.  

So if I go here to this sort of mini ruler along the top here, this edge here is the right margin. 

Note the Tool Tip. And I could actually change that right margin like that or indeed go back and 

change the left margin. And then if I look back at the Margins Command here I’ll see now that 

I’ve got Custom Margins selected. 

So as you can see in Page Layout View you can actually adjust the look of the pages in a very 

sort of look and feel, interactive kind of way. 

Now this even extends to being able to change the contents of the sheet itself. So for instance, 

let’s suppose that I wanted that title column in my table to be wider. I’ve got plenty of room on 

the right. So what I could do is go up here to where it indicates columns A and B and I can 

change the column widths. And again it’s interactive and visual.  

So there really are a lot of things that you can in Page Layout View that let you customize how 

your pages look when they’re printed. 

And one other thing you can do. I’m just going to give you a quick demonstration of this. What 

about adding a Header? 

Now if I click here in Add Header not only am I given a space to enter a header into but I get one 

of those Contextual Tabs that I mentioned towards the beginning of the course. And the tab is a 

Design Tab and it’s part of what’s called the Header and Footer Tools.  

Now having done that not only could I type a title for my pages in here but I could insert one of 

the standard and footer elements. So for instance, I could insert the file name. Click File Name, 

that’s inserted there. Now it may not look like the file name but it’s actually a code that goes in 

there and when you printout you would see the file name. In this case Top 50.xlsx. And if I 

wanted to put something in the footer, if I click on Go to Footer it takes me to the bottom of the 

page and maybe in there I could put the current date. And again a code goes in for the current 

date. And when I print those pages I’ll see the current date. 

Now having entered the header and footer anytime you want to go back in and do some more 

work on it you can just click in there and you get the Header and Footer Tools Design Tab again 
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which means you could insert one of those standard elements or indeed as I say you can type 

what you want not only into that center box but there’s also a left side and a right side.  

And I mentioned just now that these are actually codes that go into the header and footer here to 

indicate things like the file name and the date. If you go into Backstage View again to the Print 

Page you do actually see the page as it would appear printed. So you get the actual file name and 

the actual date there, which means that you can check exactly what you’re going to get. 

That’s the end of this section. Please join me in the next one. 
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Video: Exercise 03 

Toby: Hello again and welcome back to our course on Excel 2016.  

In this section I’m going to set you Exercise 03 and you can see in front of you here my answer 

to Exercise 03. And what I’ve done here is to take the climate figures for my area and I’ve put 

them on a single A4 page, ready to print, and I’ve put a header on the page. It says actually 

Annual Rainfall Figures for Northallerton, North Yorkshire. And then on the footer of the page 

I’ve put the date on the left hand side in U.S. format and I’ve put Page 1 of 1 on the right hand 

side of the footer. I’ll come back to that in just a moment. 

Now I’d like you to do just the same sort of thing and preferably print it out to make sure it looks 

good. Don’t worry about the alignment of the columns or the fact that the heading looks a bit 

boring and the text is all the same size, same color, all that sort of thing because in a couple of 

sections from now we’re going to start to look at formatting worksheets. All we’re really trying 

to do here is to make sure that you can set up a header and a footer and that you know how to use 

your printer. 

Now if you haven’t got a physical printer or if you don’t want to use the paper you could print 

this say to a PDF file and then open the PDF file and have a look at it. Obviously to a large 

extent you can see what it looks like just by looking at this preview but it’d be good if you can 

print it out or print a couple of copies out as well. 

Now I mentioned just now the right hand side of the footer where it says Page 1 of 1. Then 

obviously in a one page document that’s particularly useful but if you had a worksheet that ran to 

sort of 20 pages when you printed it might be nice if it said Page 7 of 20 in case you dropped 

them all on the floor and got them out of order. 

So let’s just go back into this worksheet and let’s go Page Layout View which is where I am at 

the moment and then I’m going to click in the footer here and just look carefully what it says in 

the footer. It says actually the word Page. So I’ve typed the word Page, then I put a space, and 

then I inserted the code for Page. Don’t forget on the Design Tab in the Header and Footer Tools 

there is a button to insert the page number. Then I put another space, the word Of and another 

space, and I’ve put the number of pages. So that’s another Field Code. So it actually says Page 

and then the Field Code for the page number, Of, and then it’s got a Field Code for the number 

of pages. So you can actually build up a sort of composite component in the header or the footer.  

So that’s Exercise 03 for you. I’ll see you in the next section. 
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Chapter 12 – Cut, Copy, and Paste 

Video: Methods of Cutting, Copying, and Pasting 

Toby: Hello again and welcome back to our course on Excel 2016. In this section we’re going to 

take a look at Cut, Copy and Paste. 

Now the first thing I need to point out is that Cut, Copy and Paste work to some extent in a 

similar way to the way that they work in other Windows applications but there are quite a few 

additional features or shall we say specific features of Excel that you need to be aware of. So 

what I’m going to go through first is some pretty straightforward examples of Cut, Copy and 

Paste and I’ll point out many of those features as we go. You can Copy, Cut, Paste individual 

cells, whole rows, whole columns, any combination of cells, rows and columns, and in fact you 

can Copy, Cut and Paste whole worksheets, including between workbooks.  

So let’s just take a straightforward example. Let me just select the cells from M9 down to M14. 

There’s a number of ways of doing that. Of course one way of doing that is to click on M9, keep 

the mouse button down, drag down to M14, and then I can just copy.  

Now on the Home Tab in the Clipboard Group there’s a Cut and Copy button available to me. 

There’s no Paste at the moment because I haven’t got anything on the Clipboard. But if I just 

click the Copy button I’ve copied the selection there to the Clipboard. Note the little marching 

ants round there. And if I select a similar range of cells here, of course the Paste button is 

activated in the Clipboard Group and I can simply click on Paste and the contents of the selected 

cells are pasted. 

Now of course as usual because that column is too narrow you can’t see that that’s correctly 

pasted. So if I select column H I could, for example, go to the Format button and say AutoFit 

Column Width and it will AutoFit that column to the pasted content. 

Now one very important point to note here is that the marching ants are still marching. So that 

selection is still inforce and the content is still on the Clipboard. So if I want to Paste it 

somewhere else I can.  

Let me select another of cells but this time I’m going to do it wrongly. So I’m going to have one 

more cell selected than I actually need. I’m going to click on Paste and basically what it does is 

to paste into the cells that it needs. So it still works but it doesn’t use all of the cells. Let me 

select less cells than I need, do Paste again and in fact if you just select one cell, the one where 

you want the Paste to begin, it will successfully paste into that range.  

Now you need to be a little bit careful about this because Excel will Paste over existing content if 

you ask it to. So if I selected the cell above H9, so I select H8, and click on Paste it will Paste 
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what’s in the Clipboard, overwriting what I pasted before. So you do need to be a little bit careful 

when you’re pasting.  

Now you can of course use the standard Keyboard Shortcuts for Cut, Copy and Paste. If I hover 

over the Cut button up there, as you can see the Keyboard Shortcut is Control-X, the Keyboard 

Shortcut for Copy is Control-C and in fact although Paste is currently disabled the Keyboard 

Shortcut there is Control-V. If I do a Cut, of course, so if I click Cut for my selection of cells and 

click here and do a Paste, having done the Cut and Paste of course then the selection is no longer 

available to me in its original location. It’s been Cut.  

And something else you will have noticed is this tiny little icon down in the bottom right hand 

corner and it’s called the Quick Analysis Tool. Now I’m not going to look at the Quick Analysis 

Tool at this point but later on in your use of Excel you’ll find that having in this example pasted 

some content into the cells, this tool gives you access to a number of things you may want to do 

to this pasted data. For instance you might want to draw a particular chart or perhaps create a 

total for the contents of those cells. Now as I say I’m not going to look at that at the moment but 

I’m sure you’ll find that’s something that will be useful to you later on. 

What I’ve done now is to change the formatting of some of the content of this sheet. So in 

column K I’ve changed the Font, the Font Size, I’ve got it Italic and Underlined, and in Column 

O I’ve added some color to the background and changed the Font Color to White. Now when 

you’re doing Copy, Cut and Paste you are actually potentially cutting, copying and pasting a lot 

more than just the words or numbers in the cells. You can also cut, copy and paste colors, 

formats, font sizes, all sorts of different things. And when you do a Copy you copy all of those 

things to the Clipboard. When you do a Paste you select what you actually want to Paste. 

Now let’s take an example. Let me go to these money values, these currency values over here, 

and I’m going to Copy them. This time I’m not going to use the Ribbon. I’m not going to use 

Keyboard Shortcuts. I’m going to right click and use the Contextual Menu and one of the options 

there is Copy. So marching ants as usual. I’ve copied everything to the Clipboard. I’m going to 

Paste it into column J but when I Paste it what I’m going to do first, I’m going to right click and 

I’m going to look at these Paste Options.  

Now if you look at the top group there is Paste which will literally paste exactly what there is in 

column O. Note the colors, the values and so on. But I could also say Paste Formulas. Now at the 

moment pasting formulas won’t mean very much to you but I’ll explain that a little bit later on in 

the course. But if you have formulas here, so for instance if you had a formula whereby the 

contents of these cells were being calculated by adding up other cells it’s the formulas that you’d 

paste not the values. I can say Formulas and the Number Formatting. Note that in that case not 

only am I putting in the numbers such as 127.5 but I am pasting the fact that it’s currency 

formatting. I can say Keep the source formatting. I can say Paste with no boarders. I can say 

Keep the source column widths as well. So not only paste what’s there but keep the column 
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width. So as you can see I’m not actually going to go through all of these. As you can see there 

are many options for how you do this paste and what you keep and what you don’t keep. 

Now given that you have really quite an array of options here it can be quite difficult to decide 

exactly which one to use. And there’s a long list there. There’s over a dozen buttons. But if you 

go down to the very bottom there is a Paste Special option. And Paste Special brings up the Paste 

Special Dialogue which many people find an easier way of doing exactly the sort of Paste that 

they want to do. Now in order to demonstrate this I’m actually going to Paste into a different 

location. So let me cancel this and let me put the cursor there and then right click and go into the 

Paste Special Dialogue. And with this dialogue you have really a couple of main sections. You 

have a Paste section and an operations section. And then you also have a couple of options down 

here, Skip blanks and Transpose. I’ll come back to Transpose in a moment. Note also that you 

have an option there to Paste a link. So if you’re using Links that’s the button to use.  

When it comes to Paste you’ve got the simple option on the left. Do you want to Paste Formulas, 

Values, Formats, Comments, or Validation? Most of the time you’ll probably be pasting 

Formulas or Values or Formats but let’s on this occasion say that what we want to Paste is 

everything, All, using the source Theme. So we’re basically going to Paste the numbers, the 

number formats and the source theme from our original selection. But in the lower section I’m 

going to choose Transpose which will transpose columns to rows, rows to columns. Now I could 

as part of the Paste operation include an operation of add, subtract, multiply, or divide. On this 

occasion let’s just keep it simple and we’ll do a Paste of everything but we’ll do a transpose. 

Let’s see what happens. And what you get is the contents of those cells formatted as, actually 

it’ll be accounting amounts. You can tell it’s Accounting rather than Currency because the 

currency signs are to the left of the cell and they’re pasted across instead of pasted down. 

So that’s an example of the use of the Paste Special Dialogue. 

The next thing I’m going to do is to demonstrate to you the use of the Format Painter. And this is 

a quick and easy alternative to using Copy and Paste of Formats. If I select one or more cells, let 

me select from O9 down to just say O11 and what I want to do is to apply the formatting of those 

three cells to a different three cells. Having made that selection if I click on Format Painter and 

then click on, let me just click on the first one and what happens is the format is applied to the 

range of cells, the set of cells corresponding to the size of range, in this case three cells, a little, 

short column of cells if you like, that I had selected when I clicked the Format Painter button.  

So the Accounting Format has been applied to those three cells. Now you may look at that and 

think, “How did Monday become $42,072?” Well I did mention to you before that dates in Excel 

are held as the number of days. In fact since the 1st of January 1900. So it’s actually 42,072 days 

from the 1st of January 1900 to Monday, March 9, 2015. So given that Excel has stored that date 

as a number if you reformat it as an accounting figure that’s how much money it corresponds to. 
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Now when you use the Format Painter, as we just have, once you’ve used it once it’s no longer 

available. And if I click somewhere else it doesn’t have any impact. If I select those three again 

and instead of clicking on Format Painter I double-click on Format Painter than in effect it’s 

sticky and I can use it once, note the little brush next to the cursor. I can use it again. I can use it 

over and over again. And then when I finished using it I can just press the Escape key. 

Now it’s very straightforward to Copy and Paste any kind of shape here. So if I wanted to Copy 

and Paste a set of cells there which corresponds to six down and two across, if I Copy that I’m 

going to use the keyboard this time, Control-C, click somewhere else suitable, Control-V. I’ve 

copied and pasted all of that. And you can, as I mentioned right at the beginning, Copy and Paste 

whole rows and whole columns. You need to be a little bit careful when you’re doing Copy and 

Paste in particularly rows and columns because as I say generally speaking things overwrite. So 

if I selected row 9, right click on it and click Copy, and then say select row 13 and do a Paste. 

Let’s just do a straightforward Paste. Then I’m going to completely overwrite what’s in row 13. 

However if I were to restart that and Copy row 9, so do a copy, and then select row 14 but 

instead of doing a Paste I select the option here Insert Copied Cells what happens is it inserts the 

row into the sheet and moves what was row 14 down to become row 15. And or course 

everything below that gets moved down as well. And exactly the same thing would happen with 

columns. Let’s select column H and copy it and then let me select column K, right click, Insert 

Copied Cells, and it puts a copy of row H as the new row K and moves everything else to the 

right. So that’s an area to be careful with. 

That’s the end of this section. Please join me in the next one. 
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Chapter 13 – Formatting a Worksheet 

Video: Delete and Clear 

Toby: Hello again and welcome back to our on Excel 2016. 

In this section and the next couple of sections we’re going to look at formatting worksheets. You 

should by now have a pretty good idea about how to enter data into worksheet, how to edit it, 

and also how to format it from the point of view of the type of data. What we’re going to start 

looking at now is how to do things like add and remove rows and columns and how to do some 

of that coloring in, how to change the background colors of cells and how to use specific fonts, 

as well as things like alignment of text and numbers. 

So in this first section I’m going to concentrate first on inserting and removing rows and 

columns. But before I do that just one thing. The reason for spending time on formatting 

worksheets is not only to make them look good which is often a very, very important thing in 

itself. I’m a great believer in the fact that presentation is everything. But also by judicious 

formatting the message that you’re trying to put over with the information in your worksheets 

can be a lot stronger. So making sure that the points that you’re trying to make easily stand out is 

very important and formatting is in turn a very important aspect of that. 

So the first job I’m going to do is to tidy up this worksheet. I saved it at the end of the previous 

section, Business Expenses 02.xlsx. I left it in quite a mess as you can see and there’s quite a lot 

to do to make this worksheet usable again and certainly presentable. 

So before I do that I just want to do one other thing, mention one other thing because this is 

going to be quite important from now on. If I click on a cell, let’s click on that one. It’s got 

42,072 in it. It’s actually of Accounting Data type at the moment so it’s $42,072. If you look 

over to the left of the Formula Bar there’s another box here. It’s actually called the Name Box 

and it says K8. And K8 is of course the Cell Reference for that cell. It’s column K, row 8. Now 

when it comes to deleting and inserting rows and columns let me just quickly delete a column 

here. I’m going to delete column D. So I’m going to select it, I’m going to right click and I’m 

going to say Delete. I’m going to delete column D. Look what happens to that cell, the one that 

was K8 just now is not surprisingly J8. Now you will see as we start inserting and deleting rows 

and columns that the cell references change accordingly. And as we’ll see in three or four 

sections from now once we start including these cells into formulae and functions and drawing 

graphs and so on it’s quite easy to think well what happens to my formula here. If I’ve got a 

formula that’s going to add some cells together won’t those formula get upset by inserting and 

deleting rows and columns? Won’t all my references change? Won’t Excel get confused? Well 

the answer to that is no it won’t because although the references to your cells change every time 

you insert a row, insert a column and perform many other operations as well, Excel always keeps 

track of any changes which are consequences of changes that you make. So if you delete a row 
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or a column or something you don’t have to worry about that. Excel will look after the 

consequences of it for you.  

So let me start by doing some inserts. So I’m going to insert a new column. If I select column E 

and right click and click the Insert I will get a new column inserted. Now it’s actually inserted to 

the left of the column that I had selected. So the column that I had selected actually moves to the 

right. And I’ve got one column inserted because I had one column selected. If I selected two 

columns, let me select F and G. So just to do that if you select F by clicking on the header, drag 

across with the mouse with the mouse button still down and then release you’ve got two columns 

selected. If I now right click and do Insert I get two columns inserted. Not they’re empty but I’ve 

got two columns inserted. 

Now inserting rows pretty much works the same way. One very important point to note though, 

I’ll just mention this now but just something to be aware of. I’ve selected row 8 and I’m going to 

do an Insert. This time I’m going to do the insert using the Insert button in the Cells Group on 

the Home Tab. I’m going to click on Insert Sheet Rows and I get a newly inserted row above the 

row that I had selected and that newly inserted row is itself selected. So that’s fine. If I had 

selected two rows I would have got two rows above, etcetera. 

But now let me select row 12. Now look carefully at row 12. You see that it’s got some 

formatting itself, a bit of that sort of mustardy colored background shading and it’s got some 

shading above it and below it. Let’s select row 12 and let’s do an insert again. Now once again 

when I do this I’m going to get a row above the one that I had selected and that new row will 

itself be selected, but also the newly inserted row has some formatting. It inherits some 

formatting from the row above the one that was selected when I did the insert. Now this may all 

seem rather baffling to begin with but once you’ve been doing this for a little while you’ll get 

used to the fact that when you do do inserts, particularly inserts of whole rows and whole 

columns, there are situations where you can inherit some of the formatting surrounding the 

selected row or column. So it’s something to be aware of. I’m not going to linger on it now. 

You’ll soon get the hang of dealing with it when it occurs, if it happens in a way that you don’t 

want. But you don’t get, necessarily, a completely empty row or column when you do an insert. 

You may get some formatting. You won’t get any content as in numbers and letters and so on but 

you might get some formatting. It’s just something to be aware of. 

Let’s now look at doing deletions. Let’s delete that row 12 that I entered. So all I need to do is 

select the row. If I look at the Contextual Menu I’ve got a Delete option. On the Delete button in 

the Cells Group on the Ribbon I’ve got Delete Sheet Row. So let me use Delete Sheet Rows on 

this occasion. That row is deleted. 

Next I’m going to delete several columns. Now first of all I can select a whole range but 

supposing I want to delete two columns and they are not next to each other. So they’re not 

adjacent columns. Say I wanted to delete columns K and N. If I select column K by clicking on 
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its header, hold the Control key down and select column N I’ve got two non-adjacent columns 

selected. I can do that of course with any number of non-adjacent rows or columns. Having done 

that if I go back to the Delete button in the Cells Group on the Ribbon the Delete Sheet Rows 

option has become a Delete Sheet Columns option. So these options are context sensitive. So 

let’s do Delete Sheet Columns. Those two are now deleted. 

But I can of course delete a whole range of columns quite easily. So to delete columns B to L if I 

click on the header of column B, keep the mouse button down, drag across to column L, so I’ve 

got that whole selection made, right click, click on Delete, and all of those columns are now 

deleted. And I’m back to having something that’s a little bit closer to my expenses. 

Now you can see some other things that I need to delete but before I do I want to talk to you 

about Clear because something Clear can be a better option than Delete. 

Let’s look at these cells here from B20 through to E20. They have formatting and they have 

content. So for instance, the cell B20 has got the number 73.5 in it which because the cell is 

formatted in Accounting Format its got a dollar on the left hand side and 73.50 on the right and 

it’s got that sort of mustardy color background and that’s part of the Fill Color of the cell. Now I 

could of course just select row 20 and delete it because I don’t actually need that but sometimes 

you may want to note delete everything in a cell or a row or a column. You may just want to 

delete the formatting or perhaps delete just the content and that’s where Clear comes in. 

Now with row 20 selected if you look at the Home Tab and the Editing Group there is a Clear 

button with a dropdown. And on the dropdown you have a number of options. You have Clear 

All which basically clears everything, Clear Formats, Clear Contents, Clear Comments, we 

haven’t talked about Comments yet but you can put comments in a cell, and you can also put 

Hyperlinks in a cell and you can clear those with the Clear Hyperlinks option.  

Let’s first of all try Clear Formats. Now if I click on Clear Formats I’ve removed both the Fill 

Color and the Accounting Format, so the number formatting, and all I’ve got left are the actual 

numbers in those cells. Let me Undo that change and instead of Clear Formats let’s do Clear 

Contents. Now if I do Clear Contents the contents themselves, the numbers have gone but the 

number formatting, in this case Accounting Format, and the Color Formatting, the fill 

formatting, etcetera, that is all still there. So if I clicked in cell B20 and typed the number 13.4 

and click, it’s $13.40, still Accounting Format. So when I did the clear I lost the actual numbers 

in there but I kept all of the formatting. 

So sometimes Clear is a good option. Let me on this occasion though select row 20 and say Clear 

All and to all intents and purposes that does the same as a delete. It’s not quite as simple as that 

because the delete would have moved everything underneath up one whereas the clear just clears 

the content without actually deleting the row or column. 
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Okay I’ve got two more columns to delete. That’s D and E. So now I’m back to having just the 

information that I need. There’s quite a lot of work to do on the formatting and there’s quite a lot 

of work to do on adding some additional information. But for the moment let’s just do a final bit 

of tidying up. 

Let me take the cells from B10 to B16 and what I’m going to do there is to say Clear Formatting. 

So I’m back to just the numbers. And then what I need to do with those is to apply a consistent 

number format. In this case what I really want is that Date Format and I’m going to put that Long 

Date Format back again. And over here, D10 to D16 I want to just clear the formatting. Really I 

only want to clear the coloring, if you like. Now I could do that by changing the Style. I’ve not 

talked about Style so far. I’ll be coming back to that a little bit later on. For the moment let’s just 

do exactly this equivalent of what we’ve just done on column B. We’ll say Clear Formats and 

then what I’m going to do is apply, I’ll think I’ll put Currency Format on there now. 

Okay I have a few too many rows above here. Let me get rid of most of those. And then I have 

one more duplicate row to get rid of there. Select that, delete that, and I’m going to leave this 

expenses, Business Expenses 03 sheet like this for the moment and carry on working on it in the 

next section. I’ll see you then. 
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Video: Insert, Hide, Column Width and Row Height, and Merge 

Toby: Welcome back to our course on Excel 2016. 

In the previous section I did a lot of work on the Business Expenses spreadsheet. And in this 

section I’m going to do some more formatting work on it, including adding some additional 

information. 

First of all I’ve still got a couple of rows to delete there. So let’s get rid of rows 7 and 8. And 

now what I’m going to do is to add a couple of columns of information. I’m going to put a 

couple of columns between the current C and D. Now in order to insert two columns to the left of 

D I would select D and I can either do two inserts or I could select column E as well, right click, 

Insert, and I will have inserted two new columns. Now of course the text in column C, as you 

saw earlier in the course, shows in front of the empty cells in columns D and E. There are 

various ways of overcoming this as you saw earlier and I’m going to talk about this a little bit 

more later on in this section. But for the moment all I’m going to do is to click on the divider 

between the headers of C and D, drag over to the right and now I can clearly see all of the text in 

column C and columns D and E are empty. 

Now column D is going to hold a category for the expenses. So I’m going to start putting the 

categories in here. Now one interesting thing to note here is that when you’re entering data like 

this as I start to type Office Expense watch what happens. As soon as I’ve typed the first letter 

Excel tries to match what I’m typing to anything else that it can see that I’ve already typed. Now 

it can see the O in Office Expense so it offers me Office Expense. If in fact that is what I want to 

enter then all I need to do is to press the Enter key in this and that saves me having to type the 

rest of the content in that cell. Column E will contain either Yes or No, indicating whether the 

expense is rechargeable to the relevant customer. So let’s go to E3 and that’s it. Now I’ve 

finished entering my new data. 

Now I’ve shown you how to delete columns and rows but you can also hide data as well. And if, 

for example, you wanted to show this worksheet to somebody but you didn’t want to show them 

some of the data. Supposing you didn’t want to show them whether the expense was chargeable 

or not. If you select column E, if you right click on it one of the options is Hide and that hides 

that column. Now you may look at that and think well that doesn’t look very well hidden to me 

because a) I can see a thick black line and also there is a gap between the letters D and F in the 

headers so there’s obviously a missing column there. Well it is true that unless you take 

additional precautions it’s actually quite easy to see that there is a hidden column. But even 

without those additional precautions which basically involved putting protection onto the 

worksheet you can still successfully hide things in some situations. For example, if I wanted to 

print out this worksheet and I didn’t want to show that particular column, if I do a print now. So 

let’s just go into Backstage View and go to Print, look at the Preview. You’ll see that the hidden 

column is certainly not shown and also there is no sign that there is a hidden column there. So 
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you can use this even without taking these additional protective steps in order to hide 

information in worksheets. 

So let’s go back to our sheet. We can see that we’ve got that hidden column, the gap between D 

and F. Just for information the hiding is actually done by making the column width zero. But 

let’s select D and F and in fact if you click on Format you can see on the Format Menu there is a 

Hide and Unhide. And you can see there Unhide Columns is one of the options and that will 

reveal column E again. 

Now the next thing that I’m going to do is to put some headings above these columns. So I’m 

just going to type some entries into row 2. Now one thing to notice here is that as you add data to 

what is effectively a table of data like this one what tends to happen is that you constantly have 

to keep changing column widths in particular and sometimes even row heights in order to 

accommodate the data and to make it all visible without one lot of data obscuring another lot of 

data, for example. As we saw earlier you can adjust the column widths in a number of ways. In 

fact if you were to take a column like column C. Let’s select column C and click on Format and 

then choose Column Width you’ll see that each column actually has a numerical width. Now the 

numbers, in this case that number is 43, are not necessarily very straightforward units to deal 

with. So when you’re dealing with things like column widths you’ll probably deal with them 

more in terms of the relative values of those numbers rather than what the numbers actually 

mean. So when you have a column width of 43, if you wanted something roughly half that 

amount you might say well let’s try 20 or 25 without necessarily thinking or knowing what that 

actually is.  

But in fact one option that’s open to you if you use numbers like column width numbers is that 

you can set widths to fixed amounts. So for instance, if I wanted to make this column 50 units 

wide click on 50, click on OK and it’s done. Similarly if I wanted to make columns D, E and F 

all the same width, supposing I wanted to make D wider and I wanted to make the others the 

same width I can say Column Width. Well it’s currently 8.43. Let’s try 15. Yeah 15 looks okay. 

And I could set the others to 15 as well.  

Another popular option of course is the one we used earlier which is to use AutoFit. So select the 

whole lot and go for AutoFit Column Width. And in that situation Excel will use enough width 

for each of the columns without leaving an excessive amount of space in any of them.  

Now another issue which needs attention is that as the description there of the expense gets 

longer you can see that column C could get very wide and unless you put some possibly 

problematic restrictions on how people describe expenses you could find column C getting just 

wider and wider and wider in order to accommodate long descriptions. Now the way that you 

can overcome this in Excel is to change the formatting of column C so that text in the cells in 

column C wraps. Now on this occasion what I’m going to do is to make the text in column C 

wrap for every cell. But you may want to exclude the header cell, Description, from this 
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normally. But let’s just select the whole of column C, click on Format Cells, go to the Alignment 

Tab and one of the options there is Wrap Text, and let’s click on Wrap Text, click on OK. Now 

there’s no visible sign of a difference there because in fact all of the text in column C currently 

fits in the available space without wrapping. But supposing I make column C narrower now, 

watch what happens to row 6, the one that says Annual Subscription to Industry Digital Service. 

What happens is that it appears to be truncated. But if I select row 6 and then go up to the Format 

button on the Ribbon and say AutoFit Row Height watch what happens. What happens is that the 

height of row 6 increases so that the text in column C in row 6 can all be seen. So basically the 

text wraps within the cell.  

Now clearly I’m going to need to apply the same principle to any other entries in column C 

where the text needs to wrap. So what I’ll normally do is select maybe a few extra rows and 

apply the AutoFit Row Height to many rows. I might in fact apply it to the whole worksheet but 

I’m aware of the fact I need to do a couple of things to the headings yet. So at the moment I’ll 

just apply that AutoFit to a number of rows. 

Now before we move on I’d just like to point out something else. If you look again at the Row 

Height Dialogue you’ll see that little question mark there that brings up Help. I mentioned the 

units in which rows height and column width are measured. Well those units are actually 

described in the Excel 2016 Help. So for example, the row height is measured in units of a point. 

A point is actually a printers measure that corresponds to 172nd of an inch or 0.035 centimeters 

approximately. So as you can see they’re not necessarily the most convenient units to work in. 

But if you do want to know what those units are so you can do some calculations then you’ll find 

that information in the Help. 

And one other thing that I’d like to do here is to put an overall heading on this table of expenses. 

So what I’m going to do is above the headings that currently say Date, Description, Category, 

Recharge, and Amount I’m going to put another heading. I’m actually going to insert a row 

above there and I’m going to just have a single row and I’m going to type in the first column, 

that’s B2. I’m going to type Toby’s Expenses. Now purely by accident there I finished up with a 

strange font. That doesn’t really matter because I’m going to deal with that in the next section. 

But if I select B2 and keep the Shift key held down and select F2 what I’m now going to do is to 

Merge the cells from B2 to F2.  

And there are a number of ways of doing this. One of them is to use one of the buttons in the 

Alignment Group on the Ribbon. It’s on the Home Tab. And it’s actually a button that says 

Merge and Center which will merge those cells into a single cell and center the contents. So that 

gives me a sort of relatively nice heading on my table. Now it’s not a particularly nice or suitable 

font but as I say we’ll deal with that a little bit later on.  

When I’ve merged those cells together I can treat this as a single cell and the Cell Reference for 

this will be the reference of the top left cell in my merged set. I can actually merge whole groups 
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of cells. So for instance, I could select here from say L5 down to R20 I think that is and say 

Merge and Center and that’s made into one big cell. And the reference of that one big cell is L5. 

It’s the top left hand one. 

With that cell selected if I go back to Merge and Center and click on the dropdown one of the 

options is Unmerge Cells and that returns everything to how it was. And similarly here if I 

clicked within that Toby’s Expenses cell I could unmerge if I wanted to. And merging cells is 

very often used for putting headings above sets of data on sheets and giving structure to data. 

Now we’re going to carry on formatting this particular table of expenses in the next section. I’ll 

see you then. 
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Video: Alignment 

Toby: Welcome back to our course on Excel 2016.  

In this section we’re going to continue looking at formatting a worksheet and I’m going to 

concentrate on this section on Alignment, both horizontal alignment and vertical alignment. 

Now I’ve mentioned horizontal alignment in particular earlier on in the course and if you look at 

this current worksheet and the cells that already have content there is quite a mixture in terms of 

how the content is horizontally aligned in the cells. So for instance, if I look at this date here in 

cell B4 it’s clearly right aligned. It’s sort of pushed over to the right, whatever space there is on 

the left. Whereas if I look at the content of C4 the text in that cell is pushed over to the left. It’s 

the left aligned. Now how the content of cells is aligned depends primarily on the formatting of 

the cell. And as I pointed out earlier in the course and in many situations by default the general 

type is assigned to cells when you enter data for the first time. Now sometimes, depending on 

what you’ve actually entered into a particular cell, Excel will decide on a more specific data 

type. But if you take something like say this entry here, Annual Subscription to Industry Digital 

Service, if I right click on there, go to Format Cells, you’ll see that its data type is General. 

Now as the note says there, General format cells have no specific number format. And generally 

speaking a lot of the time you’ll be quite happy with General format cells provided they look 

okay and you won’t really need to go in and do anything particular to them. So what I’m really 

looking at here is how to control things either when what Excel is doing is not what you want or 

when you want to be very specific about the layout of individual cells or rows or whatever in a 

worksheet. 

Now let’s look at the columns in this particular worksheet. Let’s start with column B. We have 

dates there in that Long Date Format and they are right aligned. Let us select one of the cells and 

let’s change the alignment. Now there are a number of ways that you can change the alignment. 

One of them is by changing the type. But on the Home Tab in the Alignment Group there’s a set 

of buttons that enable you to change the alignment very easily. That’s little group here. This is 

Horizontal Alignment. So you have Align Left, you have Center and you have Align Right. So if 

I click Align Left on that one you can see how that’s left aligned in the cell. Now of course I 

could change individual cells by selecting them and changing the alignment. That looks really 

bad. Or I could select a whole group, perhaps all of those dates and maybe Center Align them.  

Now we do get into a situation here where what I think looks good may not be what you think 

looks good and vice versa. But generally speaking centering long dates like that looks a little bit 

clumsy to me. Having said that I think that it’s actually quite difficult to make long dates look 

very neat. If you Right Align them I think that probably is the best of the three options. 

But of course the other option when you’re looking at those dates and saying well that looks a 

little bit messy, a little bit sort of ragged. If I right click and go into Date Format I can always 
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change them to one of the other formats instead. So for instance, one of those Short Date 

Formats like that one. Then if I center them, yeah maybe that looks a little bit better. 

Generally speaking when it comes to dates if you want something that looks neatly aligned one 

of the best things to do is to use say a Short Date Format where you’re not subject to differences 

in the lengths of the words that are months or days of the week. But to make sure that you put 

leading zeros on the numbers. So if I right click on there again, go into Format Cells again but 

this time choose that format, the one that’s got leading zeros, click on OK, then all of those dates 

are of exactly the same length. 

Now one of the things that we did just there was to format a whole load of cells at once and 

that’s something that you’ll very often do. And in fact the cells in column C here have all sorts of 

different formats applied to them. So for instance, you’ve already seen that C7 that has Annual 

Subscription to Industry Digital Service in it has its type set to General. Whereas if I click on 

Taxi to International Chemicals, C5, and look at that it’s actually formatted as Text. One or two 

of the others have very strange formats indeed. So for instance, C4 has a format of Zip Code. 

Now one thing I pointed out to you earlier on is that Excel will try to use the format that you’ve 

specified to arrange a cell in a particular way but if you put content in which is nothing like that 

format, well Excel just lets you get on with it really. 

If I select a whole range of cells and they have a mixture of formats what happens when I click 

on Format Cells is that there is no category selected at all. This basically tells me that I’ve 

selected a range of cells where the cells have different formats. And if in this case I want to make 

them all Text Format, which I will, I can select that format, click on OK, and that format will be 

applied to all of those cells. And similarly if I go up and do an Align Right when they’re all 

selected then the text in all of those cells will be right aligned. 

There will be situations where you may well want to right align text but generally speaking we 

left align text. 

Now one of the other things I want to demonstrate to you here though is an alternative text 

alignment. I want to select in C7 and I’m going to do a little bit of Copy and Paste but I’m going 

to do it in a very specific way. I’m going to enter an extra space in the Formula Bar at the end of 

Annual Subscription to Industry Digital Service and I’m going to Copy the text in that space and 

I’m not selecting the whole cell. I’m actually selected the text in the cell by selecting it in the 

Formula Bar and then I’m going to Copy it to the Clipboard by using the Keyboard Shortcut 

Control-C. Now I’m going to put the cursor after the space in the Formula Bar and I’m going to 

Paste the text again. So basically it’s like I’ve just typed that again. And I’m going to do it say 

five times and then tick.  

Now what you can see there is a bigger block of text in that cell. And what I want to talk about is 

one other option for alignment, horizontal alignment in a cell and that is to use what’s called 

Justified Alignment for the text. Now in order to do this I’m going to go to this little Dialogue 
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Box Launcher here to bring up the Format Cells Dialogue. I’m going to make sure the Alignment 

Tab is selected and then for Horizontal Alignment I’m going to choose Justify and click on OK. 

And what that does is to Justify the text which means that it’s even on the left hand edge and on 

the right hand edge. And this is the kind of justification that’s used, for example, in newspapers 

and magazines to give you both edges of the column even. 

Now sometimes this looks really good. It can be problematic because when you’re dealing with a 

narrow column, and C is actually quite a narrow column, what happens when you Justify text is 

that you finish up with quite big spaces between the words. So for instance if you look at the line 

there Industry Digital Service Annual you can see how big the spaces are between the words 

which is what Excel has to do in order to keep both edges of the text even. But it is worth 

knowing about that justified text as an alternative to having left, center or right. 

Center of course looks like that which is really quite strange. Let’s put it back to left. 

And then finally I’m going to just delete all that text that I don’t want.  

In terms of the Horizontal Alignment of the other columns here, some of this is really very 

subjective. A list of yes’s and no’s probably looks best if you Center Align it. The categories 

there probably left aligning and numbers almost always look best right aligned. Some people like 

Accounting Format because with the column of currency amounts like this it does tend to look 

neater with all of the currency symbols aligned. But that’s pretty subjective as well. And very 

often people like column headings as we have here to be centered. So let’s select just the column 

headings and Center Align those and again that tends to make things look a little bit neater. 

So that’s Horizontal Alignment. 

Finally for this section let’s take a look at Vertical Alignment. Now if you look, for example, at 

cell B7 the date there is bottom aligned in the cell. In fact there’s a little group of three buttons 

up here in the Alignment Group which are the Vertical Alignment buttons. There’s Bottom 

Align, Middle Align, Top Align. And when a particular one of those options is selected, as it is 

in B7, it’ll be highlighted. So that tells us that B7 is bottom aligned. Although obviously looking 

at it you can tell that it’s bottom aligned. 

I don’t really know why Excel by default bottom aligns things because I don’t really like bottom 

alignment. I know some people who do but most people don’t really like it. And I tend to prefer 

top alignment.  

So if I wanted to change the alignment on that cell, clearly with the cell selected try Middle 

Alignment. Yeah that looks okay. Top Alignment, that looks okay as well. I just don’t like 

Bottom Alignment. 

If I wanted to change the alignment on the whole of this row, row 7, which is the only one really 

that’s affected because it’s the only one where the text in column C wraps and therefore the row, 
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row 7, is much taller than the other rows. Then I can either select the row and say I’m going to 

Center Align the whole row. Even that I think looks better than Bottom Align. Or I could say I’m 

going to top Align the whole row. I prefer top alignment myself. And if I wanted to apply Top 

Alignment to every cell on the sheet I select all the cells by clicking up there in that little block in 

the corner and then I can select Top Alignment for the whole sheet and everything on that sheet 

will be top aligned. Although of course in most cases there is no visible difference with the 

Vertical Alignment anyway because everything is only one row high, except row 7. 

So that’s Vertical Alignment. 

That’s it for this section. Please join me in the next one. 
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Video: Themes and Styles 

Toby: Hello again and welcome back to our course on Excel 2016.  

In this section we’re going to apply some styling to the Business Expenses worksheet that we’ve 

been developing. And we’re going to do this with the general approach of using Themes and 

Styles. 

If you’ve used either earlier versions of Office or other components within Office 2016 before 

chances are you’ve come across the use of Themes. And Themes give you a straightforward and 

consistent way of producing good looking documents whether they’re Word documents or 

PowerPoint presentations or indeed Excel worksheets. 

Now I’m going to assume for the moment that you really have no knowledge of Themes. I’m 

going to explain the basics quickly now. And then we’re going to use the Theme and Style 

approach to making this worksheet look a lot more attractive. 

So first question is what is a Theme? Well a Theme is a set of fonts, colors and other stylistic 

components that give a consistent look and feel to a document. If you select the Page Layout Tab 

in Excel on the left there’s a group called Themes and a button in there which is also called 

Themes. And if you click on the dropdown there you’ll see a list of the themes that are available 

to you on your device. Now you can get themes from other sources. You can download 

additional themes from Microsoft. You can actually buy themes from other sources. But the 

standard set you get will probably be similar to the list that I’ve got here. 

Now I’ve got one Custom Theme there. I called it TA Theme. But by default you probably will 

find that any workbooks you’ve created have the Office Theme and that there will be other 

themes such as Facet, Integral, Ion. And what you’ll notice as I hover over those is that I have a 

live preview of the effect of each of those themes on my existing workbook if I were to apply 

that Theme. Now at the moment the Office Theme is selected. Watch what happens if I hover 

over Facet. The font changes, the sizes change, the overall look changes quite considerably. 

There’s very little color in this workbook but you can see the difference there just by changing 

the font and the sizes. Let’s try Integral and Ion. So basically by applying a different Theme I can 

get a very different look and feel to my workbook. 

Now let’s stick with the Office Theme for the moment and let’s look at how we can extend this 

into the use of Styles. 

The sort of data that we have in this worksheet is actually quite structured. We have a description 

of the data. It says Toby’s Expenses. That’s like a sort of heading on this data. And then we have 

some headings on the columns: Date, Description, Category, and so on. The individual items are 

individual expense items and each of those we have a date, a description, etcetera. Now in order 

to reflect this structure and to make the worksheet easier to interpret we can apply styles which 
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correspond to that structure. And if you’ve used Microsoft Word before in even a much older 

version you’ll be familiar with the idea of Heading Styles.  

So what I’m going to do is go back to the Home Tab on the Ribbon and one of the groups there 

is Styles. And if I click on the dropdown arrow there where it says More I have a list of available 

Styles. Now generally speaking how Style looks is dependent on the Theme. But we’re actually 

going to set this up independently of the Theme and then we’ll try applying different Themes 

later on. 

So let’s start with Toby’s Expenses. So all I need to do is to select Toby’s Expenses and I’m 

going to make that Heading Level 1. So let me bring up my Styles and say that’s Heading Level 

1. Let me just click away and you’ll see that what Excel has done is to style that particular cell. 

Of course it’s a merged cell. It’s made it Bold. It’s used a larger font and it’s actually put an 

underline. Now the underline is actually a Border on the bottom of the cell. But that gives me my 

Heading 1 effect. 

Now for the column headings I’m going to make those Heading Level 2 to reflect the structure of 

the data. So select those and let’s make those Heading 2. Again click away and you see a 

reasonably good structure. You notice how the text in those headings is slightly smaller. It’s 

Bold but it’s smaller. And you’ll see how although each of those cells has a Border at the bottom 

it’s a less prominent Border than the one on the cell that says Toby’s Expenses. 

Now let’s take each of the entries in the list of expenses and let’s supply another level down. 

Now I’m not going to make these Heading 3 or Heading 4. I’m going to make these just Themed 

Cell Styles. Now if I’d like to see what each of these is going to look like I can hover over and 

get a live preview. So I could, for instance, actually I quite like that one. Let’s go with 40% 

Accent 5 and I’ve now applied a Themed Style to the body of the entries in my table of expenses. 

And already you can see a very considerable improvement in the appearance of the table of 

expenses. 

Now let’s do one more thing. Let’s say that I want to make the dates and the amounts prominent. 

So I’m going to select the dates, I’m going to hold the Control down and select the amounts. I’m 

going to go back into Styles again and I’m going to make those 60%, no I think I’ll make those 

Accent 5. Okay. And then looking at the individual columns you note the Date column is much 

too wide. I forgot to reset the width of that column when I changed it from Long Date to Short 

Date in the previous section. So I’m going to select column B and also the Recharge column 

because the heading has been made Bold. The heading Recharge? doesn’t quite fit so I’m going 

to hold the Control key down, select column E, I’m going to go up to the Format button and say 

AutoFit column width, click away again, and there we are. Toby’s Expenses. That’s starting to 

look a lot neater than it looked before. 

Now let’s take a look at the effect on this sort of changing the Theme. What I’m going to do is to 

make column A very much wider for reasons that will become apparent in a moment. And then 
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on the Page Layout Tab, let’s go back to Themes. Not the Office Theme is the one that’s 

selected. Let’s preview some of the other Themes. Let’s try Facet. Notice a very considerable 

difference to appearance that makes. Now what I marked as Heading 1 is still Heading 1. What I 

marked as Heading 2 is still Heading 2 and so on. But everything reflects that changed Theme.  

Integral. Now notice with the Integral Theme selected I’ve got a situation where the content of 

the Date column don’t fit and that’s going to be a standard kind of issue if you change the 

Theme. You probably need to adjust things in order to make things fit again. But as I say that’s a 

fairly normal kind of thing to have to do in order to make your worksheet or worksheets look 

good again when you change Theme. 

Now of course with the Integral Theme selected here if I actually want to apply the Integral 

Theme then I would click on Integral. It is now the applied Theme. And if I bring up that 

Themes Gallery again you’ll see that it’s Integral that is highlighted. Of course it’s 

straightforward anytime to change back to the Office Theme again. 

So that’s how to use Themes and Styles. You can make exceptions. And in fact there is a very, 

very wide range of stylistic options in Excel where you can do direct formatting. Let me show 

you an example of that.  

I could select any cell that I like, say that one, the one which is in the middle row and it’s 

Category, Sales. And I could go back to the Home Tab and make that Bold and Italic. Now 

having made that one so Bold and Italic that’s direct formatting. Let’s go back to Page Layout 

again. Let’s go back to the Themes Gallery and let’s try looking at other Themes. It’s still Bold 

and Italic. It’s still different from the others in those other Themes.  

And in fact if I were to say take the Description column here, select the column and change the 

Fill Color. If I go back to the Home Tab one of the buttons there is this one which is Fill Color. 

And if I click on Fill Color it gives me a number of options for filling in the color. The top 

section are the available Theme Colors. And these Theme Colors are colors that will change if I 

change the Theme. The colors down here however, these ones, are standard colors that don’t 

change when I change the Theme. So what I’m going to do is to set that to that sort of yellow 

color there. That standard color. Now watch what happens if I change the Theme. So I’m on 

Office. I’ve got Bold-Italic for Sales in the Category column and I’ve set yellow as the Fill Color 

in the Description column. Watch what happens as I try the other Themes. Let’s try Facet. You 

notice how everything else changes but the Bold-Italic Sales is still Bold-Italic and the 

background color on the Description column is still yellow. Let’s try Integral, Ion. So you can 

see how that direct formatting basically overrides the Theme related coloring and styling. 

So finally let me just Undo those most recent style changes. 

That’s the end of this section. I’ll see you in the next one. 
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Video: Exercise 04 

Toby: Welcome back to our course on Excel 2016. It’s now time for Exercise 04.  

And in Exercise 04 I’d like you to take the weather data that you assembled in Exercise 03 and 

present it in a style similar to this. It doesn’t need to be exactly the same and you don’t need to 

choose the same Theme that I’ve chosen. But I’d like you to set it out like this. Make sure that 

you have Styles in place, that you have the Alignment of the data in the various cells correct, 

you’ve adjusted row heights, you’ve done things like wrapping text where necessary, etcetera. 

And you should finish up with a pretty smart looking table such as this one.  

I’ve included one additional little challenge here if you want to try something that’s a little bit 

trickier and that I haven’t gone through already.  

If you look, for example, at the heading on the Max Temperature column instead of just saying 

Max Temp C I put a little degree symbol in there. And to put in those symbols unless you’re very 

good at remembering very complex key strokes the best option to use is on the Insert Tab on the 

Ribbon. The right hand end there is an Insert Symbol option. So if you were trying to do this in 

the Formula Bar, Max Temp C, if you put the cursor to the left of the C you’ll see I’ve already 

got that little degree symbol in there. If you do Insert Symbol you should be able to insert a 

symbol, a degree symbol in there. 

So that’s Exercise 04. My sample answer is in the usual place. That’s it for this section. I’ll see 

you in the next one. 
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Chapter 14 – Formulas and Functions 

Video: Basics of Formulas and Functions 

Toby: Welcome back to our course on Excel 2016. 

This is the Business Expenses worksheet so far and how you found out quite a bit about 

formatting a worksheet and making sure that everything is starting to look pretty good. What 

we’re now going to do is to turn to what is probably Excel’s greatest strength and probably the 

reason that most people use Excel which is to do some kind of calculation or analysis. Whether 

your strength is in calculation or whether you’re doing it somewhat reluctantly I think you’ll find 

that many of the things that you need to do in Excel are pretty straightforward and we’re going to 

start with one or two really straightforward examples of calculations in Excel. And in doing that 

I’m going to try to demonstrate the general principles of doing calculations in Excel 2016. 

So the first thing I’m going to do is to apply a little bit of Zoom. Now let’s do some work on the 

total amount of Toby’s Expenses over the period that is in that table of values. 

What I’m going to do is to put the total in this cell here, F9. And first of all I’m going to do this 

whole thing pretty badly or at least you’ll see in a few minutes time that it was done pretty badly. 

And that is I’m just going to put a simple formula in here to add up the figures in column F. 

Generally speaking if in a cell rather than putting a number like an amount of currency or some 

text like the word Travel or a date you want to put a formula that something that involves a 

calculation you put an equal sign and that’s how you always begin cell contents where there’s a 

calculation to do, so equals. Now you actually enter the formula. Now in this case what I want to 

do is this. I want the contents of F4, so that’s F4, and I just type F4 and then I say plus and then 

I’ll want F5 and then I want and so on. So let me just put the others in and that’s a Formula. 

Now at the moment in the cell you can see the formula but if I enter that value now either by 

hitting the Enter key or using the Enter tick mark by the Formula Bar you’ll see what happens. I 

actually get the total amount of the expense claim over that period. 

Now before we go any farther there’s one very important to recognize here and that is that cell 

F9 is now unlike the other cells on this sheet because it has both a value, it’s value is $305.20 

and it has a Formula. And its formula is the formula in the bar. So when you click in the Formula 

Bar, you see in the Formula Bar the formula which you also actually see in the cell in that 

situation. But if you select the cell it’s the value that you see. 

So cell F9 has got a formula and a value. And closely associated with that is the fact that without 

changing the Formula the value may change. So let’s suppose that I spot an error in my 

expenses. Let’s suppose that the error I spot is that that Annual Subscription $64.50 should 

actually be $84.50. So there was a mistake of $20 right there. Let me change it to $84.5, tick. 

Now automatically the value in F9 is increased by $20. And when you make a change to a cell in 
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Excel any consequential changes are automatically carried out. So in this case when I change the 

value in F7, F7 is part of the Formula for F9 so the value of F9 is recalculated as well. So we 

haven’t actually changed the Formula in F9 but the value changed because of a change in the 

value in the cell F7. 

Now the Formula you can see here in F9 is a pretty straightforward Formula. It’s a Formula to 

add the contents of five cells together. And of course in Excel formulae can become extremely 

complex. And if you look at say the length of the Formula Bar there right across my screen you 

could have that Formula Bar full and more than full in terms of the complexity of the formulae 

that are possible in Excel. But apart from writing out a sum like this, =F4+F5+F6, etcetera there 

are some other ways of doing things like totaling a column of figures that are actually much 

more efficient ways of doing things. And I’m going to demonstrate one of those to you next. But 

just before I do I want to point out one other thing and this relates to something that I said earlier 

as well. 

If I were to put an additional expense in here. So let’s suppose that I realize that there was 

another expense for the 10th of March, March the 10th but I’d forgotten to include. Let me select 

row 7 and Insert an additional row. Let’s go back and see what the formula is in what is now 

F10. Look at the formula. It’s F4+F5+F6+F8+F9. What Excel can do is to compensate for things 

like inserting and deleting rows and columns. So not only do you not need to worry about that 

because Excel takes care of it but obviously you can use that to your advantage. 

Now let me just Undo that and I’m actually going to Delete F9. So don’t forget when I’ve got 

that cell selected I can either just press the Delete key or I could say Clear All because clearing 

all will clear formulas and it will clear contents and it will clear formats. It’ll clear absolutely 

everything. So that’s all cleared. And now I’m going to take a different approach to adding up 

that column of figures. 

And the approach I’m going to take is this. I’m going to select F4, keep the mouse key down, 

drag down to the bottom, and just include F9, then I’m going to release the mouse key. Now I 

mentioned this little icon down here before. Ignore that for the moment, the Quick Analysis icon. 

Don’t worry about that for the moment. What we’re going to do is to go up to the Editing Group 

on the Ribbon and next to the AutoSum button we’re going to choose Sum. And unsurprisingly 

the total we get is back to $325.20, the same as before. And we have a Formula in F9 but it’s a 

very different formula to the one we had before because it now uses the Excel Function of Sum. 

And the general format for a Function is that you’ll have the name of the function, in this case 

Sum, then you’ll normally have a set of brackets and then in this case there is what’s called a 

Range of Cells. So it’s a range from F4 to F8 and the ranges indicated by a starting cell, then a 

colon, then the ending cell in the range. Now in this case those two cells are in the same column 

but in fact they could be in different rows and columns. So a range is actually a rectangle of 

cells. And in this case the top left of the rectangle is F4 and the bottom right of the rectangle is 
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F8. So we have a little sort of sub-column of cells. So in that formula we’re using the function 

Sum. 

Now one of the big advantages of using the Sum function there is you haven’t got to type in the 

list of cell names. But there are some other advantages to it as well and let me do what I did just 

now and insert a row corresponding to a missing expense. So let me select row 7 again, do an 

Insert and let’s now look at that formula. And the formula is still just =Sum but in this case not 

only does it cover the correct range from F4 to now F9 but if I put a value in here, let’s say I put 

a value in there of say $17.30, it would be included in the calculation because by using that 

function I didn’t have to specifically mention the new F7. All I needed to say was the range and 

F7 is automatically included because it is in that range. So that’s a big advantage of using a 

function here.  

Now let me just Undo that last couple of operations. And the other thing that is particularly 

useful about this approach, let’s suppose that instead of adding up those expense amounts I 

wanted for some reason to find which the largest was. If I click within the Formula Bar and 

delete the word Sum and instead change it to the word Max what I’ll see there is the Max figure 

in that column. So the maximum amount is $127.50. Or what about the average figure? Now as I 

start typing that function name a whole list of the functions that begin with the letter A appears. 

And at this point if I wanted to just scroll down, find the one I want, Average, that’s the one I 

want. Let’s take that, tick that. The average expense amount is $65.04. In Excel 2016 there is a 

very, very large number of Functions available. 

So in this section I’ve introduced you to the basics of Formulas and Functions. In the next 

section we’ll start looking at some more complex calculations and how to set those up efficiently 

and effectively in Excel 2016. So I’ll see you then. 
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Video: Complex Examples of Formulas 

Toby: Hello again and welcome back to our course on Excel 2016. 

In this section we’re going to continue to look at formulas and functions and we’re going to 

concentrate on a more complex example of the use of formulas. 

I have here a simple list of rooms in a house that’s going to be refurbished. And I have the length 

and width of each of the rooms in the house. So I have a dining room with dimensions 5 meters 

by 5.6 meters and so on. Now I’m doing these calculations in meters and square meters but just 

think of them in any units that you’re familiar with. 

Now the first thing I want to do is to work out the floor area of the whole house because I’m 

going to work out a budget cost for carpeting this house. 

So if I wanted, for example, to work out the floor area of the dining room then to get the area of 

the floor I would multiply the length by the width. So once again let me first of all zoom in and 

let me click into E5 and type in a formula. So it will be =C5*D5. So there we. There’s my 

formula for the floor area. So let me tick that and I can see that the floor area of that room is 28 

square meters. 

Now what I could do is to click into E6 and type in the corresponding formula for the area of the 

living room floor multiplying C6 by D6. But in fact there is another way of doing this, a much 

easier way of doing this and that is to use Fill because where cells contain formulas Fill, in this 

case Fill Down, will actually fill down the formulas and adjust the formula in each cell according 

to its position. Let me show you what I mean. Let me select from E5 down to E13. Now I’m 

going to use the Keyboard Shortcut Control-D to do a Fill Down and I have all of my room 

areas. If I click in the cell E6 look at the formula, C6*D6. If I click in E7, etcetera. So the 

formula in each case is adapted to suit the position of in this case the floor area cell, the cell in 

column E, with effectively its row number. So that means I don’t have to type in all of the 

individual formulas. 

Now that’s absolutely fine. It’s a little bit annoying actually. I tend to be a little fussy about these 

things. I’m going to give all of those floor areas two decimal places so that it looks a lot neater. 

So having selected all of the cells from E5 to E13, note they contain formulas but I can still 

format the cells to determine how the values are displayed. So if I go into Format Cells say that 

these are Numbers and I want two decimal places, click on OK, then I just think that for those 

floor areas that looks quite a bit neater. 

Now what I’m going to do is to work out a budget cost for the flooring. Now the figure that I’m 

working on is a cost per square meter for flooring of $21.00 per square meter. No idea whether 

that’s a realistic one, depending on what’s required in this house but it’ll do for our purposes 

here. 

http://www.simonsezit.com/


Learn Excel 2016 for Beginners: Master the Essentials 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 
 

So let me put a heading in here and now what I need to do is to work out the cost of the flooring, 

for example, in the dining room. Well it’s going to be the cost which is $21, that’s the cost per 

square meter, times the area of the dining room floor which is E5. Let me enter that and I have a 

cost of what’ll actually be $588.00. So let me do a Fill Down of this. Don’t forget for Fill Down 

I can go to the Editing Group and use Fill Down there. And I’m going to format these values as 

Currency Values. Two decimal places and that’s it. 

So that’s the cost, the budget cost of the flooring in each of the rooms.  

Now if I click in one of the other cells, say F9 for example, you can see that it’s very 

successfully put 21*E9 for the cost in that room. One of the issues here is that let’s suppose that I 

then found that my budget for flooring had to be decreased or increased. So instead of $21 it was 

going to become $19.50. I’d have to go through and change all of those formulas. Now I could 

change the first one and do a Fill Down but generally speaking it’s a better idea to treat 

something like the budget cost per square meter of the flooring as what would often be called a 

perimeter, an input to the calculations, a separate figure that we can maintain separately, change 

separately and we could perhaps experiment with different budget costs to look at a different 

overall cost for the flooring in the house.  

So one of the approaches that we could take here would be to put our cost figure in a separate 

cell altogether. So for instance I could choose cell I5 and type 21 in there and use that as my cost 

per square meter. Now an advantage of that is that if my cost per square meter changes all I need 

to do is to change the value in I5.  

So first of all let me format that value. Now let me change the formula in F5. So now instead of 

21*E5 I’m going to put I5*E5 and some of you may already spot the problem here but let’s carry 

on. And I have the same total of course, $588.00. Now let me do my Fill Down. What do you 

think is going to happen? Well in fact what’s going to happen is I’m going to get a nasty surprise 

because as I do the Fill Down all of the other costs become $00.00. And you can see the reason 

by looking in, for example, the Formula in F6 because F6 says I6*E6. Excel doesn’t realize that 

although I want the row numbers in my flooring dimensions to go 5, 6, 7, 8, 9, etcetera my 

budget cost per square meter in I5, I don’t want that to change. I want them all to refer to I5. 

Whatever the row number in the calculation column I want always the formula to say I5. So I 

want to fix that 5. 

Now the way that I do that in Excel, go back to that formula again, is that in front of the 5 in I5 I 

put a dollar symbol. And that makes that reference an Absolute Reference, so the 5 won’t vary. 

Now in fact I could put a dollar in front of the I as well. It’s not actually necessary in this case 

but it would just emphasis the fact that in the Formula I5 is a fixed cell. It is always the cell that’s 

in row 5 and column I. So it’s $I$5. Now let me do my Fill Down and now I’m back to my 

figures being correct. And if I say looked in cell F11 the formula is $I$5xE11. So that’s how to 

use an Absolute Cell Reference in Excel 2016. 
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Now there are a couple of other things that I’d like to demonstrate here. Let’s suppose that I now 

want to put a note next to $21 to explain what that figure is and I’m going to need a little bit of 

space. I could make column H wider. What I’m going to do instead is I’m going to Insert an 

extra column or two here and I’m going to say Merge those three cells. And I’m going to say, 

let’s make that a little bit wider. Now what you can see here is that the $21 is now in cell K5 but 

it hasn’t actually affected my budget flooring cost. And if you look in the formula here you’ll see 

that Excel is intelligent enough to realize that although I’m dealing with the Absolute Reference 

in the various formulas here for the cell that contains that cost per square meter. So what was I5 

is now K5. It’s intelligent enough to realize that I’ve actually moved that cell but it’s still that 

one that I need to refer to. So you won’t upset it by moving that figure, for instance by inserting 

columns as we’ve done just here. 

Now let me just Right Align that in the cell and I’m going to apply a bit of style to that cell. Let’s 

go with that one. That’s fine. 

And just one other thing I’d like to demonstrate to you. I’m going to click in I8 and I’m going to 

make a mistake. I’m going to try and put a formula in put I’m going to put it in wrongly. I’m 

going to for some reason want to work out what twice the floor area of the bathroom is. I don’t 

know why. But instead of putting for the floor area of the bathroom E8 I’m going to put B8 by 

mistake. Now B8 of course is the name of the room, the bathroom. One thing to notice here in 

the Formulas when you refer to a cell is that Excel maintains a color coding system. So you can 

probably see quite clearly there that B8 in that formula is blue. Well that’s the same blue that’s 

used on B8 now once I’ve entered its Reference in the formula and you can use that color coding 

to relate the elements in a formula to the corresponding cells on the worksheet. So in this case 

the blue that’s used for B8 in the formula is the same as the blue that’s used around the word 

Bathroom in the cell B8. And if I referenced a number of cells they’d each be given different 

colors accordingly. That can be a very useful way of identifying which object on a worksheet is 

being referred to. But in this case I don’t really want to refer to B8. It’s actually a mistake. I just 

want to show you what happens because the chances are you’ll see this quite a bit. Let me tick 

that. You get that to Excel users a very well-known piece of bad news, #VALUE!. It basically 

means you’ve put something illegal. You’re referencing something or trying to do something 

which is illegal. You can’t multiply the word Bathroom by two in Excel. And that will normally 

tell you that there’s something wrong with a formula or you’re referencing something that isn’t 

there or that you can’t do that to or whatever. So in that case you look at the formula, you look 

and you say okay =2*B8. You look at B8 and you say oh it says Bathroom. That can’t be right. 

And then you’ll correct your error and you’ll be fine. 

So that’s an important thing to recognize as normally indicating that a formula is trying to do 

something that’s not possible. 

Well that’s it on this introduction to Formulas and Functions. I’m going to give you an exercise 

next in the next section. I’ll see you then. 
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Video: Exercise 05 

Toby: Welcome back to our course on Excel 2016.  

In this section I’m setting you Exercise 05 and we’re looking at my answer to Exercise 05.  

With Exercise 05 I want you to take the weather figures that you produced for Exercise 04 and 

produce some summary information. Now if you look at the figures for where I live near 

Northallerton in North Yorkshire, if you look at the average rainfall figures they’re the exactly 

the same as they were before month by month from January to December. But then I have an 

average overall 12 months of the year and then I’ve got a maximum figure, 63.3, which just 

happens to be in August. We get most rain in the summer. And the minimum, 39.9, is actually in 

February. 

Now the Functions and Formulas that you use here, hopefully you’re going to be able to work 

out okay. Let me just look at one of these because one thing to be careful of is, let me take this 

one, MIN(C4:C15). You need to make sure that it covers the correct range from C4 to C15. If 

you start doing Fill Downs and of course you can Copy and Paste cells with formulas in as well 

very successfully in Excel. Just always be careful at this early stage of using Formulas and 

Functions that the range of cells that you’ve got within a reference to a function such as this one 

is the correct range. I’ve seen people do this exercise before and instead of having C4 to C15 

here they’ve got, for example, C6 to C17. So everything sort of got out of step. That’s something 

to be careful of until you get used to this in Excel. 

So pretty much Max Temps the same and Min Temps the same. Work out the average, work out 

the maximum. So here the maximum 20.8, that’s in July for us. And the highest minimum 

temperature is a bit of strange concept but the highest minimum temperature is also in July, of 

course. 

And then what I’ve done is to introduce a second column of figures. And this column of figures 

compares the rainfall in the month to the average. Now if you take January, for example, the 

main rainfall is 55.5. The average for all months is 53.5. So January is a +2. The rainfall is 2 

millimeters on average above average. Whereas for February where the rainfall average is 39.9 

compared to a monthly overall average of 53.5. February actually has relatively very low 

rainfall. On average it has 13.6 millimeters of rain less than average. 

So basically this second column is comparing the figures in the first column with the average for 

the first column. So that’s a slightly trickier thing for you to do. See if you can work out the 

Formulas and Functions in each case. 

That’s Exercise 05. I’ll see you in the next section. 
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Chapter 15 – Managing Worksheets 

Video: Rename, Insert, Move, and Reference a Worksheet 

Toby: Welcome back to our course on Excel 2016. 

In this section we’re going to take a look at how to work with worksheets, how to manage 

worksheets in Excel 2016. And I’m going to start by looking again at this house refurbishment 

workbook. 

You may have noticed when we were working on this earlier, working out the floor area and the 

budget cost of flooring, that there are actually a couple of Tabs at the bottom of the window. The 

one that we were working on says Floors and the other one says Room Sizes.  

Now if I click on Room Sizes I see a different worksheet with different content. And in fact the 

Room Sizes worksheet has more information about the house. It’s got details of the height of 

each room and the results of calculating the wall areas. And this workbook has two worksheets. 

So far we’ve only worked on the Floors one but if we wanted to do estimation based on the wall 

areas, for example, we could maybe return back to the Room Sizes sheet and use some of the 

information there.  

Now one thing to briefly mention here in case you’re getting a little bit confused by what you’re 

seeing on the screen is that each sheet can be shown at its own Zoom level. So when I’m looking 

at the Room Sizes sheet I’ve actually got the Zoom set at 88%, whereas when I’m looking at the 

Floors sheet I’ve got it set at 170%. So please don’t be too confused by that. 

If I wanted to add another sheet to this workbook it’s pretty simple. In fact there are a number of 

ways of doing it. That little plus sign there in a circle, if you look at the Tool Tip there, New 

Sheet, that gives me a new sheet. And when I get a new sheet there is a default name in system. 

So let’s have another one. You’ll soon see what the default naming system is. Sheet 1, Sheet 2. If 

you’ve used a very much older version of Excel you’ll know that in the early days of Excel you 

always got Sheet 1, Sheet 2 and Sheet 3 when you created a new workbook. But as I mentioned 

much earlier in this course now by default you just get one sheet and it’s called Sheet 1. 

The two sheets that I had in this workbook originally had already been given more meaningful 

names and it’s very easy to give a sheet a new name. All you need to do is to right click on it. 

You get a little Contextual Menu and one of the options there is Rename. So let’s click on 

Rename. The whole of the text in the current name is highlighted. Let’s call it Walls. And that 

sheet is now called Walls. 

The sequence of sheets, the order from left to right there, Room Sizes, Walls, Sheet 2, Floors is 

actually not significant in terms of the calculations processing you do but you may like to 
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arrange things in a certain way, for instance for your own convenience or to make it easier for 

you to find things. 

So let’s suppose I wanted to move Walls so that it was the last sheet. All I would have to do is 

click and hold. You get a little symbol like sheet of paper with a turned down corner and then 

you can just drag it into position. So I could just drop it there. 

Now you saw just now that little Contextual Menu. Let me just select the Floors sheet, right click 

and let’s look at one or two of the other options that are available here. Insert, that’s another way 

of inserting a sheet. So if I click on Insert I get a little dialogue. By default it gives me an empty 

worksheet but I can in fact insert a number of other things. So I can put in sheets with specific 

characteristics but we’re not going to cover that now. By default that would just give me a new 

worksheet. Let me Cancel that. Right click again. If I wanted to Delete a sheet it’s 

straightforward enough. So let’s say Sheet 2, right click, Delete, and it’s gone. And then I can 

also Move or Copy a sheet. So if I’ve got more than one workbook open I can actually Move and 

Copy sheets between workbooks. But if all I want to do here is to Move this sheet rather than 

make a copy of it, if I click on Move or Copy I can say if I want to move it where do I want to 

move it to. If I want to move it to the end that’ll be the equivalent of doing the drag that I did just 

now. Select Move to End. If in fact I want to make a Copy at the end I would check this box, 

Create a Copy. I’m just going to move it, click on OK and it’s moved. 

Now there are just one or two of the other options on that Contextual Menu that I want to briefly 

mention here. 

It is possible to Protect a sheet, to stop users accessing it or changing it. This can be very useful 

if some of the information you have in a workbook is confidential, for example. And it’s another 

reason why it can be useful to have more than one worksheet. 

You also have the option of Hiding a sheet. Another option here is View Code. I mentioned just 

now that the order of the sheet isn’t important. Well I think I probably should have said that it’s 

not important at this stage because particularly if you start to write program code in Excel the 

order of the sheets can be important. In fact there are one or two other situations where the order 

of the sheets is important but these won’t really come into force for you for a while yet. 

You can also, for example, change Tab color. So if you want to give a sheet a particular Tab 

color you can click that and that sheet will appear with a different color on its Tab to the others. 

Now the other thing I want to demonstrate now about worksheets, a very important one. I’m 

going to add a new sheet. Note that I’ve got the Floors Tab selected here, the Floors worksheet. 

Click on plus. The new one appears to the right of the selected sheet. And what I’m going to do 

is to go back to the Floors sheet and I’m going to select the cells from H5 to K5 and I’m going to 

Cut those. And what I’m going to do is I’m going to select Sheet 3 and I’m going to Paste them 

on to Sheet 3. Now cells B2 to E2 on Sheet 3 now say Cost of Flooring per Square Meter $21. 
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Do you think the calculations on the Floors sheet will still work? Let’s go back to Floors and 

they do. Let’s take a look at the Formulas. And what you see in the Formula is that the Cell 

Reference there now says $E$2, as before Absolute Reference, but before that it has the name of 

the worksheet that that cell is on. So it’s Sheet 3. Let me go and change the name of Sheet 3. I’m 

going to rename it to Reference. So this is going to be the sheet where I keep my references, the 

values that I’m basing my calculations on. Now let’s go back to Floors again. You notice how 

that Formula has now changed to say =Reference!. We normally say =Reference-bang and that 

means that refers to another worksheet in the workbook. So it says Reference!$E$2 is an 

Absolute Reference to cell E2 and then asterisk for multiplication and E5 is the cell containing 

the floor area of the dining room. 

So that’s how you reference one or more cells on another sheet in a workbook. 

That’s the end of this section. I’ll see you in the next one. 
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Chapter 16 – Working with Multiple Workbooks 

Video: Working with Multiple Workbooks 

Toby: Hello again and welcome back to our course on Excel 2016. 

In this section we’re going to look at a couple of aspects of managing workbooks and the first 

aspect we’re going to look at is how to have more than one workbook open at a time. Now there 

are various reasons why you may want to have more than one workbook open at a time. For 

instance, you may want to copy information between workbooks or you may want to setup a 

linkage between the two workbooks. And in fact in Excel 2016 in theory you can have a very, 

very large number of workbooks open at once. In practice there may be restrictions placed by a 

combination of the size of the workbooks and the amount of memory, the resources in general on 

your computer, on your device. Now to all intents and purposes normally with a modern 

computer with a reasonable amount of resources you can open as many workbooks at once as 

you want. 

I have one workbook open here, House Refurbishment 03. I want to open a second workbook 

and in order to do that all I need to do is to go to the File Tab into Backstage View, click on 

Open. Now let me open one of the other workbooks that I’ve been working on on the course, 

Monthly Electricity, and I’ve now got two workbooks open. 

And of course it’s straightforward to create a new workbook. So if I use the normal keystroke 

keyboard combination of Control-N I also now have a new book called Book 1.  

When you have two or more workbooks open you’ll want to be able to switch between them. 

There are a number of ways of doing this. One way is to if you click on the View Tab and look at 

the Window Group one of the options there, Switch Windows on the right. Click on the 

dropdown and there is the list of the three workbooks that I’ve got open. And by selecting one of 

those I will switch to that workbook. 

As I mentioned just now there are a few ways of switching between open workbooks. Let me just 

demonstrate one of the others. And that is if I move the cursor down, hover over the Excel icon 

on my Windows 10 Taskbar you’ll see there thumbnails for the three workbooks that I have 

open. And by clicking on one of those thumbnails that will take me to the relevant workbook.  

You can also you Task Switching in Windows. So for instance I tend to use the keyboard 

combination Alt-Tab. So hold the Alt key down and repeatedly press the Tab key to take me 

through the open applications, in this case the open workbooks. And when I get to the Excel 

workbook that I want to work on I just release the Alt key and I am ready to work on that 

particular workbook. So you can use Windows Task Switching in the usual way. 
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If, as in this case, I have a particular workbook open I can close it and the other two will remain 

open. So even if I use the Close button in the top right there, the Close Excel button, if I close 

that the other two workbooks are still open and available to me. 

Let me once again create a new workbook. So I’m going to use the Keyboard Shortcut Control-N 

again. I now have three workbooks again. And instead of switching between them what I’m 

going to do is to arrange things so that I can see all three at once. If I go to the View Tab one of 

the options there is Arrange All. If I click on Arrange All I get a little Arrange Windows 

Dialogue and I can choose how I would like my three workbooks arranged. I’m going to leave 

you to experiment with the options here. But I’m going to start, first of all, just with a 

demonstration of what Vertical looks like and there you can see a vertical arrangement of my 

three workbooks.  

Now you might think that well there’s something strange going on in the middle because 

Monthly Electricity I can’t see any data. That’s only because the content is over to the right in 

the sheet. Each of these windows with a workbook in it has its own Zoom and Scroll controls 

and so on. So in that middle view, the one of my Monthly Electricity account, I can use the 

Scroll Bar there to move around. It also has its own Zoom control. So if I need to see things I can 

change the Zoom in that one single window. So in that way I can do things like compare the 

contents of two or three workbooks. 

Now at any time I can restore them to being maximized. I can basically undo the tiling of those 

windows. Note that whichever workbook I’ve got selected at the time I’ll see all the normal 

controls. So for instance I could maximize that one. It goes back to full size again. Let’s put it 

back to 100%. So it’s very flexible in terms of how you can arrange the views of all of your open 

workbooks. And as I say I’m going to leave you to experiment with some of those others. Don’t 

forget, if you get a bit lost and you sort of find things a bit jumbled up you can always go back to 

the approach that I showed you just now. For example go back down to the Taskbar, hover over 

and here the House Refurbishment workbook is still the size it was when I was looking at the 

three of them vertically arranged side by side. I can just go back to that one, maximize it, change 

its zoom, and so on. 

What I want to do next is to demonstrate Copy and Paste between workbooks. What I’m going to 

do is to select some of the information about these floor areas from the House Refurbishment 

books. So I’m going to select a block of cells. I’m going to select that block of cells. I’m going to 

do a Copy using the keyboard. So that’s Control-C. And then I’m going to switch into the empty 

workbook, Book 3. I’m going to just select a single cell and do a Paste. Use the keyboard, 

Control-V and that looks absolutely fine. If I click in one of those cells, such as D4, you notice 

how I’ve actually got the number there 5.2, 5.2, etcetera and the words are exactly the words that 

I had in the original copy. I can adjust column widths and so on. 
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Now let me go back to the Refurbishment workbook. This time I’m going to Copy this block of 

cells, the ones that give the floor area. So it’s a Copy and then back into what was the empty 

book, click there, do a Paste. Now let’s look at what we’ve actually got for the floor area for the 

dining room. And what we’ve got is =D4*E4. It’s actually adjusted that formula to allow for the 

fact that we’ve used a different set of cells. We’re in a different workbook altogether actually. 

And Excel is able to adapt not only for the change in the row and column numbers as necessary, 

which I mentioned earlier on in the course, but it’s also adapted for the fact that we’ve moved to 

a completely different workbook.  

Now let me go back into Refurbishment yet again and this time I’m going to copy the Budget 

Flooring Cost figures. Again Copy and then back into my new book, once again do a Paste and 

once again it has correctly come up with the figures, the Budget Flooring Cost. Now the thing 

that’s a little bit strange here is that if you remember when I was calculating this Budge Flooring 

Cost I was using a Reference Sheet to hold the Cost per Square Meter of the flooring. So let’s 

take a look at the formulas here. And the formulas here now say multiply F4 in this case. So 

that’s the floor area of the dining room by and the reference figure that it’s given me is a 

reference figure from the House Refurbishment workbook. So it actually refers to the other 

workbook by name and in fact the name of the other workbook is put in square brackets. So it’s 

got square bracket, House Refurbishment 03.xlsx, then it’s got the name of the sheet which is 

Reference, and overall in fact the name of the sheet is House Refurbishment 03.xlsx, that’s the 

workbook name, then the sheet name which is Reference and then I get the exclamation mark, 

the bang, saying that the Cost per Square Meter on that sheet is in cell $E$2. So you can see how 

in a formula it’s now referring to a completely different workbook within that formula. So you 

can see how Excel Formulas can actually span not only more than one sheet but actually more 

than one workbook as well. 

So having looked at how cells in workbooks can refer to cells in other workbooks let me return 

to something else that we looked at briefly earlier in the course and that was moving and copying 

sheets but now moving and copying sheets between workbooks. 

Let’s suppose that I wanted to Copy the Room Sizes sheet to the new workbook. So I go to the 

original, the House Refurbishment book, select Room Sizes, right click, Move or Copy, and I’m 

going to choose from the available books. Now at the moment the book that’s shown is the one 

I’m currently working on, House Refurbishment 03. Let’s look at what else is available. There’s 

Book 3. And I can decide where I want to put it. Well I’m going to make a Copy at the end of 

Book 3. Now by making a Copy of course that means I’ll still have this Room Sizes sheet in 

House Refurbishment 03 but I’ll have a copy of it in Book 3. So let’s click on OK. That’s now 

copied and if you look in Book 3 you can see a copy of that sheet. 

Let’s now go back into House Refurbishment. Let’s now select the Reference sheet, right click 

on the Reference sheet. I’m going to move this Reference sheet. I’m going to move it to Book 3. 
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Not Copy it, Move it. Move or Copy, Book 3. I’m going to Move so I don’t check the Create a 

Copy box. I’m going to put it at the end, click on OK and I’ve moved that sheet. 

Now if in Book 3 I go back to Sheet 1 again you notice that my amounts of money are still 

correct. That’s have another look at that formula, the one we were looking at just now. Excel has 

realized that I’ve moved the Reference sheet between open books. It’s no longer in the House 

Refurbishment 03 book. It’s in the current book. So it can reference that cell just by using the 

sheet name Reference and then it just says Reference!$E$2, that’s the Absolute Cell Reference 

for the cell containing the Cost of Flooring per Square Meter. 

So once again you can see how intelligent Excel is when we come to moving and copying sheets 

around. 

Now finally what I’d like to look at in this section quite briefly is information about workbooks. 

We’re talking about managing workbooks here. And it’s very often very useful to keep 

information about your workbooks and also to be able to check certain information about 

workbooks that Excel maintains for you. If you go into Backstage View and look at the Info 

Page over on the right hand side you have some information about the workbook. Now much of 

that information is maintained by Excel. So for instance the size of the workbook. This one is 

15.9 kilobytes. The related dates. When was it last modified? When was it created? This 

workbook or in fact the original version of this workbook was created a very, very long time ago. 

It’s been modified over many versions of Excel. And it was last printed about four-and-a-half 

years ago. So as you can see I don’t print workbooks out very often. The author? That’s me. 

Who it was last modified by? That’s me. And as you can see there are various other properties as 

well. 

Now right at the bottom you have Show All Properties. That will show additional information. 

And when you’re showing all properties you’ve got an option at the bottom, Show Fewer. And 

right at the top you have Properties with a little dropdown arrow next to it. Click on that, click on 

Advanced Properties and you see a Properties Dialogue which contains five tabs of information 

about a workbook. 

Now some of that information as I say is maintained by Excel. So for instance when it was 

created, when it was last modified, when it was last printed, the size of the workbook, the 

location, and so on. But some of the information, such as the information on the Summary Sheet 

you maintain yourself. So you can type in a title, you can type in a subject, you can record your 

own name the way you want to see it. If this is work that you’re doing at work you may want to 

put your manager or the manager of the project this refers to in there, the name of your company 

and so on. You then have some statistics including the ones I’ve mentioned already. 

Contents. This summarizes things like which worksheets are included, which Named Ranges are 

included. I’ll be talking about Named Ranges a little bit later on. And then you can also have 
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Custom Properties as well. Now Custom Properties are outside the scope of what we’re doing on 

this course. 

One of the areas that many people find very useful is the set of properties that are on this 

Summary Sheet though. And if you put a title on a workbook, you describe a subject, it’s very 

often useful when you come back to look at old workbooks to remember what the purpose of 

those workbooks is. 

Now what I suggest you do now, this is not strictly speaking an exercise but maybe something 

you should do now and hopefully get into the habit of doing is for all of the exercises that you’ve 

done so far just make sure you put a title in that Title Field there at the top of the Summary Sheet 

and make sure that your own name is shown in the Author Field as well. And you’ll notice that 

I’ve done that on the exercises and the demo files that are included with the course. So hopefully 

I haven’t missed any of those. Make sure you do that as well from now on. 

That’s the end of this this section. Please join me in the next one. 
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Chapter 17 – Saving Workbooks 

Video: Saving in Different File Types 

Toby: Hello again and welcome back to our course on Excel 2016.  

In this section I’m going to take a look at other file types and file formats associated with your 

use of Excel 2016.  

Now as you’re going to see in a moment there are many, many different file types and I’m only 

really going to look at a handful of the most important ones. And I’m going to start by pointing 

out that the current format for Excel workbooks, the format that’s used when you save a file as 

an XLSX file, is the standard workbook file format in Excel 2016. And in fact it’s the same 

format that has been in use since Excel 2007. So this is its fourth version. But there may be 

occasions when you need to save one of your workbooks in an even older format. So for instance 

let’s supposed you’d produced a workbook like this one and one of your colleagues, one of your 

friends wanted to access your workbook but they had Excel 2003 or Excel 2000. They wouldn’t 

actually be able to open at this formatted workbook. So the solution to that is to save it in one of 

the older formats. 

Now in effect you have access to two older Excel formats. Let’s suppose I want to save it in the 

format that was in use in Excel 2000. If I do File and then Save As, go to my Course Files folder 

and where it says Save As Type which defaults to Excel workbook Style.xlsx you may remember 

from very near the beginning of the course that I pointed out that you can actually change that 

default within your Excel Options. If I click on this dropdown I get a list of the available formats. 

And as I said just now it’s a very long list. Now amongst the other formats that are available we 

have that one, Excel 97-2003 workbook. So to save this for somebody who was using Excel 

2000, 97, 2003, or indeed Excel XP that’s the format that you would use. 

There is an even older Excel format which is still available and if we go down here it’s that one, 

Microsoft Excel 5.0/95 workbook format. Now in the unlikely event that you need to save it in 

that even older format that is the option to use. 

Now I should point out one very important thing here and that is that if you’ve used, for 

example, a modern feature of Excel the new features are generally not savable in older formats. 

So anything which needs a feature of file format which wasn’t in the older formats then you’re 

not going to actually see it. So for instance let’s suppose I choose that very old format and I click 

on Save. Notice that warning there. Some features in your workbook might be lost if you save it 

as Microsoft Excel 5.0/95 workbook. Do you want to keep using that format? And basically that 

warning is telling you that if you’ve used any of the more recent features they may not be 

savable in the older format. So I’m going to say no to that and let’s return to the list of file types. 
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Now I’m not really going to demonstrate the next little group but I’m going to briefly talk to you 

about them and that is that when you are working with Excel you can create Templates, Excel 

Templates. So in the example that we’re looking at here with the floor areas, let’s suppose that 

you’re somebody who does flooring work for a living and you wanted this nice workbook that 

you’ve created to be usable for other people’s houses and offices and so on. You might create a 

Table like the one that we’ve just created and just basically use that as a starting point, a 

Template, for other workbooks. Now if you want to save a workbook as a Template, we’re not 

going to go into this in detail now but there is a standard format XLTX format. That’s that one. 

So that’s how you save a workbook as a Template. 

And another important format is one where you actually need to include Macros. You write your 

own program code within your workbook to do something that Excel doesn’t do all on its own 

naturally. And then you need to save your workbook in what’s called a Macro Enabled 

workbook format and that’s XLSM format. So that’s that one. 

Now the older formats such as Excel 97-2003 also have Template format. So there’s an XLT 

format which is an Excel 97-2003 Template format. So for some of these Excel file types there 

are older versions of the same file types as well. 

So I’ve talked there about saving a workbook in one of the current formats or one of the older 

workbook formats. Let’s look next at a couple of situations where you might save a workbook to 

give to somebody else who doesn’t have Excel or perhaps just to give to somebody as if you like 

a presentation. 

Now there will sometimes be cases where you’ve done some work on a workbook and you 

maybe want to give it to somebody else. You don’t particularly want or need them to be able to 

use it as a workbook. You just want to show them the content of the workbook. So let’s suppose 

you are working as a flooring contractor. You created that table with all those sizes and costs on 

it and you want to give a presentation to the customer. You don’t want to give the customer the 

workbook. You just want to give them maybe an online presentation or even a sheet of paper 

with those values on it.  

One of the options you have is to save in PDF format. Now you’re probably familiar with Adobe 

PDF format. Nowadays most people are. It’s PDF, Portable Document Format, and almost every 

device you’re likely to look at a PDF file on will have a PDF Reader, so the ability to read 

what’s in such a file. And the portability of PDF format is now well established. 

So if I click on the Save As Type one of the options quite near the bottom is PDF. Incidentally 

while we’re looking at PDF just below it is XPS. That is Microsoft’s version of PDF, Portable 

Document Format. XPS is not so popular but you may well find people that would like XPS 

format. So you can do that from here. Let’s stick with PDF.  
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Now the important thing here is we’re not producing a workbook in a format that somebody 

could change the numbers or change the formulae. They’re going to get basically a printout even 

if it’s an electronic printout of this particular workbook. 

Now there are a couple of important options here. One of them, Optimize for: Standard 

(publishing online and printing). That’s the default setting here. There is an alternative setting. If 

what I was in fact going to do was to put this workbook online I can go for the Minimum size 

option which will make the resulting PDF file as small as possible. So if you do need to keep this 

file small that’s an important option.  

And the other option here which I am going to use now is Open file after publishing. So when 

I’ve created this PDF I’m going to just immediately open it so that you can take a look at it. 

The Options that you see here brings up this little Options Dialogue where I can choose things 

like how many pages I want printed and so on. I’m going to leave you to experiment with that. 

One thing to note though within that is Publish what, Active sheets or Entire workbook. Now of 

course if you publish the entire workbook it’s not going to be published like a workbook with 

tabs. So just try these things out and see what these different options do. But for the moment lets 

stick with the default settings and click on Save. And what you can see is my PDF format 

document. Don’t worry too much about the formatting of the borders and things here which we 

haven’t really looked at yet. But as you can see I have a PDF document. I could print it out. I 

could put it onto a device and give it to somebody. And as I mentioned just now I could publish 

it online. So that’s how to save in PDF format. 

Having checked the Preview I’m going to close that and I’m back to my workbook again. 

I’m just going to show you one more option now but before I do I just want to quickly remind 

you of one or two things about this workbook and the Floors worksheet. 

If you look at, for example, the dining room, the dining room if I click in the cell C5 it says 5. 

It’s 5 meters long, 5.6 wide. The floor area is a Formula, C5*D5. And then F5 in this case works 

out the Budget Flooring Cost for the dining room by multiplication of the floor area by a 

reference value that’s held on one of the other worksheets. 

One of the other ways that you can save a workbook is in what’s called CSV format which you 

may have come across before. CSV stands for Comma Separated Values. And CSV format saves 

the numbers. It won’t save the formulae. It won’t save the formatting, the borders, the layout. It 

will just save the words and the numbers. Now it’s very often the case that you will get data 

arriving that you can import into Excel in CSV format. It may not be that often that you export 

the values into a CSV file. But there may be situations where let’s suppose somebody you know 

is going to do this kind of work and they’re using a completely different piece of software. 

Maybe they have some sort of job costing software or they use a different spreadsheet system to 
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Excel. And all you can do is give them the numbers that you’ve used, then saving in CSV format 

is usually a good option. But let me just show what a default save in CSV format does here.  

So let’s do, so there’s CSV and I’m going to just save this in CSV format and then I’ll show you 

what the file looks like. Now notice the warning. The selected file type does not support 

workbooks that contain multiple sheets. Very important point about CSV format is that it only 

saves the active sheet. It can’t do more than one. And as the note there says to save all sheets 

save them individually using a different file name for each. So what you’d need to do is to select 

each tab and then save that worksheet. But let’s stick with this okay. Usual warning. Of course 

anything to do with formatting won’t be saved, the formulae won’t be saved and so on. When 

you save in CSV format you get the words and the numbers and that’s it basically. 

Now I’m going to open up that CSV file using Microsoft Notepad. And what you can see is the 

heading. It’s just the words Floor Areas. The commas are separating out basically empty cells. 

Then we’ve got a row of empty cells. Then we’ve got Room, comma, Length (m). You see how 

the headings are just given as the text content of each cell in the workbook heading. So the first 

cell is Room, the next cell is Length (m), meters, Width (m), and so on. And then for each of the 

rooms you have its length, its width, its floor area, and the Budget Cost of Flooring as numbers 

separated by commas with the empty cells at the end just being comma, comma, comma, and so 

on. 

So that’s what happens when you save in CSV format. 

That’s it on file types for now. Please join me in the next section. 
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Chapter 18 – Proofing 

Video: The Spell Checker 

Toby: Welcome back to our course on Excel 2016. In this section we’re going to take a look at 

checking spelling. 

As your workbooks get bigger and bigger and include more and more information it’s very often 

the case that a lot of the information is textual and most people like to check the spelling and 

sometimes the grammar of the text in their workbooks. Now in order to do this I’m going to 

create a new workbook from a template. I’m going to use one of the standard templates. The 

reason I’m doing that is this one will have plenty of text in it. Then I’m going to deliberately put 

a couple of spelling errors into that book and I’ll show you how they will be detected by the 

Excel 2016 Spell Checker. 

So first of all let’s go to New. So let me just explain how to use these templates. If I click on, for 

example, Personal Expenses Calculator what happens is this panel, this dialogue comes up and 

there is a sort of representation of what one of the sheets in this workbook looks like. So I can 

take a look at that and see if it looks like the sort of thing I’m after. There is normally a 

description on the top right such as here. The information I’m given also includes who it’s 

provided by. I think all of these will be provided by Microsoft Corporation. And if I decide that I 

want to try this one, if I click on Create it will create me a workbook from this template. If I 

haven’t used this template before it will be downloaded from Microsoft. So depending on the 

speed of your internet connection it may take a moment or two for that to happen. But I think 

I’ve used this one before so if I click on Create I should get a new workbook straightaway. And 

there it is. 

Now you’ll notice that it’s actually got three worksheets. You’ll also see that to some extent it’s 

formatted to be attractive looking. We’ve done some of this formatting now but in terms of 

things like drawing a nice Column Chart there, we’ll come to charting later on on the course. 

Now the first thing we need to do is to check that one or two of the Excel Options are set 

appropriately. So I’m going to go into Excel Options and the page to look at is the Proofing 

Page. That’s divided into two sections. The top section AutoCorrect Options I’m going to come 

back to towards the end of this section. But I want to look at the main section. When correcting 

spelling in Microsoft Office programs this is a Microsoft Office wide set of settings. And I’m not 

going to go through all of these but I’ll talk about most of them. For instance, Ignore words in 

uppercase. When it’s spell checking if a word is all uppercase characters it won’t be checked. 

The second option there, Ignore words that contain numbers. Note that the checkbox there is 

ticked which means this option is in force as well. Now those two between them say, for 

example, that if I were looking at a column of part numbers, ABC123, etcetera, I wouldn’t be 

trying to spell check those. The fact that a particular sequence of characters is a mixture of words 
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and numbers probably indicates that I wouldn’t want to spell check it anyway. And ignoring 

words in uppercases may be a little bit more questionable. It will depend to some extent on the 

situation you’re in. But make sure that you have that option set appropriately. 

The next two options, Ignore internet and file addresses. Well most internet and file addresses 

would not pass a spell checker because they’re usually a real sort of long conglomeration of 

characters the spell checker wouldn’t like. And then Flag repeated words. If you’ve used the 

same word twice just get the spell checker to indicate that as well. 

Now the other options here I’m going to skip over. I’m going to go right down to the bottom one 

there, Dictionary Language. I’ve got this set to English (United States). Sometimes I use English 

(United States), sometimes I use English (United Kingdom). You need to make sure it’s set 

appropriately for you.  

I’m going to come back to Custom Dictionaries as well in a moment. So I’m happy with those 

settings. I’m going to click on Cancel. 

So now let’s try a bit of spell checking on this first sheet. If I go to the Review Tab one of the 

options there on the left in the Proofing Group is Spelling. Click on Spelling and it will spell 

check the current sheet. Now it says spell check complete. You’re good to go. That means that it 

found no errors on that sheet. Now of course that doesn’t necessarily mean that I haven’t made 

mistakes because of course one thing that can happen when you spell a word wrongly is that you 

finish up with a legal word, a word that does pass the spell checker but it’s not the word you 

intended. So you do still have to be careful about what you’re typing and any changes you make 

to what you’ve typed.  

Now having checked one sheet let’s move on to the second sheet. Now this particular workbook 

has some quite complex processing in it in terms of categorization of expenses and so on, but 

you can still apply a spell checker to it. 

Now notice when I’ve gone to this sheet I have a particular cell, in this case F24 selected. And 

when you invoke the spell checker it always starts on the selected cell. In fact if you have a range 

of cells selected, so that’s more than one, it will spell check that range of cells rather than the 

whole sheet. Well what I’m going to do here is hit the spell checker again. You can probably see 

that I’ve got one of my deliberate errors there. You may also notice that that particular error is 

repeated a little bit further up the sheet. So click on Spelling and it finds that error. Now having 

found that error, so it says Not in dictionary P-A-A-S-S. It suggests what I might have meant. So 

it’s got Pass, which is clearly the word that I did want, Peas, Passé, or Papas. Now in order to 

correct that error all I’ve got to do is click on Change. But if I suspect that I’ve made the error 

elsewhere I can click on Change All and it will correct that particular error wherever I’ve made 

it. 
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Now of course if it’s found something there which is a word that I intended to use I can either 

say well Ignore it and when ignoring it I can either say Ignore Once or Ignore All, ignore 

everywhere, or I can Add it to my dictionary, but more of that in a moment. So I’m going to say 

on this occasion Change All. Note I’ve made that mistake in two places. Do you want to 

continue checking at the beginning of the sheet? Remember what I said just now about it starting 

at that cell. Yes. Now the next error its come across is Classic Movie Night. I’ve actually missed 

the I off of Night. Two options for Night there and I’m just going to do a Change Once in this 

case and it automatically changes the second occurrence of the Pass spelling error. So now it 

says Spell check complete. That one’s good to go. Click on OK.  

So we move on to the third sheet. Let’s do a spell check on this one. Now the first thing it comes 

up with is E-T-C. If you look in cell F7 you’ll see I’ve got Food, etcetera. Now it’s probably a 

matter of personal preference whether you write etcetera with or without the dot after it. I do 

actually normally put a full stop afterwards. You notice how as always I could choose a different 

option there. So I could say Etch and change it to that or E-T-I-C, Etic, another valid word. But 

on this occasion I’m going to change to Etcetera with a full stop. So having selected E-T-C-dot 

I’m also going to say Change All in case I put Etcetera anywhere else. And now it finds the term 

BluRay. BluRay it has heard of but not with that spelling. If you look at the suggestions down at 

the bottom Blu-ray. It spells it in that particular way. Now I may decide that I like to spell 

BluRay the way that I’ve spelt it. And what I can do is to Add BluRay to my dictionary. So I’m 

going to click on Add to Dictionary. It’s now happy with that sheet. Spell check complete. 

You’re good to go. Let’s take a look now at my dictionary. 

Now I mentioned this before. Let’s go into Custom Dictionaries. I’m actually setup with what’s 

called a Roaming Custom Dictionary which means that it’s synchronized between the devices 

that I use Office 2016 on. So I’ve got Roaming Custom.DIC default. If I want to see what words 

are in it, if I click on Edit Word List I can see my word list. And low and behold you’ll see that 

BluRay which I just added is in that word list. And the other two words are the parts of my name. 

Now of course over time the list of words in there will get longer and longer. If I mistakenly put 

a word in there I can always select it and then if I click on Delete and it will delete that word 

from my dictionary. So next time I put BluRay spelt like that into a workbook or another Office 

2016 document it will mark it as a potential spelling error. I can in fact clear all of the words out 

of my dictionary if I want to start again. I’m going to leave this as it is so I’m just going to 

Cancel. And apart from using my Roaming Custom.DIC, D-I-C, I can also use a local custom 

dictionary. You’ll see the file path there. And in some situations if you’re say working on a 

workbook with some very specific and unusual language in it, perhaps related to a particular 

branch of science or engineering or technology or psychology or something where you’re using a 

lot of very specialized terms you can even create a specific custom dictionary to deal with that 

workbook or other related workbook. I’m not going to demonstrate that now but I suggest you 

look into that if you think it might be appropriate to you. 
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So I’m going to Cancel this now and just return to the one other option that I said I would refer 

back to and that is AutoCorrect Options. 

Now AutoCorrect Options actually is quite a powerful facility and there’s a number of tabs here, 

most of which I’m not going to look at but I do want to look at a couple of the options. First of 

all this little block here corresponds to some common typing errors that people make. You notice 

that all of the options here are checked. There’s a tick in each of the boxes. These are mistakes 

like correcting two initial capitals. If you have a tendency when you’re typing to put two initial 

capitals onto words instead of just one then if you have this checked Excel will automatically 

decapitalize the second capitalized character on each word. Also you can tell Excel to capitalize 

the first letter of sentences or indeed to capitalize the names of days. So if you tend to type the 

days of the week, Monday, Tuesday, Wednesday without a capital letter you can say to Excel 

make sure you capitalize those for me please. And you can also correct accidental use of the 

Caps Lock key. I’m sure we’ve all done that where you’ve got the Caps Lock depressed. You 

start typing a sentence and the capital letters are not capitalized and everything else is. Well it 

can correct that for you as well. 

Now the second little group of things you can get it to do is to take specific key sequences and 

turn them into either special characters or treat them as spelling errors. So if you type (C), for 

example, what Excel will make it into is a copyright symbol. But if you have some common 

spelling errors, so if you type A-B-B-O-U-T for About, so you put two B’s instead of one, you 

can say to Excel please put About if I type that or if I type A-B-O-T-U that’s About as well. Now 

many of the most common spelling mistakes that people make are covered there but you can add 

your own as well. 

So that’s the AutoCorrect facility which you can also switch on in Excel. And if like me you tend 

to make some pretty repetitive errors when you’re typing you might find that a very useful 

feature. 

So that’s it for spell checking for now. I’ll see you in the next section. 
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Chapter 19 – Inserting Comments 

Video: Inserting Comments 

Toby: Hello again and welcome back to our course on Excel 2016. In this section we’re going to 

take a look at Comments. 

Now sometimes it can be very helpful to add additional information or explanation to one or 

more cells on a sheet. And one way of doing this is to insert a Comment in a cell. So as an 

example of this, let’s suppose that on the expense here, Lunch with Stephanie Estabo, I wanted a 

little note there to the affect that this could actually be charged to a specific account. Having 

selected the cell if I go to the Review Tab there is a group on the Review Tab, Comments, and 

one of the options there is New Comment. Click on New Comment. Now the first thing to be 

aware of is that when you make a comment it is attributed to you and it’s therefore very 

important that in your Excel Options you are identified correctly. Comments are often used when 

people are reviewing worksheets and you’ll want to read other people’s comments, make your 

own comments on their comments, and you’ll expect other people to look at your comments. So 

it’s normally very important that you are identified correctly against a comment.  

Now the comment I’m going to make in this case is quite a long one so let me just make this box 

a little bit taller. And I’m going to enter now the Comment itself. Now having entered the 

Comment all I really have to do is to click anywhere else on the sheet and the Comment is saved. 

Now you can see that there is a comment. Your eyesight’s got to be pretty good for this. But if 

you look at the cell, Lunch with Stephanie Estabo, you could probably just about see a little red 

wedge in the top right hand corner of the cell. And in fact if I hover over the cell the Comment is 

visible. And note how the little arrow on the Comment points at that little wedge.  

Now that’s not the only way of inserting a Comment. If I wanted to insert a Comment in this 

cell, for example, E4, if I right click one of the options on the Contextual Menu is Insert 

Comment. Now once I’ve added some comments it’s very interesting to take another look at the 

Comments Group on the Ribbon. If I go to a cell that doesn’t have a comment, such as C4, you 

notice the commands that are available there. We’ve got New Comment, Previous and Next, 

Show all Comments, and also note there Show Ink. Don’t worry about Show Ink at the moment. 

Now because there is no Comment in this cell I can add a new Comment. If I click on Next it 

actually takes me to the next cell that has a Comment and shows me that Comment. Next again 

takes me to the next cell. And when I actually get to a cell that has a Comment such as here the 

options that are available to me change. So I’m now on the cell C6, Lunch with Stephanie 

Estabo. I’ve still got Next and Previous enabled but I’ve also got Delete which will delete the 

Comment and I’ve also got Edit Comment which would allow me to go into the Comment and 

edit it. 
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So you can see how in this case the commands in the Comments Group on the Review Tab most 

of them are contextual. Whether they’re enabled or not will depend on whether you currently 

have a cell with a Comment selected or not. 

Now let me just quickly go through a couple of these other options with Comments here. One of 

the options is Show All Comments and Show All Comments does probably exactly what you 

thought it would. Let me switch that off again. The other option is if you want to be able to look 

at a Comment without it disappearing when you hover away from the cell. If I hover over Lunch 

with Stephanie Estabo see the Comment, move away you don’t. If I select that cell and change to 

Show/Hide Comments then wherever I put the cursor that particular Comment is visible. If I 

select another cell with a Comment of course that one shows itself and hides, depending whether 

I hover over it or not. But again if I say Show/Hide Comment it basically sort of glues it on if 

you like. If I want to unglue Lunch with Stephanie Estabo select the cell, click that one, same 

with this one, and that’s it. That’s it for Comments. Please join me in the next section. 
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Video: Exercise 06 

Toby: Hello again and welcome back to our course on Excel 2016. 

It’s now time for Exercise 06. Let me explain Exercise 06 first and then I’ll show you my 

solution to it. 

I’d like you to take Exercise 02b, that’s the exercise with the opening hours in it. And we’re 

starting to work on the opening hours for 2016. So first of all this workbook is going to have two 

worksheets. One with a tab saying 2015, that’s the current opening hours, and then another one, 

the first sheet in the book, saying 2016.  

In 2016 our opening hours, we’re going to open half-an-hour later each day of the week that we 

are open and on Sunday’s we’re actually going to open one hour later. We’re also considering 

extending Sunday opening by an hour but that’s not a decision yet so I just want to Comment in 

the Sunday Closing Time cell to the affect that a review is needed of whether we’re going to 

close an hour later on Sunday. 

In addition I’d like you to Merge cells A11 to C11 and put a visible note in there to the affect 

that Visitors should always check online before visiting or call customer services on 555-2334. 

And ideally you’ll put that note in there, slightly smaller font, perhaps Italic just to make it stand 

out a little bit. 

Now having done that and saved the workbook what I would then like you to do is to save the 

workbook as a PDF file. So my answer to this is actually in two parts. There is a workbook, 

Exercise 06, and there is a PDF file with the same name but a PDF extension. 

So here is my solution to Exercise 06. As you can see I have the PDF open here. There are two 

pages. When I saved as a PDF I saved the whole workbook. There’s the first page. Note the 

opening hours extended by half-an-hour every day except Sunday when they’re extended by an 

hour. You don’t see the Comments of course there under the Closing Time for Sunday but you 

can see that note that I added, Visitors should always check opening times online or call 

customer services on 555-2334. I hope that in doing this, of course, you did a spell check. Now if 

I use the scroll bar on the right I can go down to the second page which shows the old opening 

hours for 2015. 

Let me close the PDF file. Now I’m at the workbook. Note the two tabs at the bottom, 2016, 

2015, with 2016 first. You can see the indicator of the Comment there in cell C9. If I hover over 

that you can see the Comment. 

So that’s it. That’s my answer to Exercise 06. I’ll see you in the next section. 
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Chapter 20 – Basic Functions in Excel 

Video: The VLOOKUP Function 

Toby: Hello again and welcome back to our course on Excel 2016.  

We’re now going to return our attention back to the core of Excel and having looked briefly at 

formulae and functions earlier on we’re now going to look at functions in particular in a lot of 

detail in this section and in fact the next few sections. 

Now there are actually hundreds of functions in Excel and some of them require quite a detailed 

knowledge of particular areas such as statistics, mathematics and so on. But I’m going to 

concentrate on some of the most common functions that you’re likely to need, particularly when 

you’re just starting out with Excel and as your knowledge and use of Excel develops. 

Now in order to learn about some of these functions I’m going to develop an invoice for a 

bathroom company called Shower Power who are based in the U.S.A. Basically they put together 

and install bathrooms and shower rooms for people. Now as part of this they have to produce 

invoices and their invoices are not just simple documents that somebody enters in a word 

processing application such as Word. Their invoices involve accessing very simple types of 

database with details of the products they use and with details of their customers. And the 

invoice that we’re going to develop in the coming sections is going to be based on the use of 

what are effectively databases of information and Excel functions. So let’s get started. 

Now one of the first things I need to explain to you is what I mean by databases. You may be 

worried at this point that I’m going to start teaching you how to use Access or something like 

that. Very many commercial databases are operated purely on the basis of the use of Microsoft 

Excel. And one of the things that I hope you’ll see in this and the next few sections is how in 

effect you can setup a database system in Excel. Now with this particular workbook, Shower 

Power Invoice.xlsx, I’ve already created a total of three sheets and one of the sheets, the third 

one there, is actually Customers. Now in effect the contents of that Customers sheet is a very 

small example of a part of a database. I have information about four customers. Each has an 

account number, the name of the customer its company name, the name of the contact at the 

company, at the customer, and then I have the terms for that customer, whether the customer 

receives a discount, and the first two lines of the company’s address. Now of course in reality I 

would have many other pieces of information about each of these customers but I think you’ll get 

the hang of all this on the basis of just the amount of information that’s there. 

The second worksheet shows the list of parts that Shower Power supplies. And for each part 

there’s a product code, a description, a quantity or size, a list price, and a discount percentage 

where a discount is applied. Now you’ll notice that in column F there there is a column which is 

supposed to contain the net price, the price after discount of any particular part. So when a 
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discount is applied this would give the net price. But in effect all of the little design decisions we 

might make would be whether we would store the discounted prices on the sheet or whether we 

actually calculate them in the invoice itself. You’ll see what I mean by this a little bit later on. 

So in effect that list of customers and that list of parts is the basis of our database. And what 

we’re going to do is to use this information to create invoices. 

Now the first sheet is my sort of invoice template. And all that I put on this invoice template at 

the moment is some fixed information. So for example, I put the word Invoice at the top, I put 

Shower Power, the company name, there, and then a few headings and then at the bottom I’ve 

got, Please contact the customer service department. Thank you for your business, etcetera. So 

what I’m now going to do is to start to fill in on this invoice various parts of it which are 

variable. So these are the parts that will be different between customers. I’m not necessarily 

going to put all of these in but I’m going to add quite a few of them over this and the next few 

sections. 

Now one thing you might already have noticed about the invoice is that there are no lines 

showing. I’m not going to show horizontal and vertical lines on this invoice. But very often when 

you’re working in Excel and you’re trying to align things it is a good idea to show the gridlines 

while you’re working. So what I’m going to do is to go to the View Tab and switch the gridlines 

on. That will help us quite a bit with alignment and seeing whether we need to do anything with 

cells and rows and columns and so on. And what I’m going to do first in this section is to show 

you how to use a Lookup function. And the function we’re going to use is called VLOOKUP.  

What I’m going to do is to put an account number in here. And on the basis of that account 

number I’m going to get some details of the relevant customer and put them up here to represent 

part of the customer’s address. So I’m going to put them up here. So let’s go over to the 

Customer sheet and let’s look. The first account number I’ve got there is 2307. So let’s go back 

and put 2307 in the Account Number. And then what I want to do is to put into this cell here, D5, 

the name of the customer contact. Now of course if I look at the Customers sheet I can see who 

that is. It’s Dorothy Walinksi. But I want that to happen automatically. And the way that I do it is 

to use the VLOOKUP function. 

Now if I go to the Formulas Tab you’ll see on the Formulas Tab a Function Library. And within 

the Function Library one category of function is Lookup and Reference. So click on Lookup and 

Reference. And the one I’m going to use here is VLOOKUP. There is also an HLOOKUP. 

VLOOKUP stands for vertical lookup. HLOOKUP stands for horizontal lookup. And which of 

those you use depends on how your data is arranged on your Reference sheet. In this case my 

Customers sheet. In this case my records, my customer records are arranged vertically so I’m 

going to look at the VLOOKUP function. I’m going to use the VLOOKUP function. 

Now what you see is this Function Arguments Dialogue, a very clever little dialogue. It’s going 

to make it very straightforward for us to set this up. But I want you to read carefully the 
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information about how this function works. It looks for a value in the left most column of a table 

and then returns a value in the same row from a column you specify. By default the table must be 

sorted in an ascending order. 

Now the very first thing we’re going to enter here is the Lookup_value. But before we do that 

let’s just check that our table is in ascending order. So let me Cancel this. Let me go back to my 

Customers sheet and my account numbers, well actually they’re not in ascending order. 2307, 

3210, and then they’re out of order. Now I could do a little bit of Cut and Paste, put those in the 

right order. Alternatively I can easily Sort a sheet. In this case by default on the first column. If I 

just select that sheet, go to the Data Tab, in the Sort and Filter Group that I’m going to tell you a 

lot more about later in the course, this top left hand button here, Sort Smallest to Largest by 

default works on the first column. So that sorts everything into the correct sequence. So now the 

table I’m going to lookup is in the correct sequence. So let’s go back to the invoice. Let’s once 

again go to Formulas, Lookup and Reference, back to VLOOKUP, now we can proceed.  

Now the value we’re going to look up on the Customers sheet is the value in C17. So I could 

type in that first box in the Function Arguments Dialogue C17. But in fact if I click in there 

Excel does it for me. Now the next thing I specify is the Table_array. Notice as I click through 

these fields that an explanation of what each of those fields is is given lower down in the 

dialogue. Table_array is a table of text, numbers or logical values in which data is retrieved. 

Table_array can be a reference to a range or a range name. I’m going to talk about range names 

later on. For the moment we’re going to make it a Table_array. So I’m going to click on the 

Customers sheet. Note how that dialogue is still on top. Now let me select the Array that contains 

all of my data. So that’s the cells from A2 to G5. And that is my Table_array. Customers!, so the 

Customers sheet, A2 to G5. 

Now the third field is the Col_index_num. It’s the column number in the Table_array from 

which the matching value should be returned. Now the first thing I want here is the name of the 

contact. So that’s actually the third column. So the column number is three, the number three.  

And now finally what we need to enter is Range_lookup. Now this is a logical value that 

determines whether we’re looking for a closest match in which case we put True in here or 

whether we want to find an exact match. Now in this case we must have an exact match on 

Account Number so we type in here False, click on OK, and we find in cell D5 on the invoice 

that we have the name Dorothy Walinski.  

Now that appears to be fine. Let’s just do a quick check. Let me look for one of the other account 

numbers. What about 5112? Let’s put the other account number in cell C17, 5112, tick it. That’s 

good. I get Zak Stephens. So that seems to be fine.  

Now what would I put in the next cell down? That’s what I have in cell D5. What would I put in 

D6? Well let’s just try doing a Fill Down shall we? You probably already worked out that this 

isn’t going to work at all but let’s do it anyway. Of course it doesn’t work at all because what? It 
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doesn’t work at all here is that Excel just moves everything down a row in which case C17 is no 

longer C17. It’s looking for C18 which won’t help at all. The Lookup Table on the Customer 

sheet is no longer A2 to G5. It’s put A3 to G6. So that definitely doesn’t work.  

Now one way of getting around this of course will be to do the VLOOKUP individually on each 

of those cells. But another way of doing it and probably the better way of doing it, when we 

setup the VLOOKUP is to use Absolute Cell References for the Cell References because C17 

isn’t going to change and the range on the Customer sheet isn’t going to change either. So let me 

put Absolute Cell References in here. 

Okay that’s better. Now let me do a Fill Down for say four rows. Of course it’ll help a little but 

I’ll get Zak Stephens every time. But if what I really want here instead of Zak Stephens four 

times is the company name, then the first line of the address, then the second line of the address. 

Let’s look at the Customer sheet. The company name is column 2 and the address is in columns 

6 and 7. So let’s go back to the invoice. Let’s say that one is column 2, that one is column 6. 

Notice I’m only changing the column number. And that one is column 7. That one is better. Now 

let’s go back to that earlier account number again, 2307, tick it, and that’s fine. That seems to be 

working perfectly. 

So finally in this section what I’d like to do is to put the customers terms of business in here. 

Now that’s from column 4 on the Customers sheet. So if I just take one of these, do a Copy, 

Control-C, do a Paste, Control-V, look at the Formula, change that to column 4, tick it, and as 

you can see seven days. Let’s try changing the account number, 5112, tick it, and as you can see 

that works perfectly as well. 

That’s the VLOOKUP function. Please join me in the next section. 
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Video: Text Functions 

Toby: Hello again and welcome back to our course on Excel 2016. 

In this section we’re going to continue looking at Functions and I’m in particular going to look at 

one of the main Text Functions. 

Now Text Functions are as the name implies used to process text in workbooks in various ways. 

And you’ll probably find that as you use Excel more and more you’ll come to use more and more 

of the Text Functions. I’m going to demonstrate with a pretty straightforward example in this 

section one of the most commonly used Text Functions but before I do it and I’ll remind you of 

this again towards the end of this section. It is important to realize that there are as with many 

other things in Excel many ways of doing some of the things that we’re going to do in this 

section. And in this section I’m really concentrating on showing you one or two straightforward 

ways of doing things that you might like to get to grips with before you try some more 

sophisticated and powerful methods later on. 

Now what I want to do is to get into a situation where we can put a date on this invoice, which 

we’re going to do in the next section, but also tell the customer when the invoice is due. Now at 

the moment we’ve got the terms in cell E18, 30 days. That 30 days is for reasons that will 

become apparent in the next section is quite a clumsy way of storing those terms. Now we could 

use that as it is but what I’m going to do on this occasion is I’m going to go into the Customers 

sheet and I’m going to change all of those terms. All I’m going to do here under the terms is I’m 

going to remove the word days from each of those cells, D2 down to D5. Now if there were 

thousands of these I could actually write a little procedure to do it but there’s only four so all I’m 

going to do is with 7 days selected, cell D2, type 7, down arrow, 60, down arrow, 30, etcetera. 

That’s going to make my life a lot easier later on. Now let me go back to the invoice and you can 

see there is a rather unfortunate consequence for the invoice because now terms just says 30. 

Now what I’m going to do is to use one of the Text Functions to turn that back into 30 days 

again but I’m going to do it without changing the number on the Customer sheet.  

So first of all let me click in cell E18. Let’s just remember what we had in E18. It’s that 

VLOOKUP statement there. =VLOOKUP, etcetera, etcetera. So that’s where my 30 comes from. 

But what I want to do is to add the word Days to that cell. So what I’m going to do is use one of 

the Text Functions. 

Now I’m going to need that VLOOKUP so what I’m going to do is to basically swipe across it in 

the Formula Bar and then I’m going to Cut it to the Clipboard. So I’m using Control-X to cut it 

to the Clipboard. And what I’m going to put in here instead is one of the Text Functions. So I’m 

going to the Formulas Tab on the Ribbon and let’s take a look at the Text Functions. 
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Now once again there’s a long list of Text Functions. One of them we’re going to use in a 

moment but let me just talk about one or two of the others. The purpose of some of these 

functions is fairly obvious. So for instance, right near the bottom there’s a Text Function called 

UPPER. That will take a piece of text and convert it to all uppercase letters. Notice how the little 

tip there that comes up, UPPER(text), describes what the function does, Converts a text string to 

all uppercase letters. And also look carefully at how the function appears. It says UPPER(text). 

That tells you how many arguments, in this case a single argument, that the function has. In this 

case a piece of text. 

There’s another function, LOWER. I’m sure you can probably work out what that does. And 

there are other functions where you can probably work out what they do as well. For instance 

there’s a SEARCH function which will search a particular piece of text for another piece of text. 

But the one we’re going to use is CONCATENATE. And what CONCATENATE does is to join 

several text strings into one text string. So let’s put CONCATENATE into that cell. 

Now as we saw in the previous section we get a Function Arguments Dialogue and it invites us 

to specify the text for two arguments. Now in fact as the information there in the dialogue tells 

you, you can have up to 255 text strings to be joined together there. So you’re not restricted to 

two. And what I want to put in the first text string I’ve already got copied to the Clipboard 

because it’s that VLOOKUP. So you can see the cursor flashing in Text 1. What I’m going to do 

is just do a straightforward Paste and it puts my VLOOKUP function in there. 

Now what do I want to concatenate with the result of that VLOOKUP function? I want to put the 

word Days with a space in front of it in fact. So let me put in a double-quote character to denote 

the beginning of a text string, a space, the word Days, then I will close the double-quote again. 

Note within the Function Arguments Dialogue to the right of Text 2 it’s actually showing me 

what that’s going to look like.  

So I only need to concatenate two strings on this occasion. Let me click on OK and now you can 

see in my terms back in cell E18 that I’m back to having it saying 30 Days again.  

Now there are a couple of particular things I’d like to point out here. One of them is if we go 

back up to the Formula Bar and look at the contents of cell E18 you can already see how 

complex formulae can look once you start getting one or two functions involved. And perhaps 

when we started this course you might have looked at that and thought it was just a load of 

mumbo-jumbo. But in fact it is a fairly complex formula already. 

So we start with an equal sign that tells us it’s a formula and it’s a formula which is a 

concatenation of in this case two strings separated by a comma. The first string is itself a 

VLOOKUP and the VLOOKUP has four arguments. It’s got which cell to lookup, which range 

to lookup in, which column in that range to use, and whether to use closest match rather than 

exact match. And then the second text string is a literal string in quotes, space, Days. So already 
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you can see that these formulae and functions can actually look quite complicated in Excel even 

when as in this case they’re not really particularly that complicated things to do. 

Now the other thing I’d like to point out to you and I did mention this at the beginning of this 

section. I could have taken a completely different approach here, left 30 days as it was 30 days. 

And when I came as I’m going to in the next section to do some arithmetic on dates I could have 

removed the word Days from 30 Days and used the 30 as it is in that calculation. So there are 

many ways of doing these things and you’ll find over time that you develop your own preferred 

ways, your own favorite ways of doing things. 

But for now let’s tick that. We’re back to having 30 Days as our terms. In the next section let’s 

do a little bit of work on Dates. I’ll see you then. 
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Video: Date and Time Functions 

Toby: Hello again and welcome back to our course on Excel 2016.  

In this section we’re going to carry on working on this invoice and we’re going to look in 

particular at the Date and Time Functions. 

What I want to do is to put a couple of dates on this invoice. I want to put an order date on there 

and I want to put a due date on there as well.  

Now one of the factors to bear in mind here is that where you get a date from, the source of 

information, will very much depend on the situation you’re in. I am to some extent in this section 

going to cheat a little bit. But if, for example, your company worked in a way that you received a 

lot of orders by mail, by email or perhaps online orders, phone orders, and so on you may always 

enter an order date into your Excel based invoicing system just by typing it in. So given that cell 

C11 here is going to be the order date I could just type the date in there. That would be a very 

straightforward thing to do. I can of course format the cell as a Date Format cell and then Excel 

can make sure that the date looks correct for me and is in fact a valid date. 

To some extent what I’m going to do here is to cheat, as I say, and then I want to demonstrate 

one or two of the Date and Time Functions. So I’m going to automatically insert in there today’s 

date.  

Now you won’t be surprised to discover that the Date and Time Functions are on the Formulas 

Tab. There’s a whole section of Date and Time Functions. And again it’s a good idea to work 

your way through those, hover them, look at the Screen Tips and Descriptions. Two in particular 

I want to point out to you are NOW. And NOW returns the current date and time formatted as a 

date and time. Now if the time of the order were important we might want to include the time in 

there. That would be fine. You’d use the NOW function. But on this occasion all I want is 

today’s date. So I’m going to put in TODAY(). Now notice TODAY(), note the round brackets 

there on the Screen Tip. TODAY() doesn’t have any arguments. It just is today. So let’s click on 

TODAY(). And not Functions Arguments there, the little message returns the current date 

formatted as a date. This function takes no arguments. So let’s click on OK and in there we’ve 

got today’s date. It’s actually November 19, 2015. 

Now of course if I wanted to change that format it’d be straightforward enough. Right click, go 

into Format Cells and you’ll see that the Date Format it’s chosen is that one, what’s called the 

Long Date. It’s a long U.S. formatted date. If I wanted to use a different Date Format there are 

many others there. Let’s stick with the one that Excel has presented us with. 

Now the other date that I want to enter here is the due date. And the due date obviously is going 

to be based on the terms for this client. Now in this particular case this client has 30 day terms. 
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So what I need to do is to add the terms to the date. So I will need to add 30 days to that date, 

November 19th, to get the due date. 

So what I’m going to do is I’m going to Copy these two cells. Keyboard, Control-C, click on the 

first cell here, D17 which is where I’m going to Paste it, and what you can see there now it says 

Order Date. Let me click in Order Date. I’m going to change that to Due Date in the Formula 

Bar. And now in cell E17, the due date, it currently just says today as you would expect. 

Now the key thing to remember here is something I mentioned earlier on in the course and that is 

that dates are stored in Excel 2016 as the number of days since January 1, 1900. So if I want to 

find a date 30 days from today all I need to do is to add 30 to today’s date. So looking at my 

Formula up here in the Formula Bar I want it to equal today, the round brackets even though 

there were no arguments you still need to put the empty brackets there, and then I’m going to put 

plus and what I want to add is the number of days in the terms for this customer. Now hopefully 

you remember where I get the number of days in the terms for this customer. And that’s by using 

VLOOKUP and accessing the data on the Customers worksheet. 

So I could go through. Now that you hopefully are pretty familiar with VLOOKUP you could 

probably work all this out again. But let’s just use something we’ve done already. Let’s click 

down here on cell E18 and the VLOOKUP for the number of days is actually already there. And 

if I go up to the Formula Bar and select the VLOOKUP for the terms for this customer, do a 

Control-C, and having copied that to the Clipboard I don’t actually need to make any changes to 

cell E18 itself. So just to be on the safe side I’m going to Cancel that, come out of there. I’m 

going to go back into cell E17 where I’ve already put the function TODAY() with no arguments 

but round brackets to give me today’s date, click at the end of the Formula in the Formula Bar, 

then a plus, and now I’m going to Paste in that VLOOKUP. So it’s Control-V. There’s my 

VLOOKUP, tick it and we find that the date is December 19, 2015 which is of course 30 days 

later. So that’s absolutely fine. 

Now I always test these things when I’ve done them even if I’m 100% confident it’s right. So 

let’s try a different customer. This is for account 5112 which is a 30 day account. What about 

trying 2307 which is a seven day account? So let’s change that to 2307, tick that, seven day 

account. That will give us a date of November 26. So that seems to be working absolutely fine. 

I’ve saved that as version 03 of the Invoice workbook. That’s the end of this section. I’ll see you 

in the next one. 

  

http://www.simonsezit.com/


Learn Excel 2016 for Beginners: Master the Essentials 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 
 

Video: Logical Functions 

Toby: Hello again and welcome back to our course on Excel 2016. In this section we’re going to 

look at the use of Logical Functions.  

What are Logical Functions? Well a Logical Function is one which enables us to take an action 

that depends on a specific situation. So for instance, with the focuses we’ve looked at so far 

we’ve basically said things like add these numbers together or find this particular value in a sheet 

using a VLOOKUP, that sort of thing. What we need to be able to do is to say depending on a 

particular value, depending on a particular situation do one thing or do another thing. So we 

apply logic to what we need to do. 

Now the way that I’m going to demonstrate this with our Shower Power Invoice is we’re going 

to start putting in details of the items that have been ordered. And the price we’re going to charge 

the customer will depend on whether the customer gets a discount or not. You may recall on the 

Customers sheet that there’s a column there, column E, Discount. A couple of our customers do 

get a discount and a couple of our customers don’t get a discount. So the price will depend on 

whether they get the discount. 

In terms of what the discount is, if you look at the Catalogue sheet. Column D gives the list price 

of each of the items that we sell and then column E gives the percent discount that is applied to 

that price for customers that get a discount. Now one thing I need to point out and I won’t keep 

going on about this. There are many ways of doing what we’re doing here. We could apply the 

discount when we actually create the invoice. But what I’m going to do here is to put the 

discounted price, let’s mark those the net price. It’s actually the discounted price. I’m going to 

calculate that value and what we’re going to do in the invoice is we’re going to say if a customer 

gets a discount they pay the price in column F, that’s column 6. If they don’t get a discount they 

pay the price in column D, column 4.  

So let’s calculate those discounted prices first. Let’s put a Formula in F3 to calculate the net 

price for that first item, the Chrome Flat Listello, whatever that is, $7.55 and the discounted price 

to work out is 20% off of that price. Now in order to work out a 20% discount on that price I 

appreciate that some of you perhaps are not particularly mathematical so let me explain this step 

by step. We first of all need to work out what the price is that they pay by saying well if it’s a 

20% discount then they’re going to pay 80% of the price. So first thing you need to do is to take 

the discount, in this case 20 from 100 which is going to give us a balance of 80% pay. Now 

we’re going to need a Formula here. So the cursors in F2. Let’s put an equal sign to start our 

formula. And the first thing we calculate is the percentage that they pay which is 100 minus the 

value in E2. So it’s 100-E2. So that would be 80%. Now in order to work out what 80% of $7.55 

is we need to divide the percentage by 100 to make it into a fraction. So let’s put 100-E2 in 

brackets and then the division symbol is the slash symbol. We need to divide that by 100. And 

the 100-E2/100 will give us the fraction that the customer pays. In this case that would be 0.8. 
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And then we need to multiply that by the list price which is D2. So that’s times D2. Let’s see 

what the price comes out to be. It’s $6.04 which I believe is correct. 

Now that’s currently not formatted as a currency so let’s just go in there, do a quick Format 

Cells, make it into a Currency, U.S. dollars, two decimal places, there we are. 

So that’s worked out my discounted priced, $6.04. And what I now to do of course is to fill that 

down as a discounted price to all of the other rows on this sheet. So what I’m going to do is drag 

that down, release and there I have all of my discounted prices. 

And of course you might like to check, for example, let’s choose a sort of random row here. This 

one, for instance, F11, you can see the Formula in there. Notice that the other cells refer to are all 

in row 11 as well. And of course that’s a 33.33, a third discount on $24.17. It gives me a balance 

of $16.11. Note that we’re working to two decimal places to the set value of cents. 

Now let’s go back to the invoice because the next thing to do is to start putting the details of the 

order on the invoice.  

Now I’m going to put some headings here corresponding to the information about each of the 

items ordered by the client and then we’ll start working out what to put in each of those columns. 

So I’ve entered the six headings there: Product, Description, Unit Type, Unit Cost, Order 

Quantity, and Cost. It’s very often the case when you enter text data in particular like this into a 

sheet that you pick up whatever formatting was on the sheet beforehand and you finish up with 

formatting that’s really quite messy. So let me select those six cells and quickly apply a bit of 

consistent formatting. Of course I could use a Style if I wanted to. So why don’t I try heading to 

Style up here. That would at least make it look more neat than it is now. That’s okay. Slight 

adjustment here so I can read all of that heading. I usually only really worry about formatting a 

document like this one when I’ve pretty much sorted all the content out so that I don’t have to 

keep redoing it. So it’s quite often the case that when I’m working on a workbook it really looks 

quite messy until I’m getting towards the end and then I spend quite a bit of time usually just 

tidying it up and making it look much more shall we say respectable.  

The number of items we’re going to allow for here is obviously a decision that you think you 

might need to make at this point but we’re going to leave that for the moment. In fact we’re 

going to look at the issue of number of items later on in the course. For the moment I’m just 

concentrating on working out the cost of each line item in the order. 

Now the product code for the item that the customer orders will go in B21. And going back to 

the catalogue that’ll be something from column A, Product Code. And then we’re going to look 

that up in the Description column to get the description. So that’s column 2. Now by now you 

should be pretty adept at working out what the VLOOKUP needs to be to go into here. So see if 

you can work that out. I’ll quickly put that VLOOKUP in.  
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Notice at the moment that I get that N/A. The reason I’ve got an N/A there is because I haven’t 

entered a product code yet. Let’s put an appropriate product code in. Let’s choose MAP15001. 

That now gives me a proper description. Let’s make that column a little bit wider. I’m probably 

going to need to wrap text in there to make sure that you can read what it says but we’ll stick 

with that for the moment. 

Now don’t forget in this VLOOKUP we need to make sure that we make any references absolute 

that need to be absolute. We’re always going to be looking in column B for the product code so 

we could certainly put $B there, although in this case it wouldn’t really create a problem if we 

didn’t because we’re only going to put the product codes in column B anyway. But don’t forget 

in the Catalogue References here for the moment at least we do need to make sure that we’ve got 

our Absolute References in there and there we are. That’s the Description. 

Now the Unit Type is basically what’s in column 3 and then the price will either be 4 or 6, 

depending on the discount but more on that in a moment. 

Now if all I wanted to do in there was to put the List Price then I could do pretty much the same 

as I did now to get the Unit Type in there. I could basically Copy the contents of that cell, Paste 

it into that cell and change that to column 4 and I would have the List Price for that item. Now 

note that the VLOOKUP there refers to column 4. But if I wanted the discounted price I’d use 

the same VLOOKUP except I’d change the 4 to a 6. So the question is if one situation applies I 

need one VLOOKUP and if another situation applies I need the other VLOOKUP. 

Now let me just Copy that VLOOKUP to the Clipboard. Then what I’m going to do is to 

completely clear out the contents of that cell and I’m going to put into that cell a Formula 

including a Logical Function. Now the Logical Functions are available from the Function 

Library on the Formulas Tab and the one I want is If.  

Now basically with an If statement you ask a question. You do what they call a Logical Test 

here. And then you say this is what I want if the test is true, this is what I want if the test is false. 

Now the test we’re going to do is to say Does this customer get a discount? And if the customer 

does get a discount we’re going to give them the discounted price. And if they don’t get a 

discount we’re going to give them the list price.  

Now I copied to the Clipboard the list price, so that’s the value to put in here if the test is false. 

So I’ve selected that cell in the Function Arguments Dialogue, Control-V. So that VLOOKUP 

corresponds to the list price. And then in the value if true, I’m going to Paste in the same thing 

and change the 4 to a 6. So that’s the discounted price. 

So the question remains what is the Logical Test? Well the Logical Test is going to be based on 

this. Look up the customer on the Customers Table and look at the column that states whether 

they have a discount or not. So let’s just quickly click on the Customers Table, take a look back 

at that. That’s column 5. And we’re going to see if column 5 contains a Yes or not. If it contains 
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a Yes then get a discount. So let’s go back here and the test we’re going to do then is this. We’re 

going to do a VLOOKUP on the Customers Table and see if it says Yes. Now the VLOOKUP on 

the Customers Table, maybe you could work this out yourself by now, hopefully. So it’s 

definitely a VLOOKUP. We’re going to look up the customer account number which is in C17. 

Don’t forget, make sure you put Absolute References here because we don’t want it to be 

anything other than C17 that we’re looking at. The range of cells we look up is on the Customers 

sheet. So that’s bang and it’s $A$2 and then colon, $G$5. So that’s where we look it up. Which 

column do we look up? It’s column 5. And are we looking for a closest match? No, we want an 

exact match. So that needs to be false. So that’s the value we look up. And what do we want to 

test with that value? We want to see equals, does it equal the word Yes? So basically we say if 

the discount column for this customer says yes then we’re going to use the VLOOKUP on the 

price with column 6, that’s the discounted price. If not we’re going to look it up in column 4 and 

that is the list price. So that’s it. Click on OK. Let’s see what we get. And we find that for this 

customer, 2307, they do actually get a discount. 

So let’s work out what the cost of three of those items is. Put a three in there. Cost will be equals 

and then it will be F21, that’s the number, multiplied by E21 which is the unit cost, tick that. And 

now for both unit cost and for the total cost, I’m going to select both of those cells, hold the 

Control key down to select the second one. I’m going to right click, Format Cells. Make them 

into Currency Amounts, two decimal places, dollar, click on OK. So three of those items is 

$33.12. 

Now let me do my usual test. Let’s try that for a different customer. If I go back to the Customers 

sheet, 2307 gets the discount. Note that 2636, the next customer doesn’t. So let’s see what 

happens if I change that to 2636. Leave the order as the same for three of those adhesives. When 

I tick that, just check what happens to the unit cost. You see they get the non-discounted price. 

So finally I’ve just tidied up the formatting there a little bit. Let me do a second item. I’m just 

going to copy the whole of that row and Paste it into the next row. I’m going to change the item. 

Let’s look at the catalogue. What about BRI9001? Let’s make that BRI9001. And we’re going to 

have two of those in the order. And then an extra little bit of work you might want to do but 

maybe just do total the order cost. Straightforward job. Total cost $46.20. And maybe we’ll 

finish off by making it Bold.  

That’s the use of a Logical Function. I’ll see you in the next section. 
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Chapter 21 – Graphs and Charts 

Video: Creating Graphs and Charts 

Toby: Welcome back to our course on Excel 2016.  

In this section we’re going to start to look at what many people consider to be one of the greatest 

strengths of Excel and that is the ability to create really good Graphs and Charts. 

So why do people use Graphs and Charts in Excel? Well usually it’s to strengthen a message or 

sometimes to actually give the message itself. As the saying goes, a picture can paint a thousand 

words. And very often, particularly with complex data a picture can help people to understand 

the data without getting too baffled by all of the numbers. 

Now I should warn you that the area of Graphs and Charts in Excel is a pretty vast area so we’re 

going to start with the basics as usual and I’m going to use some very straightforward data here 

about the lengths of a number of rivers in Africa and the drainage basins for some of the rivers. 

And what I’m going to do first of all is to create a straightforward Graph or Chart to illustrate the 

lengths of those eight rivers. 

So let’s just ignore the drainage basins for a moment. What I’m going to do first of all is to select 

the data that I want to draw the Graph or Chart of. So I select from A1 down to B9 and then I go 

to the Insert Tab. And one of the groups on the Insert Tab is Charts and I’m going to click first 

on Recommended Charts because once you’ve selected some data what Excel 2016 can do for 

you is to recommend a suitable type of chart. The recommendations it makes are on the left here. 

There are four of them. First of all it says Clustered Column. Now I’m going to assume you’re 

not really familiar with types of Graph and Chart, although I know many of you will be. I’ll 

briefly explain each as we go along. A Clustered Column basically means we have vertical 

columns and each column corresponds to a category. Now Excel assumes in this case that the 

categories are in column A, so A2 down to A9. So we have a category, Okavango, and a 

category Orange and so on. And then on the vertical scale, on the vertical axis it plots what it 

calls the value. And the values in this case are the lengths of the rivers. So as you can see its 

taken each of our rivers and plotted a column. Now note the little summary underneath the chart. 

A Clustered Column Chart is used to compare values across a few categories. Use it when the 

order of categories is not important.  

The second option it offers is really similar but it’s flipped over. It’s what’s called a Clustered 

Bar Chart. This time the categories are on the vertical axis, the values are horizontal. So you’re 

looking at the lengths of the rivers as horizontal bars. 

The third category it offers is a Pie Chart. Now Pie Charts most people are familiar with. We 

slice a pie up in proportion. And here we come to a very important point. When Excel is looking 

at the data that you’ve selected it has no idea what it means. And in this case if you’re used to 
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Charts or Statistics and so on you probably realize that a Pie Chart would be an extremely bad 

choice of Chart here because a Pie Chart implies that you’re dividing something, you’re dividing 

the pie into parts. Now these eight rivers, the lengths of them do not when added up add to a 

whole something. It’s not sort of the length of all the rivers in the world or something like that 

and it’s divided between these eight. They happen to have those eight lengths but those eight 

lengths added together don’t form a total of something. So a Pie Chart would not be suitable. 

However, Excel doesn’t know that. You understand this, Excel doesn’t. So it offers you a Pie 

Chart and you need to be aware of the meaning of Pie Charts to realize that this is not a suitable 

Chart in this case. 

The fourth option is one of the new types of Chart in Excel 2016 and it’s what’s called a Pareto 

Chart. Now I’m not going to talk about Pareto Charts at the moment. It’s associated with 

something you may have heard of called Pareto or Pareto Analysis. Again, this would not be a 

suitable Chart in this case. I’ll come back to Pareto a little bit later on in the course. 

So really the best choices here would be either the Column Chart or the Bar Chart. Either of 

them are suitable. Some people avoid Column Charts in this kind of situation because quite often 

people associate the columns as in some way progressing with time. Now of course in this case 

there is no progression with time. And anybody looking at this Clustered Column Chart, should 

we choose to draw it, certainly should not imply any change over time. But because sometimes 

people make this time inference many people would go for the Clustered Bar in this case. But in 

effect either of them are totally suitable. 

But before I actually draw the Chart in this case what I want to do is to take a look at the All 

Charts Tab in the Insert Chart Dialogue because listed there you will effectively see all of the 

available Chart types. And in addition at the very top you’ve got a tab that says Recent which 

shows you the recently created types of Chart. It gives you quick access to the ones you’ve used 

most recently. You also have access to any Chart Templates that you may have created or 

acquired. And then you have a list of all the different Chart types.  

Now the fact that you have selected the data of the type that you have will to a large extent 

determine which types of Chart you can actually draw from that data. And in fact with a very 

straightforward selection like the selection here most of these Charts you could draw but some of 

them you couldn’t. For instance you couldn’t draw a Stock Chart because for a Stock Chart you 

need high, low and close stock market figures to be selected. And Excel can tell that what you 

have here is not high, low and close figures. 

Often, and particularly when you’ve got used to the different types of Chart in Excel, you may 

go to this All Charts Tab here and go straight to the sort of Chart that you want to select. Now in 

addition, let me now Cancel that. I will come back to it in a moment. If you go back to the Charts 

Group there are a number of icons within the group which represent the most popular types of 

Chart. So you’ve got things like Hierarchy Chart, Waterfall or Stock Chart. And then you’ve got 
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Statistical Charts and most of these have dropdowns. And on the dropdown you have the main 

Charts of that particular type and then usually access to some more. And then in the bottom right 

hand corner of the Charts Group there’s a little Dialogue Box Launcher and that gets you back 

into the Insert Chart Dialogue. So as you can see there’s a very wide range of Charts. And to 

some extent if you haven’t done this sort of thing before you really need to rely on a bit of 

experience and you’ll soon find that you start to know which Charts to use in each situation. 

So I’m going to create now a Clustered Column Chart. So I’m going to click on OK and there is 

my Chart. Now to the right of it you will see three buttons. There’s one with a plus, one with a 

pen, one with a filter on it. I’m going to talk about those later on in the course so don’t worry 

about those at the moment. Let’s concentrate for now on the chart area itself. Within the chart 

area there are a number of things. There’s the Chart itself of course. You can see the vertical 

columns. You have a horizontal axis with the categories on it. In this case the categories are the 

names of the rivers. And then on the left hand side you can see the scale for the vertical axis. 

And the vertical axis in this case contains the values and the values are the lengths in kilometers.  

Now there are many other things that you can add to Charts, as we’re going to see. And to some 

extent Excel does its best job to make your chart complete as quickly as possible. But sometimes 

what it does is not really up to the job. So for instance, if I hover over Length kilometers here 

what Excel has done is to make length (kilometers) the Chart title. It didn’t actually have 

anything else to use so it used that. I definitely want to give this chart a better title than that and 

I’m going to do that in the next section. But you can see here the basics of a straightforward chart 

and some of the main features. 

Now as we’ll see in the next section there are many ways that we can customize this, as I’ve 

already said. When you have a Chart selected like this one you get two additional tabs on the 

Ribbons and these two tabs, there’s a Design Tab and a Format Tab, are described together as the 

Chart Tools. And with those Chart Tools we can do all sorts of things in terms of changing the 

design. So for instance, we can use this gallery of Chart Styles here and completely change the 

style of the chart. And then with the Format Tab we can do a lot in terms of individually 

formatting the way the text appears and so on. But more of that later. 

One very straightforward thing you can do is to resize a chart just by using the Resizing handle. 

So for instance, if I wanted to make this chart bigger I could hover the top left hand corner, get 

the appropriate cursor, the cross-haired cursor, release the cursor, and my chart is much bigger. 

Another thing that you can do with a Chart and this is in fact a very important feature, is that you 

can move a Chart. By default it’s created on the same sheet as the data which it is representing. 

But sometimes you may want the Chart to be created on a completely different sheet or indeed 

you may want to create it on a special type of sheet called a Chart sheet. And a Chart sheet is 

unlike a regular worksheet. It’s if you like the other type of worksheet in that it doesn’t contain 

cells where you use formulae and functions and so on. It’s there really to hold a Chart. And Chart 
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sheets can be very helpful, particularly if for example you want to do a presentation with a Chart 

in it and you don’t want the presentation to be sort of confused by having the data in the 

background as you have here or even by having lots of cells and rows and columns and things. 

Basically you can have the Chart sitting on its own. 

I should point out, of course, that when you’ve got a Chart you can very easily Copy it into a 

completely different type of Office document such as a PowerPoint presentation or a Word 

document. 

Let me just show you how to move this sheet. Let’s go back to the Chart Tools Design Tab and 

at the right hand end in the Location Group there is a Move Chart button. And then basically I’m 

given a choice and the choice is to either keep this as an object in the Rivers sheet or in fact I 

could put in any other available worksheet or I can move it to a Chart sheet. In this case I’m 

going to move it to a new Chart sheet. I’m going to call the Chart sheet River Lengths Chart and 

I’m going to click on Ok and there is the Chart on its own Chart sheet. And as you can see the 

Chart sheet doesn’t have the background with the cells and rows and columns. And particularly 

if you were to hide the Ribbon and the Formula Bar you could make this a very straightforward 

presentation of the lengths of the rivers without any sort of distractions. 

So that’s it. That’s how to create a basic Chart. In the next section we’re going to look at 

customization. So please join me for that. 
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Video: Customizing a Cluster Column Chart 

Toby: Welcome back to our course on Excel 2016. 

In this section we’re going to continue looking at Charts and we’re going to do some work on 

formatting this particular chart, the one we created in the previous section that shows the lengths 

of eight African rivers. 

Now I currently have selected the Design Tab. We’re still looking at this chart on the River 

Lengths Chart, Chart sheet. And as I pointed out in the previous section you can choose a Style 

from the gallery of Styles available here. Let’s change this to that one. Note that we get a live 

preview. And as you hover over each of the options it has a name. So this one is Style 15. Not a 

particularly inventive name. Let’s go back say to that one.  

Now let’s look at some of the other features of the Design Tab. And one of the things that you 

can do is to actually change the type of the Chart. So that’s in this group towards the right hand 

end, Change Chart Type. And that brings us back into the gallery of types that we can change 

this to. So for instance if I wanted to stick with Clustered Column but I wanted to try this more 

colorful type I could do that, click on OK, and now of course each of my rivers has a color code. 

It doesn’t actually say on here what the color code is but we’ll come back to that later on. And of 

course I can change the Chart Type to something completely different. So as we saw before I 

could change it to a Bar Chart, for example. 

Now one of the things you may have noticed when I was doing that is that the words that 

appeared against the axes and the chart title changed according to the selection that I made. And 

with Excel 2016 you actually have a very fine level of control over things like the title, the axis 

labels, whether you can see the gridlines or not, you can see vertical gridlines here but not 

horizontal ones, for example. But you can actually adjust the chart elements using the button on 

the left of the Design Tab in the Chart Tools, the one that says Add Chart Element. Now what 

I’m going to do is to go back to the previous Chart Type and I’m going to click on Add Chart 

Element and you’ll see a list of the things that I can either add or modify. 

Now let’s say for example the chart title. Now if I hover over chart title in the menu you can see 

which option is currently selected because it’s the one that is highlighted. So it says Above 

Chart. Now I could choose one of the other options. So for instance I could say None and have 

no chart title or I could do it as a Centered Overlay. Now with a Centered Overlay the title is 

actually overlaying the chart rather than above it. And then I also have an option here, More Title 

Options. And if I click on that I get a panel on the right. This is a panel that you will become 

very familiar with because the contents of this panel and what the purpose of the panel is will 

depend on the situation you’re in and which selection you’ve made from the relevant commands. 

So in this case we’re formatting the chart title but we may be formatting something else, like one 

of the axes or even the bars. At the moment it’s the chart title. 
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Now having selected this option notice that the current chart title is outlined and I could click in 

there and change the chart title. So if I just put the cursor in there, use the keyboard to delete 

some of the characters and now I’ve got a much more informative title on my chart.  

The other options on the Format Chart Title panel on the right, they’re actually in three groups. 

There’s a Fill and Line Group, there’s an Effects Group and there’s a Size and Properties Group. 

Now we’re going to see similar groups of formatting options in several other situations during 

this section so let’s just take a moment to look at the main ones of those here while we’re 

looking at the title. 

Now with the title still selected let’s apply one or two formatting options. Let’s go for a border 

around the title. Now at the moment it’s set to automatic which means that it will depend on the 

particular Style that we’re using how the border looks. In fact in this case if I just click away 

you’ll see that there isn’t actually a border. What you could see there was this selection rectangle 

for the title. But let me suppose I wanted to put a solid line round there. Now the solid line 

defaults to 0% transparency and a width of 0.75 points. So that really is quite a narrow line. So 

let’s just stick with that narrow line for now. Let me just click away. You’ll see now that there is 

a border on the title. And in that way you could go through, and I suggest you do this with a 

sample chart, we can go through these other options and try some of the other options. So for 

instance, supposing I wanted to put a fill-in there. I’m going to choose a very, very light color, 

say that one. See how that looks. Well it doesn’t look very good but never mind. 

And the other thing I can do, you may have noticed next to Title Options up here it says Text 

Options. You could actually format the text as well. Now this may be a little difficult for you to 

see on the screen but I’ll just zoom in on it in a moment. Supposing I wanted to apply some sort 

of text effect. Now you can see things like Fill and Outline here but the middle category there, 

Text Effects, I could for instance add a shadow to the text. There’s a set of presets here. What 

about that one? Now as I say it may be difficult for you to see. Let me just zoom in. But you now 

have that shadow effect on the text. And once again if you want to experiment with this yourself. 

So for instance that sort of thing. If I now go back and remove the options that I put in before. So 

I said I want No Fill and let’s say No Line, not automatic. Now let me click away. And you can 

see the shadow under Length of African Rivers. And so that’s basically how you can format the 

elements in a Chart. 

Now notice again at the top of the right hand panel here I’ve got Chart Options now. The reason 

I’ve got Chart Options and I’ve got Format Chart Area is that I’ve got the whole chart selected. 

When I clicked in the title I had the title selected. If I click outside I’ve got the whole chart 

selected. Let me try a Glow Effect. How do you think that will look? Let’s try a glow with the 

chart selected. Let’s try that one. And of course what happens is it applies Glow to the whole 

chart. So you see that effect outside the chart. That can look quite effective in a presentation. 
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Now there’s something else to point out here. If you look at that dropdown next to the word 

Chart Options it lets you select not only chart area or chart title but you can choose the horizontal 

axis, the plot area, the vertical axis. You can also switch on and off major gridlines.  

Now one of the options there, plot area. The plot area is actually inside the chart area and it’s the 

area with the graph itself in it. So things like, in this case, the title where I’ve got the title above 

the chart is outside the plot area. And in fact the labels on the axes are outside the plot area. The 

axes mark, if you like part of the perimeter of the plot area. 

Now in fact it isn’t the case that you can apply all effects and all formatting options in all 

situations. So for instance with the plot area selected I won’t be able to apply a glow to it. So if I 

select Glow here I don’t get a glow just around the plot area. Whereas if I were to select say the 

vertical axis and text options not only could I apply an effect to the text on the vertical axis. So 

let’s put a Shadow Effect in there. Again let’s say that one. You can see the Shadow Effect now 

on there. But I could also say go to the Text Options box on the right there and change the text 

direction from horizontal to rotate all text 90o. And now you can see that the lengths are rotated 

at 90o. That looks pretty horrible so I think I’ll just put that change back. But hopefully you get 

the idea from that. You can do an awful lot of formatting, particularly using the formatting panel 

on the right and selecting the particular element of the chart that you want to format. 

I want to go back now to Add Chart Element and we’re going to look at adding one or two chart 

elements.  

One chart element that is sometimes a very useful thing to add is a Data Table. And I can best 

explain the Data Table by a demonstration here. I’m going to add a Data Table with legend keys. 

I’m just hovering over so I’m not going to permanently add it. And what you can see now at the 

bottom of the chart is I’ve still got my names on my rivers but with each of them the relevant 

length is shown as a number. Now of course I can read off those lengths on the left, not quite as 

accurately as the Data Table tells me. But if you have a more complex chart, perhaps with three 

or four lots of columns in it or perhaps a mixture of columns and lines, having a Data Table 

included as well can be a very useful way of seeing the source data that’s used in the chart. 

Now it mentions there legend key, something else we haven’t got in this chart is a legend. And in 

this particular chart if I add a legend to it, let’s say put a legend on the right. It’s not a 

particularly informative legend really because there is only one measurement here which is a 

length. And it corresponds exactly to what’s shown on the axis on the left. But if say all of these 

bars were multicolored and we were actually using that multicolored chart type. If I change the 

chart type say to this one now the legend at the bottom shows me the river that corresponds to 

each of the colors. Note also that Excel 2016 has once again managed to get things confused by 

marking length kilometers on the horizontal axis. 

Now something else that I’d like to do here to avoid this confusion over what the vertical axis is, 

is to add a label to the vertical axis. So that’s pretty straightforward. Add Chart Element, Axis 
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Titles. I want to put one on the primary vertical axis. Now to type that in I need to click into that 

box. But notice the cursors sort of on its side. And this is rather a strange thing because you’re 

going to finish up typing text on its side. It’s easy when you get used to it. You just sort of in 

your head pretend that it’s lying in the normal way. But I’m going to type in there Length (km). 

Of course I could format that if I wanted to. Click away. That’s in place. And then of course I 

also have an unwanted and incorrect axis title on the horizontal axis. I’m going to get rid of that 

and leave the legend there. 

Let’s now look at some of the other available Chart Elements.  

We’ve already looked at axes, Axis Titles, Chart Title. Data Labels are really labels shown on 

each point or in this case each column in the chart. So let’s say that we want Data Labels at the 

outside ends. And you can see that what we have there is actual length of each river above the 

river. Now these can also be heavily formatted. And also if you have a problem with legibility, if 

you’ve got a sort of crowded chart or something like that you could, for instance, click on a 

particular one and when you’ve got the cross-haired cursor you can drag it away and leave it sort 

of pointing at the particular chart that it applies to. 

Now the formatting of Data Labels offers you most of the same options that you have with other 

elements in the chart. And again as with the other elements in the chart I’m going to leave you to 

experiment with those. Take each of these in turn. So in this case we’re looking at Label Options. 

Go through each of the categories and just try out all of the different things that are available and 

you’ll find that over a relatively short period of time you should get used to all of the various 

formatting options. 

The remaining Chart Elements to varying extents really depend on the chart type as to whether 

they’re appropriate. So for instance with Error Bars, Error Bars are generally used in a situation 

where you are perhaps predicting something, forecasting sales, something like that. And the 

Error Bars show the amount above and below your prediction that you’re prepared to find 

acceptable. Gridlines. Well currently we have Primary Major Horizontal Gridlines on. Gridlines 

really relate to numeric data and in this case putting vertical gridlines on a Column Chart we 

wouldn’t actually see any difference because the categories in this case aren’t numeric. I could 

actually set the vertical gridlines on but the only difference that would make would be to put a 

vertical line at either end of the plot area. You wouldn’t get grid lines for each of the columns. 

And the other optional chart element that’s there is the Trend Line. Now the Trend Lines here are 

really again more to do with the variation of numbers over time. So if you were say plotting the 

weather statistics that we were looking at earlier on in the course and you wanted to show a 

tendency for temperature or rainfall over time you might plot some points and then draw a trend 

line that was the best fit to those points.  

Now notice there are two other options here which are currently grayed out. And of course with 

many of these options you actually can’t draw them in some situations. Here even though you 
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can draw something it may not be helpful or appropriate. For Lines and Up/Down Bars in this 

case you’re actually not able to draw them. 

So that’s it on the formatting of a Chart for now. We’re going to do some more work on it in the 

next section. And we’re also going to look quickly at a couple of other options for applying the 

formatting. But that’s it for this section. I’ll see you in the next one. 
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Video: Customizing a Pie Chart 

Toby: Welcome back to our course on Excel 2016. 

In this section we’re going to carry on looking at Graphs and Charts in Excel 2016 and I’m going 

to start by looking at some different data related to the African continent. In this case I’ve got 

details of land use in five African countries and I’m going to plot the land use for the first of 

those countries, Congo, using a Pie Chart. 

Now in this case a Pie Chart is a very appropriate kind of chart to use because if I add up all of 

these category values for land use, that’s forest and jungles, crop land, meadows and pastures, 

and other, I will get the total land area of the country. So it is appropriate to represent the 

division of that country’s total land area using a Pie Chart. The total is actually in the figure in 

column B. So what I want to do is to select the data related to the Congo and draw a Pie Chart. 

Now one of the problems I’ve got here is that if I just make a selection like that, for example, 

that would be incorrect because in that case the area figure in column B would actually be 

represented as though it were one of the categories of land use. So I don’t actually want to 

include column B. 

Now I could just make a different selection without column B but one thing that’s a very useful 

thing to know when you’re working with Graphs and Charts is I can simply hide column B and 

then I can make that straightforward selection and create a Pie Chart. 

Now I mentioned in the previous section that there are other ways of doing many things. There 

are always different ways of doing things in Excel. One of the ways that I could deal with this 

would be to go down here to the Quick Analysis Tool, click on the Charts Tab and say I’d like a 

Pie Chart please. I get a live preview. We know I’ll be able to format that afterwards but that’s a 

very straightforward way of drawing a Pie Chart. 

Now having drawn that Pie Chart and of course you know from the previous section how to do 

all the formatting that you might want to do on that. Let me talk now about those three buttons 

on the right that I mentioned earlier on in the course. 

The first one, the plus button, is the Chart Elements button. If I click on that I get the option to 

add or to remove Chart Elements. Now in the case of a Pie Chart you have far fewer chart 

elements than say with a Column Chart that we saw in the previous section. For instance, a Pie 

Chart doesn’t have any axes. But as you can see there you’ve got three elements in this particular 

control. You’ve got the chart title, the legend, we haven’t got data labels at the moment but that’s 

fine. 
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Let’s go down now to the second category and that’s Chart Styles. Now with Chart Styles we can 

look at some standard chart styles, perhaps choose a very different one. Obviously the data is the 

same, the style is very different.  

And the third element is Chart Filters. Now with Chart Filters you can edit which data is shown. 

So for instance, if you only wanted to show the area excluding forests and jungles you could 

switch off forests and jungles. Now that’s not really very appropriate in this case but you can do 

it. 

You also, as with many other of these controls, have down at the bottom right here a Select Data 

option. And that gives you access straight back into the selection on the worksheet from which 

the chart has been built.  

So there we have the ways in which you can use those three buttons on the right rather than using 

the Formatting Panel on the right and going through the kinds of procedure that we saw in the 

previous section. 

And as if that weren’t enough in terms of options if you right click on the chart you get a 

Contextual Menu as you would expect and you have on the Contextual Menu options such as 

Format Chart Area, Move Chart, Select Data, Change Chart Type, and so on. But you have this 

little toolbar at the top with Fill and Outline buttons and you could, for example, select the 

legend and say well I’m going to put an outline around the legend. So I’m going to choose a 1.0 

point outline for the legend. And for the color I’m going to make it, let’s say that color there. 

And I’ve now got an outline round the legend. 

Now let’s suppose that I’ve been working on this for some time and I’ve got the formatting 

exactly the way I want it. I might now say well I’d like to do the same thing for Egypt. That can 

be done by changing the data, by reselecting the data to which this chart applies.  

If you look on the Design Tab one of the options in the Data Group is Select Data. But also you 

could use that Filter button. So if you click on that filter and go down to the bottom right, Select 

Data, and what Select Data does is to highlight with the marching ants the data that’s currently 

being used for this chart and it lets you change it. Now you can change it in a couple of ways. 

You can just type the data range into this Chart Data Range box. You see the range that’s in there 

already. It’s land use and then it’s A1 to F2 which looks fine. Or you can use that little control on 

the right there that looks like a tiny little spreadsheet and if you click that it lets you go back into 

the data source and reselect your data. So that’s what I’m going to do. I’m going to select A, no I 

think what I’m going to do is I’m just going to hold the Control key down and just choose all of 

the cells that I want to use. So basically I’ve chosen the cells in row 1 and row 3. When I’ve 

finished making my selection all I do is click on that little worksheet symbol again, click on OK 

and I have now got a chart that shows the equivalent information about the country of Egypt. 
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Now in this section I’ve concentrated on using some of the other controls to format this chart but 

you’ll often want to use that Formatting Panel. Let me show you one or two things that are very 

specific to Pie Charts. If I went through every type of Chart it would take us a very long time so I 

really am going to have to rely on you to experiment with each of these. But if I right click on 

that chart and go down to Format Chart Area to bring up the panel. What I’m going to do now is 

to choose the Series. So this is the Egypt Series. So basically this is the values, what would have 

been the columns in the Column Chart or the points in say a Scatter Diagram, basically the slices 

of the pie. And I’m going to look at this option on the right here, the one that says Series Options 

because they’re really quite specific for a Pie Chart and you very often would different types of 

chart get very specific options.  

So for instance, with a Pie Chart I can choose the angle of the first slice. It defaults to 0o. So the 

first slice starts right at the top there. That’s the biggest option. That’s the biggest section of all, 

forest and jungles. But I could have that start say at 90o. Now I can either use the rollers or I can 

type the angle in. And I can also choose my Pie Explosion Angle. So if I’d like my pie slices to 

come out of the chart in some way I could choose say an angle of 10 o like that. So very specific 

options for a Pie Chart. 

And one other thing I’d like to quickly point out here is we haven’t really looked much at the 

Format Tab under the Chart Tools and many of the options on the Format Tab we’ll be looking 

at later on when we look at inserting pictures and formatting shapes and so on. But one very 

useful feature there is that you can select a specific object in the chart. So for instance I could 

select just this slice up here, note the little selection markers on the corners there to indicate 

which of the slices I’ve got selected. If I now click on Format Selection on the left of the Format 

Tab and go over here to Format Data Point, say go to Effects. I could apply an Effect just to that 

point. So let’s choose say a glow effect. Let’s choose that Glow Effect just for that point. Very 

useful for highlighting a point in a presentation. 

Okay so we’ve done some work on this Pie Chart. What I’m going to do now is to Close the 

panel on the right and I’m just going to delete the Pie Chart. We can always recreate it. And then 

what I’m going to do is to draw a completely different sort of chart and this chart is going to 

show me the information for all five of those countries. 

Now one thing I should point out here when I’ve made this selection is how important it is to get 

the selection right. What I’ve done here is to make sure that when I’ve made the selection not 

only have I got all of the numbers I want, that’s the areas for the different types of land use in the 

five countries, but I’ve got the names of the five countries and the names of the four types of 

land use. 

Now it’s very important if you want to use the headings that were already on the sheet to make 

sure that they’re included in the selection. That usually, not always, but usually means that 

http://www.simonsezit.com/


Learn Excel 2016 for Beginners: Master the Essentials 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 
 

something like the top left hand cell is empty. That’s not a problem. In many cases that’s a good 

thing. But it’s usually the case. 

Now I’m going to insert a chart again. I’m going to insert from the recommended charts list and 

I’m actually going to select the first one there, the Clustered Column, click on OK, and there is 

my Clustered Column Chart. 

Now of course you would know now how to change the chart title, how to, for instance, put a 

title on the vertical axis. But the thing that I want to do here is something that we haven’t done 

before. With the chart as it is you can see that I have my five countries along the horizontal axis 

and for each country I have four bars or potentially four bars. Libya actually has no forest and 

jungle so its first bar has zero height. But if I wanted to I could switch the meanings of the rows 

and columns. Now there is a button on the Design Tab in the Data Group, Switch Row/Column. 

Watch what happens if I select that. What I now have is my four categories of land use and for 

each category of land use I have the five countries.  

Now that’s a very important feature when you’re dealing with multidimensional data because 

here you’ve effectively got three three-dimensional data. You’ve got countries, you’ve got land 

use and you’ve got the areas of land. Now to show those three in two-dimensions you need to 

show sort of charts within charts. So you’ve got a forest and jungles chart, a crop land chart, 

etcetera, within the overall chart. But that’s another important feature, switching rows and 

columns. 

The very last thing I want to show you here is that you can print charts. And if I go to the 

Backstage View and go to the Print option you can see the option there to print the selected 

chart. Now as you can see it’s a pretty straightforward job. I would choose my printer, change 

any other settings that I want to change, click on Print, and hey presto I would print my chart. 

Let me go back into that worksheet again. Let me suppose I put the cursor up in cell A1. So the 

chart itself if no longer selected. Let’s go back, File, Print. Now notice in this case the default is 

Print Active Sheet. So because I’ve got something on the sheet selected you can see part of the 

chart. Now I’d obviously want to change that to landscape orientation and then I’d be able to 

move things round to fit it all on the page and so on. But in this case the default option is printing 

the sheet. So that is an important distinction. 

Well that’s it on Chart types for now. I’m going to take a quick look at the new charts that 

arrived in Excel 2016 in the next section but for now that’s it and I’ll see you then. 
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Video: New Chart Types in Excel 2016 

Toby: Welcome back to our course on Excel 2016.  

In this section I want to quickly talk about the new types of Chart in Excel 2016. And so far the 

most informative details of the new chart types I found on a page that was actually added to the 

Microsoft Office blogs some months ago and related to the Office 2016 preview. I do believe 

that everything on here is actually in the live version of Excel 2016 but there’s a good 

explanation here of what each of these chart types is.  

As this course is for beginners and intermediate level users I’m not going to demonstrate or go 

into these charts in detail but I think it’s worth just running through what the charts are and then 

you can refer to either this page or perhaps an updated version of this page when you follow this 

course if you are interested in these charts in particular. 

So we have a Waterfall Chart for visualizing financial statements. Regular Histograms. We have 

Pareto Charts that I mentioned earlier on in relation to Pareto analysis where you can identify the 

most prevalent issues in whatever you’re measuring. In this case the example they use relates to 

the reasons that a bookstore has books returned by customers. We have Box and Whisker Charts. 

We have Treemaps and Sunburst Charts. Sunburst is a sort of multilevel Pie Chart. 

I suggest that if you’re particularly interested in charts this is a very good place to start. Some of 

these charts could to some extent be created by a little bit of trickery in an earlier version of 

Excel. But they’re very easy to use in Excel 2016. And if you’re looking at things like financial 

analysis it’s well worth catching up on these new types of chart. 

That’s all I’m going to say about those for the moment. I’ll see you in the next section. 
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Video: Exercise 07 

Toby: Welcome back to our course on Excel 2016. 

It’s time for Exercise 07. And in this exercise we’re going to do some more work on the weather 

workbook that you worked on a couple of exercises ago. And given that my weather is for the 

nearest town to where I live, Northallerton in North Yorkshire, I’ve drawn two charts based on 

the data from the single sheet that we had in the workbook last time you saw it. I’ve drawn a 

rainfall chart and it’s called an Area Chart. Some things to note about what I’ve done on this 

chart. I’ve given it a sensible title. I haven’t included in the title the range of years that it covers. 

Perhaps I should have done. And then I’ve also on the vertical axis put in a title, Rainfall (mm). 

On the horizontal axis because the month names were sort of running into each other a bit I’ve 

rotated the month names. You may want to try that sort of thing. And for each month I have 

included the actual rainfall number. If you look vertically above the month you will see what the 

rainfall, the average rainfall for that month was. 

I’ve chosen a particular Style. I’m quite happy for you to choose your own Style. And then for 

the temperature what I’ve done is to draw a Chart with two lines on it. Now these lines have a 

couple of very specific properties. One of them is that I’ve actually put the values of the data 

points on it and the other one is that the top line, the maximum temperature I’ve made red for hot 

and the lower line, the minimum temperature, I’ve made blue for cold. I haven’t actually put a 

scale on the vertical axis. You may think that will be a good idea. I’ll leave that up to you. But I 

have put a title on the vertical axis. And on this occasion because the names of the months were a 

little bit smaller they don’t run into each other. I’ve left the names of the months horizontal. But 

there is a legend and that will tell the viewer what each of those color lines mean. Once again I 

put a title on the chart as well.  

So I’d like you to effectively do that with the weather figures for the area that you’ve now got 

weather figures for. I don’t need you to make your charts exactly the same as mine but I’d like 

you to use the features that I’ve used in mine in yours.  

That’s the end of this section. Please join me in the next one. 
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Chapter 22 – Sorting and Filtering Data 

Video: Managing Data by Sorting 

Toby: Welcome back to our course on Excel 2016.  

We’re now going to cover a few aspects of what I’m going to call data management in Excel 

2016. And the first thing we’re going to look at, and that’s what we’re going to look at in this 

section, is Sorting. 

I’ve returned to the top 50 movies list here and we’re going to do a bit of work on sorting this 

into various sequences. Now although the basics of Sorting in Excel are very, very 

straightforward there are a couple of easy ways to come unstuck and also there are some flexible 

and powerful features in Excel that you should be aware of. 

So I’m going to make a couple of deliberate errors going through this section. I will obviously 

point them out as I go. But let’s suppose we wanted to Sort this list not by its position in the top 

50 chart but by the title of the movies. So let me select column A which is the column with the 

movie titles in it, go to the Data Tab on the Ribbon, and in the Data Tab in the Sort and Filter 

Group there are three buttons on the left related to sorting. Now the top left one, Sort A-Z, lowest 

to highest. This will sort whatever I’ve got selected in A-Z order. Now when it says lowest to 

highest that relates to text. If in fact what I had in this column was a set of currency values, say 

the prices of the DVDs of these movies, sorting into order would sort into ascending or 

descending price order. And as we’ll see in a moment if we were say sorting on year of release it 

would be on numerical order. And there are a couple of gotchas hidden in that that you need to 

be aware of. But when it comes to a straightforward text sort, so in this case sorting the titles of 

the movies, in theory it’s a straightforward job. If I want them in ascending alphabetical order I 

click the A-Z button. The button below it is the Z-A button. That’s highest to lowest. But I want 

lowest to highest. 

Microsoft Excel found data next to your selection. Since you have not selected the data it will not 

be sorted. So if I select the column title but not the column year of release then what will happen 

is it will sort the titles without sorting the years of release. So what would happen is that the titles 

and the years of release would get separated from each other. Now there are some situations 

where you may actually want to do that but they must be pretty few and far between. And 

normally what you’ll want to do is to do what it says here, Expand to the selection. And that 

means that Excel will select all of the columns in the worksheet and sort them all. So I’m going 

to say Expand the selection, leave that there. If I really did want to select just that one column I’d 

choose the second option, Continue with the current selection. But I’ll do an Expand the 

selection, click on Sort and it sorted them into alphabetical order. 
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Now one or two of the little gotchas that you need to be aware of here. One of them is that when 

it does this it does it purely on the basis of alphabetical order. So look at what the first movie in 

the list is, 12 Angry Men. Now why has it put 12 Angry Men at the beginning? Well because as 

far as computers, PCs are concerned one comes before A. So the one in 12 Angry Men is before 

the A in Alien. And as a sort of related type of issue, although some people would say this isn’t 

an issue at all. All of the The’s, The Dark Knight, The Dark Knight Rises, The Departed, The 

Godfather, etcetera, all of the The’s are under T towards the end of the list. Now you might see 

that as a problem. And what some people do, I’m not going to do this now, but what some people 

do to overcome this problem is they would have a different additional column here and what they 

might put in the additional column is what they’ll call the title for sorting or the sort title. So 

when they’re storing this information they actually put an additional field which is the sort field. 

Now I’m not going to go into that now but it is something for you to be aware of. 

One of the other things to be aware of is that to all intents and purposes I’ve made a bit of a 

mistake here because if I now closed this particular workbook and opened it up again and said 

now I want to put them back in order again, I want to put them back in the sequence of top 50 of 

course I have no longer got the sequence of top 50 because they were only in the top 50 sequence 

on the basis of their row numbers and I didn’t have a separate column with the chart positions in 

it. It’s very important that you have a column for all of the values that you may want to Sort on. 

So at this stage I can still do an Undo. So I inserted a new column, gave it a title, used the Format 

Painter to copy the title format from B1 to A1. I’ve typed a one in cell A2. Now I’m going up to 

do Fill and I’m going to do Series and I’m going to do a Series in Columns, Linear, Step Value 

1, Stop Value 50 click on OK, and there we are. I’ve got 1 to 50. 

Now one of the great flexibilities when you’re sorting in Excel is that you can Sort on more than 

one column. So let’s suppose that what I want to do here is to Sort by year of release but within 

year of release I want to sort by title. 

Back in the Sort and Filter Group there’s one other button we haven’t used, the Sort button here, 

and this brings up the Sort Dialogue. Now by default this will normally contain details of the last 

Sort you did. So sort by position, sort on values, sort smallest to largest. I don’t want to do that. 

If I want to delete a level, let me just delete that level and let me add a new level. I want to sort 

by year of release. I want values smallest to largest. Let’s do that first thing. Click on OK. Now 

you’ll see that the movies are sorted, the oldest one, City Lights 1931, Modern Times 1936, and 

so on. And if you go down to say 1994 you’ve got The Shawshank Redemption, Pulp Fiction, 

Forrest Gump, and Leon, all four of those in 1994. Let’s do Sort again. Let’s add a level and say 

that after year of release we want to sort on title, A-Z, click on OK. And now within 1994 we 

have them sorted by alphabetical order of title, Forrest Gump, Leon, Pulp Fiction, The 

Shawshank Redemption. And of course it would be very easy to change that second criterion 

from title to position, say. So within 1994 we’d have the highest rated movie, The Shawshank 

Redemption, then Pulp Fiction, then Forrest Gump, then Leon. So that’s a combination of two or 

more columns to sort. 
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Now there are just two other things to point out here. One of them is I haven’t mentioned the 

headers on this sheet. And generally speaking Excel is pretty good at working out that you have 

or you don’t have headers on a sheet. So when, for example, it sorted these movies by title it 

didn’t actually take the word Title right at the top there in B1 as the name of a movie and it’s 

usually pretty good at that. But you can control that if you are having problems and you’re either 

having a title included that you don’t want included or vice versa. In the Sort Dialogue there is a 

checkbox here, My Data has Headers, and you can check or uncheck that depending on whether 

your data has headers. In this case Excel decided on its own that it did have headers and that was 

a correct decision. 

The second thing to bear in mind here is this Options button. There are two other options. 

Probably you might not use either of these often or even at all. You can make sorts case sensitive 

if you need to. So for example in the case of sorting text fields capital T and small T would sort 

differently. So case sensitivity is a possibility. And also although in the vast majority of cases 

you will be sorting the rows in a worksheet you can actually Sort the columns. You can do a left 

to right Sort. I’ve been using Excel for a very, very long time. I’ve never had to do a left to right 

sort but I have actually tried it and it does work. So a couple of other things to be aware of. 

That’s it on Sorting. Please join me in the next section. 
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Video: Managing Data by Filtering 

Toby: Hello again and welcome back to our course on Excel 2016. In this section we’re going to 

take a look at Filtering. 

In the previous section we looked at sorting a worksheet. And one of the reasons for sorting is to 

be able to find particular elements. Think for a moment what a traditional paper telephone book 

would be like if the entries were not sorted into sequence, if you had to go through every page to 

find the person that you wanted. So one of the main reasons for sorting the content or a 

worksheet would be to find a particular element or some elements.  

There is another tool available in Excel 2016 that can help us to find specific rows in a worksheet 

and that is to use Filtering. 

Now I’m going to start by demonstrating and explaining filtering on this catalogue from the 

Shower Power Invoice workbook. And what we’re going to look at is how we can use filtering to 

narrow down the range of catalogue items that we’re looking at at any particular time. 

So first of all let’s suppose that I wanted to see all of the items in the catalogue that have a 20% 

discount. Now obviously I can scroll up and down. I can look in column E, the discount column, 

look at what’s got 20. But if I actually select column E and then on the Data Tab on the Ribbon 

in the Sort and Filter Group click the Filter button a Filter is enabled on column E. You can see 

it’s enabled because it’s got a little dropdown arrow to the right. Now let me click on that little 

dropdown arrow and I can now filter based on the values in that column. Now there are a number 

of options here and the options will depend to a large extent on the type of the data in the 

column. In the case of this discount column it’s numeric data. So if you look roughly in the 

middle of that menu there you’ll see Number Filters. And because this is a column containing 

numbers I’ll have Number Filters.  

But before we look at the Number Filters look at the top of the panel. You can Sort smallest to 

largest, you can Sort largest to smallest. So this is a way that you can set about sorting as well. 

You can also Sort by color. Now we haven’t got any color here so that’s not really relevant in 

this particular case. Towards the bottom of the panel you have a Search box. So you could 

Search for a particular entry in the column. And below that you have a set of checkboxes. The 

top one says Select All. Below the Select All button there is a list of all of the values in that 

column. Now there are only two values in that column. There’s a 20 for 20% discount, 33.33 for 

a 33.33% discount. If what I wanted to see was only the ones with the 20% discount I can either 

deselect Select All so nothing is selected and then click 20 or going back to Select All I could 

deselect 33. When I now click the OK button to apply this Filter only the rows with a 20% 

discount will be shown. Click on OK and now you can see only the rows with the 20% discount. 

When a filters been applied you will see a little Filter icon appearing on that Filter button there in 

place of the original Filter icon and note there’s a little Screen Tip there that tells me what the 
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filter currently is. Now that’s the sort of abbreviated form. If you put a much more complicated 

filter on which as you’ll see later you can then it will do its best to explain what the filter is. But 

here you can see Discount % = 20. 

Now if I wanted to clear the filter, if I click on that again one of the option is Clear Filter and that 

filter is now cleared. 

One thing about filters which sometimes confuses people is to note the difference between 

filtering being enabled and a filter being set. At the moment filtering is enabled on the Discount 

column, column E. You can see the little Filter button there. But we don’t actually have a filter 

applied. We’re seeing all of the rows on the sheet because we don’t have a filter applied. If I 

want to remove the filtering I would press, again, the Sort and Filter, Filter button up here and 

that actually takes the button off of the column and in fact none of the columns on the sheet are 

being filtered. All I need to do to put it back on again of course is just to click that again.  

If I wanted to filter on every column then I could either select all the columns or even select the 

whole sheet and then if I click on Filter I’ll find that all of the columns have Filter buttons 

enabled. Now I’m going to leave the Filter buttons enabled on all of the columns and I’m going 

to look at those Number Filters now. But I’m going to look at the Number Filters on the List 

Price column. 

If I click on the List Price Filter button there is of course a much longer list of prices because 

even though this is not a hugely long sheet there are a lot of different prices on it. And if I say 

wanted to look at every item that was over $30 I’d have to sort of deselect the whole lot and then 

go through and click all of the ones that are more than $30. A much better alternative in this case 

if I go to the Number Filters is say if I wanted to see all of the items with a price over $30, 

choose the Number Filter Greater than. Look at all of the Number Filters there. You’ve got 

Equals, Does not equal, Great than, etcetera. But then a little bit further down you’ve got 

Between. What are the top ten prices? Which prices are above average? But let’s look for just 

Greater than at the moment. So click on Greater than and it asks me to specify a price so I’m 

going to say Greater than 30, click on OK, and I can now see all of the products whose list price 

is above $30. 

Now let’s go back into that again and again go back to our Number Filter. Note the tick on the 

left there indicating that we have a Number Filter in force. And let’s go back into that Greater 

than. You can make up a Composite Filter. So you could say the List Price is Greater than 30 

and, and then perhaps another criterion related to List Price. But I’m on this occasion going to do 

an Or and I’m going to say Or it’s less than $10. So I’m going to say Greater than 30 or Less 

than 10. 

And you can apply filters on more than one column at once. So having filtered List Price on Less 

than 10 or Greater than 30 I’m going to once again look for those with a 20% discount. So I’m 

going to go back to the Discount column. I’m going to clear Select All, just check 20, click on 
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OK, and I’ve now got two filters applied. So now I’m building up quite a complex filter. I’m 

saying show me the products in my catalogue whose price is less than $10 or more than $30 and 

for which the discount is 20%. And there you can see all the products that satisfy both of those 

criteria.  

Now so far we’ve been filtering numeric columns. Let’s look at a text column. Let’s look at the 

Product Code column. 

If I click on the Product Code column I have a full list of all of the products because I don’t think 

I’ve got any product codes duplicated. But this time roughly in the middle there I see Text 

Filters. And when I’m filtering text I can look for very different kinds of patterns. So for 

instance, I could say I want a product code that begins with and then I could say it begins with 

MAP. So I’m looking for the codes that begin with MAP, click on OK and that’s further 

narrowed down the set of values that I’ve found.  

Now just go back into those Text Filters and take a quick look at them again. You can have 

straightforward matches, it equals or does not equal, begins with, ends with, contains, so you can 

specify just some text within the name. So if for example I were going to filter on Description I 

might look for a description that contains the word Gray if I were looking for a particular color. 

Now to do one other demonstration I’m going to use the Customers worksheet from the Shower 

Power Invoice workbook and I’m going to demonstrate a little sort of exercise here. I realize I’ve 

only got four customers but let’s pretend for the moment that I’ve got thousands of customers on 

this worksheet and I want to find all of those customers who haven’t placed an order this year 

and who don’t currently get a discount and say to them if you place an order now before the end 

of the year I’m going to change your account so that you get a discount. 

I’m going to Filter on two columns, Discount and Last Order. I’ve just added that Last Order 

column. That basically contains the date that the customer last placed an order. So I’m going to 

select the whole thing. I’m going to switch on Filters. On the Discount column I’m going to just 

look for the customers who don’t currently get a discount. And then on the Last Order column 

for Date Filters I can just specifically go for, if you look at the list on the right there, Last year. 

So that would mean the last order they placed was last year. But notice some of the other options 

there, Last quarter, This quarter, Last month, This month, Last week, This week. Some very 

useful kinds of standard filters there. But in the actual list at the bottom there with all of the data 

on it it’s not arranged in sequence as the numeric ones are and the text ones are. It’s actually 

arranged as a sort of time tree view. So you’ve got years, then you’ve got months, then you’ve 

got days. So you can select specific days, specific months or you can select specific years. Now 

on this occasion, as I say, the Date Filter I’m going to use is one of these standard ones and it’s 

Last year. So I’m looking for any of my customers whose last order was placed last year. 
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And having applied both filters I find that I’ve only got one company here who don’t currently 

get a discount, last placed an order January 9th last year so I’m going to invite that customer to 

place an order and in response they will get a discount. 

Now that’s it on Filters for the moment. There is another option here, Advanced, that brings up 

an Advanced Filter Dialogue. That’s outside the scope of this course. That may be one for you to 

look into. 

That’s the end of this section. I’ll see you in the next one. 
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Video: Customizing Tables 

Toby: Welcome back to our course on Excel 2016.  

In this section we’re going to look at another aspect of managing data in worksheets. We’re 

going to look at the use of Tables. 

Now strictly speaking you can get by perfectly well in Excel without using Tables but Tables do 

introduce some very useful features and in some situations Tables can make things easier for you 

and can certainly save you a lot of time. We’re going to use a Table in the Shower Power Invoice 

and I think when I’ve shown you some of the main advantages of doing this you’ll see why the 

use of Tables can be a very useful approach in some situations. 

In order to demonstrate this I’m really just going to create a table and then I’ll talk about some of 

the advantages that having a table has. And what I’m going to do on the invoice is to say that the 

part of the invoice that lists the items in the order, so the line orders in the invoice, are going to 

form the table. And in addition to those lines in the order, so at the moment on this sample that’s 

rows 21 and 22. I’m going to include a header and I’m also going to include a totals row in the 

table. Now the totals row I’m going to include is not this one. I don’t need one to begin with. So 

what I’m going to do is to delete that row and in fact I’m going to delete some of the rows 

underneath that aren’t going to be used for anything. I’ll get rid of those rows as well. It doesn’t 

really matter but it would just make things a little bit tidier.  

And then what I’m going to do is to select cell B20, so that’s the top left corner of my table, and 

I’m going to go down to G23. So that’s one row below the last entry at the moment. And having 

made that selection go to the Insert Tab and select Table in the Tables Group. And when I do that 

I get the Create Table Dialogue. Note the checkbox there, My table has headers which my table 

does so I’m going to leave that checked. Now as you can see there in the currently selected 

control in the Create Table Dialogue the range B20 to G23 is shown there. If you didn’t want to 

make your selection first you could just go straight to the Insert Tab, click on Insert Table and 

enter the range there. You can also use this little icon on the right, the little Spreadsheet icon that 

we’ve used before that lets you go into your sheet and let you choose the area that you want to 

select. But in this case I’m going to stick with the selection that I originally made, click on OK 

and that is now a table. 

Now if I just click away you will see there’s actually quite a smart table as well. It looks quite 

neat. And in effect it is a sort of worksheet within a worksheet because each of the headers has 

its own little Filter dropdown. So I can use those exactly in the same way that I’ve used filters in 

the previous section. I can Filter, Sort, etcetera on those. And currently I’ve got an empty row 

which I’m going to use as a totals row but I’ll come back to that in a little while. 
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Now notice at the moment that the selected cell is I20. If I select somewhere within the table 

you’ll see that I get a Contextual Tab, a Table Tools Design Tab up here. So let’s select that. And 

I’m going to look at some of the options on this Design Tab. 

Starting at the left you can give your table a name. And as we’ll see later on and as I’m sure 

you’ll find useful if your use of Excel goes as far as programming it’s a very useful thing to be 

able to give a table a helpful name. By default it’s called Table 1. I’m going to call it Order Item 

Table. And you can resize a Table. So if I click on Resize Table I’m given the opportunity to 

resize it by changing the range that’s selected there. And in fact provided you follow the 

instructions in the note there, which include the fact that the headers must remain in the same 

row, you can select the table and you can actually drag it by sizing handles to make it a different 

size. But let’s stick with the size that we’ve got now.  

Now in the next group on the Design Tab you have some commands that are outside the scope of 

this course, Summarize with Pivot Table. We don’t look at Pivot Tables on this beginner and 

intermediate course. Remove Duplicates is pretty much does what it says, delete duplicate rows 

from a sheet. In this case it will remove duplicates from the table. And Convert to Range would 

convert the table back to being a normal range again. So it started out as a range of cells. You 

can turn it back into being a range of cells as well.  

The next group along, External Table Data, is one, again, that is out of scope for this course. 

What we’re mainly going to look at now are the other two groups, the Table Style Options and 

the Table Styles. Let’s start with Table Styles on the right. 

If I click on the dropdown to look at the Table Styles gallery I can start with the very simplest 

styles at the top and note the styles are divided into light, medium and dark. And the lightest of 

the Light styles is that one. It pretty much makes it look exactly where it was when I started. And 

then really the Styles get increasingly dark through the light range. Some of them have banding, 

some of them don’t. Note that there is both horizontal and vertical banding available. I’ll show 

you that in a moment. And you might have a horizontal rules, horizontals borders, vertical 

borders, and of course the colors change significantly as well. Some have headers, some don’t. 

You get down into the Medium range and generally speaking the overall look and feel is a bit 

heavier. And when you get down to Dark you’re into the much darker range of Table Styles. 

If you were basically going to print these out you probably would choose one of the lighter styles 

but obviously that’s a matter for your own choice.  

So that’s the Styles. I’m basically going to choose, I think I’ll choose that one for now. Now 

we’ll look at the Table Style Options. 

Now first of all at the top Header Row. Yes, I’ve got a header row. Notice over on the right there 

the Filter buttons. If you don’t want to see the Filter buttons you can switch them off. In a printed 

document like this invoice you’d hardly want Filter buttons. So I’m going to switch those off. 
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You notice the banded rows is selected. If I wanted banded columns as well I could do that and 

then I’ve got banded columns. I don’t really like that here so I’ll switch that off again. And I can 

have a Total Row. If you say that you have a Total Row what happens is a row is inserted and it 

totals the last column. By default you get a total in the last column. So let’s stick with that option 

and then let’s look at one or two other variations on that. 

Now let me just make the row that’s got the totals in it a little taller. And I want to demonstrate 

now some of the particular features of Tables that make them particularly helpful.  

By default as I pointed out just now when you have a total row it will total the figures in the last 

column, in this case those costs. But you can actually put totals in any of the other columns as 

well. So for instance, if I wanted to count the number of items in the order, so basically there are 

going to be five items. There are three of the first item and two of the second. If I click in here 

there’s a little dropdown to the right and that lets me choose what I want to include in there 

related to this column. So if I want a Count in there that says there are two entries, if you like, 

not two items but two entries, two rows. So it’s not a Count that I want. What I really want is a 

total. I want to add those up. So what I want is a Sum. And that will tell me that there are five 

items in the order. 

Clearly adding up the unit cost wouldn’t make any sense. And in fact totaling any of the others 

wouldn’t. But as you can see there are various functions there that may be useful when you’re 

dealing with a total column on a Table. 

And perhaps one of the most useful features of Tables is this. Let’s suppose that I was working 

with this for some time and then I decided that I want to actually remove a column. Suppose I 

wanted to get rid of the Unit Type column from the Table. Now that’s going to really be a pain 

potentially because I can’t just delete the whole of column D because I’ve got other information 

in column D. But if I put the cursor within this column, in this case column D and then go to the 

Home Tab and go over to the Delete button in the Cells Group you will see that there are a 

couple of contextual options there, Delete Table Rows and Delete Table Columns. Now I’m 

going to click on Delete Table Columns. Look very carefully at what happens within column D 

within the Table. And what happens is that that column is deleted within the table but not within 

the rest of the worksheet. So in effect the table is made less wide without affecting the rest of the 

worksheet. So I didn’t have to do a whole load of reorganization in order to remove that column. 

Let me Undo that. 

And of course conversely if I wanted to insert a new column in the list of items but I didn’t want 

to affect the rest of the worksheet I could say Insert Table Columns to the left and it would let me 

insert a new column in there and then I can go in and change the name and put in whatever data I 

want, again, without affecting the rest of the invoice. And again I’m going to Undo that one as 

well. 
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Now I just have a couple more things to point out to you about Tables. One of them is it’s very 

straightforward to delete a row that you don’t need. So I’ve left an empty row here. Again if I go 

up to the Delete command in the Cells Group on the Home Tab, Delete Table Rows will delete 

that one row. And of course when I selected a Style for this table I chose one where the total row 

is not formatted particularly prominently. I think I’m going to change my mind about that and 

I’m going to have more or less the same Style that I had before but I am going to highlight the 

total row a bit better. So let me change that. And then if I now wanted to add an item to this 

particular order all I would do is click somewhere within the table and then just go back to the 

Home Tab again, Insert, and Insert Table Rows and I get a choice of Insert Table Rows Above or 

Insert Table Rows Below. So if I wanted a new line item there below the existing ones it’s 

straightforward to put in. 

And just one other thing to point out while I’m here. If you look at the total in G24, it’s a very 

interesting formula because it says equals and then it says Subtotal function. But note that what 

it’s subtotaling is cost in brackets. It actually doesn’t do it on the basis of the column, in this case 

column G. It does it on the basis of cost which is the name of this column in the table. And this is 

related to what we did just now in terms of pointing out that you can insert and delete columns in 

a table and effectively change their numbers within a whole worksheet. So it can’t really say 

here, for example, that the subtotal here in G24 is a total of values in column G because if we 

change the table that might not be column G anymore. So it actually does it in terms of the name 

of the column in the table which is related to the name in the header. In this case the name being 

Cost. 

So there we are. That’s Tables. I’ll see you in the next section. 
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Chapter 23 – Shapes and Pictures 

Video: Inserting Shapes and Pictures 

Toby: Hello again and welcome back to our course on Excel 2016.  

In this section we’re going to look at inserting Shapes and Pictures into workbooks. And there 

can be many reasons for using Shapes and Pictures. I’ll be showing you one of those later on. 

And in fact that will be the basis of the next exercise on the course. But very often Shapes and 

Pictures are used as part of a presentation, to put together a schematic diagram. In fact 

workbooks can be used very successfully for drawing things like Structure Charts and even Gantt 

Charts associated with project management. And you can also use Shapes and Pictures to 

emphasize some of the key points being made on a worksheet. And in many cases just to sort of 

liven them up a bit, make them a little bit more interesting. And I’m intending to show you two 

or three aspects of these things in this section. 

Now one thing I must point out before we begin is that I’m only really going to show you some 

of the basic features. And in fact the area of Shapes and Pictures is a pretty vast one because you 

have a very large number of tools for working on Shapes and Pictures. And as with many other 

topics in Excel 2016 a lot of this is going to be down to you experimenting. So I’m going to 

show you some of the key things that you can do and then I suggest that you try to get as much 

practice with them as you can. 

Now another thing to point out before we really begin is that when you put a Shape or a Picture 

into a workbook it basically floats over a sheet. There are one or exceptions to this but generally 

speaking Pictures, Shapes don’t go into cells. They hover over one or more cells. And you can 

achieve interesting effects using things like transparency as we’ll see later on. But when you 

insert a picture or when you paste a picture from somewhere else onto a worksheet generally 

speaking it floats over the worksheet and it moves around independently of the worksheet. 

Now having said that you can actually set things up so that the shape is affected by changes say 

to row heights and column widths in the worksheet but it’s best not to think of a shape as being 

in a cell or in a group of cells. Think of it a bit like a chart, sort of hovering over a group of cells. 

Now the basic commands for inserting shapes and pictures are on the Insert Tab in the 

Illustrations Group and there are five options and I’m going to go through them one by one from 

the left and we’ll start with Pictures.  

Insert Pictures from File. If I click on Insert Pictures I can browse to one or more pictures to 

insert into my workbook. And having browsed to the folder containing the pictures that I want to 

include, let’s say go for this one. And once the picture is inserted a couple of significant things 

happen. One of them is that you’ll see the sizing handles around the picture. So I can resize it 

just using the mouse and keyboard like that. And the other thing, going back to what I was 
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saying just now about the picture floating over the sheet. If I click on the picture I can actually 

move it around. Of course you can do that with Touch as well, moving it around with your 

finger. 

And now let’s come to what I saying just now about the range of options that are available with 

Pictures. I’ve just inserted in here a regular photo. And if you look at the new tab that’s 

appeared, the Picture Tools Format Tab, that’s a contextual tab that appears for Pictures. There 

are many options on there and some of those options provide a huge range of possibilities. So for 

instance, starting at the left we have the Adjust Group. There is a Corrections option there where 

I can actually adjust the brightness and contrast in this image from within Excel. And you have a 

number of presets here and you can see in each case what the preset does. But if you click on 

Picture Correction Options you get a set of options in the Format Picture Panel on the right 

where you have much finer control over these corrections. 

Now as I said, I am not going to go through all of these. We would be here for a very, very long 

time if I did. I think it’s important that you try these things yourself. But let me just give you a 

couple of highlights. 

There’s Color. So you can change the Color. And of course with the live preview that’s available 

you can see fairly amazing effects within Excel. You can apply Artistic Effects. And if you use 

the Picture Styles options in the middle there you can even do things like frame the picture, 

rotate the picture, and all sorts of fairly amazing things to it. 

Okay further over on the right we have options for Picture Border, Picture Effects, Picture 

Layout. You can also align things with the picture. You can rotate it. You can crop it. You can 

adjust its height and width using the controls over here. And you can already see down here the 

Format Picture Panel which has a very wide range of options on it. If you right click on the 

image, this is another way normally of bringing up the Format Picture Panel. If you click on Size 

and Properties, and let me quickly demonstrate one thing I was telling you about before. If I click 

on the Properties dropdown here. By default it says Move but don’t size with cells. If I change 

that to Move and size with cells watch what happens if I change the width say of column Q here 

and drag it out to the right. It actually causes the picture to be stretched accordingly as well. Let 

me Undo that, go back to the original option and move Q out again. Of course in this case it 

doesn’t do that. Now again I’m not going to pursue that any great length but it’s an important 

point to be aware of. The Picture is hovering over the cells but you can make the cells affect the 

size and position of the Picture. 

So having finished using that particular image I’m not going to leave it in the workbook. It is 

selected. To delete it I just need to press the Delete key and it’s gone. 

Let me go back to the Insert Tab again and this time I’m going to choose Online Pictures in the 

Illustrations Group. Those of you who’ve used Microsoft Office before or perhaps even Excel a 

couple of versions ago would expect to see an option here to Insert Microsoft Clipart. Well 
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Microsoft Clipart has not been available for a while now, at least not via Microsoft in the usual 

way. And now when you choose to insert online pictures you have two choices. You can go to a 

SharePoint site that you have access to to get pictures from there or you can do a Bing Image 

Search.  

Now in order to do a Bing Image Search you click in the box on the right, type in the term you 

want to search for, press the magnifier there, the Search button or hit the Enter key, and you’ll be 

given a list of potential images that you can use that match that search term. You need to be 

careful here, particularly if you’re planning to use these images for commercial purposes because 

although the images generally come back under the terms and conditions of creative commons 

which you may or may not be familiar with, there may well be copyright or royalty 

consequences. And each of the images you need to check carefully before you use it for 

commercial purposes. 

Now doing a Bing Image Search and finding a suitable image is going to be one of the things I’m 

going to leave you to do in the exercise in the next section. So I’m not going to do it now. It’s 

pretty straightforward. And I’ve given you a small clue there anyway. But having identified the 

image that you want to use and depending on whether it’s some kind of photographic image or 

whether it’s a drawing of some sort then you’re going to be able to, for instance, get it to the size 

that you want using the techniques I’ve showed you already in this section, although I’m going 

to show you now where we’re going to insert shapes into a workbook. So I’m going to Close that 

and we’re going to move on to inserting Shapes. 

Now when it comes to inserting Shapes there’s a very large gallery of Shapes here. The top 

section, Recently Used Shapes, gives you access to the ones that you’ve recently used. Then you 

have lines, rectangles, basic shapes, etcetera. Let me show you some of the fundamental things 

you can do with this Pie Shape here. I’m going to choose Pie, click with the mouse, get the pie 

the size I want, release it, I’ve got a Shape. I can change the color of the fill using the Format 

Shape Panel. Let’s say change it to that color. I have a rotate handle above the shape there which 

I can use to rotate it. And beneath that rotate handle there’s another little control that lets me 

change the size of the pie. Now exactly what you get will depend on which Shape you’re 

drawing. But notice the contextual tab here is a Format Tab but it’s the Drawing Tools Format 

Tab. Now if I were to insert a second Shape onto the sheet I can work on either or both of them. I 

can Group them together and move them around as one, etcetera. Each of them has a textbox 

within it. So given that shape is selected click on Textbox, type some text, make it bigger, select 

it. Let’s make it bigger. Go to the Home Tab, make it much bigger, and so on. So there’s an 

awful lot of things that you can do with Shapes.  

And you can do things like choose the Shape Style. And you can arrange Shapes. So for instance, 

you can bring a Shape forward so that it’s not behind another shape as is the case here. So 

they’re the basics of Shapes. One very significant thing you can do with shapes which I think 

you’re going to find very useful in the next exercise is that with a shape selected you can 
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increase its transparency. And if I increase the transparency of this shape you can actually see 

what’s behind it. Now because you can’t put shapes in cells, if you put them over them you 

generally obscure what’s in the cells. But if you make a shape partly transparent then the content 

of the cells will show through. That’s another bit of a hint for you. 

Now the fourth option I want to look at is inserting SmartArt. And when you insert SmartArt 

you’re given a choice of SmartArt graphics. They’re arranged in categories. So let’s suppose that 

you wanted to insert a Hierarchy Chart, a very common one here. Click on that, click on OK and 

you get a default Chart, perhaps to show the management where you work. 

Now I’m not going to go into SmartArt in great detail here. Again, I’m going to leave you to 

experiment with this. But I just show you one or two key things about it. 

First of all, you’re given a structure to start with but you can adapt that structure as much as you 

like. So let’s suppose with this Hierarchy here where I’ve got say the boss at the top, maybe an 

assistant down here sticking out to the left here, and then three people that report to the boss. If I 

select that particular shape there up on the contextual Smart Tools Design Tab one of the options 

is to add a shape. Now if I say Add Shape After I’ll get somebody at the same level in the 

hierarchy but after that person. So what I basically get is a fourth shape at that level. If with that 

particular shape selected I then say Add Shape Below I get somebody that reports to that person 

in the hierarchy and so on. Now I can click in each shape. As I type into the shape Excel will 

adjust things like the font size to fit what I’ve typed into the shape. I can select shapes, change 

colors and I also have SmartArt Style. So once I’ve setup my hierarchy I can try these different 

Styles to change the appearance of this particular piece of SmartArt. 

Now the sort of thing that’s typical about SmartArt, as you can see here, is that when it comes to 

entering text to go into this organization chart you can either enter it in the panel on the left, type 

your text here, or you can enter it directly into each of the shapes in the hierarchy. So let me just 

finish entering the names. And when I’ve finished using the panel on the left if I need it I can 

close the panel, click away from my border there and there is my organization chart ready to 

include wherever I want to include it within my workbook. 

And apart from dealing with each shape within the Org Chart as a separate shape if I select the 

whole thing I can once again do things like resize the whole thing.  

The final option that I want to look at here is the option to insert a screenshot which is a facility 

that is common across the components of Microsoft Office nowadays. If you click on the 

dropdown at the bottom there it shows you any available window. So that’s maximized windows 

that you can include screenshots from. You can even clip the screenshot. So just take part of it. 

But let me include the whole screenshot on this occasion. This is actually a screenshot from File 

Explorer that’s running on my PC. So if I click on that what I get in my workbook is basically a 

screenshot of File Explorer. I could of course do all the other things that I’ve done to any 

pictures. This is a picture, not a drawing. So it’s like that photo we saw at the beginning. But I 

http://www.simonsezit.com/


Learn Excel 2016 for Beginners: Master the Essentials 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 
 

can do things like frame it, crop it, resize it, and so on. So that can be a very useful feature as 

well. 

So that’s been a bit of a whistle stop tour of Shapes and Pictures. But I hope you take some time 

to practice those things, to try those things out. And Exercise 08 that we’re covering in the next 

section will be a challenging little exercise covering some of the things that you’ve seen in this 

section. I’ll see you then. 
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Video: Exercise 08 

Toby: Hello again and welcome back to our course on Excel 2016. 

In this section I’m going to set you Exercise 08. And you can see in front of you now my answer 

to Exercise 08. It’s pretty straightforward. I’ve tidied up the latest version of the Shower Power 

Invoice and I’ve added a piece of ClipArt to the invoice. I’ve used some of the techniques that I 

described in the previous section. I’ve got a piece of online ClipArt. It’s actually royalty free, 

copyright free Microsoft ClipArt. You will need to find your own piece of ClipArt. Obviously 

you don’t need to use a duck but I thought something from the bathroom seemed quite suitable 

for an invoice for Shower Power. 

That’s my answer. I’ll see you in the next section.  

  

http://www.simonsezit.com/


Learn Excel 2016 for Beginners: Master the Essentials 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 
 

Chapter 24 – Formatting Cells Based on Content 

Video: Conditional Formatting 

Toby: Welcome back to our course on Excel 2016. In this section we’re going to look at 

Conditional Formatting.  

Now I’ve already spent quite a bit of time on the course looking at how to format worksheets, 

format cells and so on. But we’ve done it really, if you like, manually. We’ve looked at a 

particular situation and decided what color we want, what size of font we want and so on. 

Conditional Formatting is a feature of Excel whereby you can format one or more cells on the 

basis of their contents. 

Now I think the best way to demonstrate and explain this is with an example. So what I’m going 

to do is to take this particular book with a sheet of class grades in it and I’m going to choose the 

results of one quiz for the class, Quiz 1 in column B there and I’m going to Conditionally Format 

the contents of column B.  

Now at the moment we can certainly look at the scores in column B and perhaps scan down there 

and find out who did best, who got the best score and who had the lowest score and so on. But if 

I select all of the cells in column B and then on the Home Tab in the Styles Group go to the 

Conditional Formatting option, click on the bottom of that, then I have a number of options. And 

the first option I’m going to go for is right in the middle there, Color Scales. So let me go to 

Color Scales. There’s a little fly out menu there and what I’m going to do is to just hover over 

the first option. And you can see what the formatting is doing here because it uses a graded scale 

from a dark green to a dark red to indicate how well each student did in the test. The darkest 

green there is in row 7, Damian Foster who got 98. There are some other green bars there. So for 

instance Pancho Da Villa and Salto Ivaonovic, Ken Johnson, and Marie Russell all got in the 

90s. And then as you get towards the redder colors, for instance, Olivia Grace only scored 43 and 

Hector Parker only scored 43 as well. So Conditional Formatting gives you a way of seeing at a 

glance how well each student did in Quiz 1. 

Let’s do the same thing for Quiz 2 but this time I’m going to choose a different Color Scale. I’m 

going to choose that one. Now the way in which this works is just the same. The Color Scale you 

choose would depend on your specific requirements. You may, for example, need to match this 

to some other aspect of a presentation. But the general principle still applies. The best colors, in 

this case the dark blue, 97 there, row 5 for Pancho Da Villa. And then the lowest score the 

deepest red is row 16, Thomas Siggurdson with a score of 62. 

Now let’s look at what the other indicators look like. Let’s go for Essay 1 and in this case let’s 

apply Data Bars. Data Bars are bars of a certain length, in this case it’s going to be width within 

the cell. And you have a choice of gradient fill or solid fill. I’ll show you gradient fill. You can 
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take a look at solid fill yourself. And here the length of the bar is determined by the score. So the 

longest bar, row 14, Marie Russell. This is one of those exceptions that I mentioned a couple of 

sections ago where you can actually have tiny little graphics inside a cell. There are one or two 

instances where this occurs and this is one of them. 

Let’s try the other option. That’s Icon Sets. You can indicate the relative merits of the scores 

using Icon Sets. So let’s go for this set of traffic lights here. They go green, amber, red, and 

black. And of course the lowest score, row 3, Milly Clayton, has pretty much a black light. And 

the best score, well the best score is Hector Parker in row 12. 

So you can see there the main options for Conditional Formatting in terms of the graphics. Let’s 

go back to that dropdown again and this time what I want to look at is Managing the Rules 

because what has happened in each case is that a rule has been created and that rule has caused 

the formatting that you can see in the relevant part of the worksheet. Now when you bring up the 

Rules Manager, the Conditional Formatting Rules Manager it says Show formatting rules for the 

current selection. Well my current selection is a cell up in O2 but I want to look at the rules on 

the whole sheet at the moment. So I’m going to say this worksheet. And you can see that I have 

four rules setup. And you can see which range of cells each rule is applied to here. And if I select 

one of these rules, supposing I chose that Data Bar rule there. Having selected it I can go into 

edit the rule. 

Now the Edit Formatting Rule options, run through them from the top. What sort of rule would I 

like? Well if I want to format all cells based on their values, which is what I’ve done here, that’s 

the default. That’s fine. But I might want to format only cells that contain something. So for 

instance, I might want to format only cells that contain cell value between and I could say well I 

only want to format the cell values between say 20 and 50, something like that. I may want to 

say format only the top or bottom ranked value. So I might want to say only format the top ten 

values or the top 10% of values if I check that box. You may want to say format only values that 

are above or below average. So I might format only the values that are above average.  

Now when it comes to formatting, you’ve seen the use of the Icon Sets which is fine. But you 

can actually do bespoke formatting as well. I might say I only want to format the cells above 

average. I can click on Format here and I can say what I’d like to do with those is to give them a 

different color. So let me choose say that color for fill and I’m going to put a little border on 

them as well. So I’m going to put an outline round them as well. Click on OK, click on OK, click 

on OK yet again, and you can see there how I’ve created my own conditional formatting rule and 

I’m not using one of the standard sets of formatting. I’ve created my own bespoke formatting 

and applied it to the cells covered by that rule. 

You can do other things there as well. You may have noticed in the little dialogue. I could for 

instance have used a different font for those or perhaps represented those in a bold font, 

something like that. 
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Let’s look now at a couple of the other standard options that we haven’t so far considered. Let’s 

go for the midterm test in column F there. The top option, Highlight Cells Rules. We can 

highlight scores greater than, less than, between, equal to, text that contains, and so on. Let’s try 

a greater than test. Now in that case what we need to specify much simpler set of options. Format 

Cells that are greater than the value 86.5. Well supposing I change that and let’s say I want you 

to show me scores that are greater than 80 and light red fill with dark red text. What about green 

fill with dark green text? Click on OK and what you can see there is that only scores over 80 are 

indicated. And they have a dark green text on a light green background.  

The next one, let’s try Top and Bottom Rules. What about showing the top 10%? And showing 

the top 10%, let’s say the top 20%. And we’re going to say in this case, let’s put a red border 

round the top 20%. Click on OK and you can see that the top 20% of scores have a red border 

around them. 

Now at any time you may want or need to clear the formatting rules that you’ve created. So if I 

say selected again those scores in column G, click on Conditional Formatting. One of the options 

there is Clear Rules. And I have two options. Clear rules from selected cells or Clear rules from 

the entire sheet. And I think both of those tell you exactly what they do. That one would just 

clear the rule that I’ve got in column G. That one would clear all of the rules. 

Now let’s go back to one of the existing rules. So let’s go back into Manage Rules again and the 

rule that we can see is the rule for the current selection. So that’s the top 20% rule that we just 

added. Let’s go back to seeing all the rules. So we’re going to say Show the formatting rules for 

this worksheet. And you notice how where we have the range of cells that each one this applies 

to. We could actually go in and change that range. So for example, for this final rule, graded 

color scale, B2 to B20. I could apply it to B2 to N20. And now that rule is applied to all of the 

scores for all of the students in all of the tests.  

Any other existing rules may or may not be applied instead of or in addition to that depending on 

the sequence of the rules in this list but also dependent on this Stop if true condition here. Now 

let me just explain Stop if true with an example. 

If I go back to that very first rule, the very first rule up here, top 20%, which applies to column G 

is supposed to format the top 20% you see with a white background and with that black border 

round the edge. Well we’ve still got the black border round the edge in column G. But the actual 

fill color on that top 20% of scores has basically been overwritten by the graded color scale 

that’s coming from the bottom rule, the graded scale rule that was originally applied to column 

B. So we’ve got our border for these top scores in column G but the fill color is being changed. If 

I were to check Stop if true here and apply that what would happen is that when Excel found that 

top 20% of cells in column G, it would apply the black border and then say stop applying any 

other rule. So let me click on Apply there and those ones will now come out showing clearly as 

white with a black border. And the colors are not set by that later rule because we’ve said Stop if 
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true. Of course the cells that don’t come into the top 20% category are not affected by that very 

first rule. So they do get colored according to the last rule. 

I’m going to finish this section by demonstrating just a couple of other things. I’m going to 

remove most of the rules. I’m going to delete that rule and that rule and that one. I’m just going 

to leave the last rule that’s currently applied to all of the scores. And I’m going to edit that 

standard rule. So having it selected click into Edit Rule. And one of the important points to 

understand about this particular type of rule is that it’s based on a continuous scale. So the 

minimum corresponding to the darkest red is the lowest value, maximum corresponding to the 

highest value and the darkest green. And the sort of mid-amber, mid-yellow color in the middle 

there is at the 50%. Now some of the rules and the corresponding graphical representations 

correspond not to a continuous scale but to particular points. So if I change this from a three 

color scale, for instance, to an Icon Set, now in the case of an Icon Set with three traffic lights we 

need to define the thresholds corresponding to those three traffic lights. And that’s how we set 

these thresholds here. So we say green when it’s greater than or equal to 67%, amber when it’s 

between 33 and 67, and red when it’s below 33. Note that for the types here you can either say a 

percentage value or you can specify an actual number or a percentile in the statistical sense of 

putting things in sequence and marking the percentiles. Now depending on the Icon Set you may 

have a different number of thresholds to define. So for instance, let’s try these nice little blobs, 

green, amber, red, and black, the four traffic lights. In this case we’d need to define three 

thresholds to define the four ranges. So the defaults are 75%, 50%, 25%. I could change that one 

say to higher threshold of 80 and maybe the lower one to a lower threshold of 20. I can also at 

this point say whether I only want to show the icon in the cell and not the numeric value as well. 

Let’s say on this occasion that I want to show the icon only. Now having changed that standard 

rule, changed the thresholds, click on OK, click on OK to apply the rule. Now the middling 

colors are much more prominent now because you only get a green if you’re over 80 or a black if 

you’re below 20. But hopefully you can see what a clear visual indication that gives you. Now in 

reality you’d probably put some additional formatting in so that the word Absent is not quite so 

prominent there. But I’ll leave you with that perhaps as a little exercise to try yourself. 

That’s it on Conditional Formatting. I’ll see you in the next section. 
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Chapter 25 – Protection and Security 

Video: Protecting Worksheets 

Toby: Hello again and welcome back to our course on Excel 2016. 

In this section we’re going to look at protecting worksheets. In fact in the next section we’re 

going to look at protecting workbooks. But what we mean by both of those things is actually 

quite different. And in fact when it comes to protecting workbooks there are a number of aspects 

to consider. But let’s concentrate here on worksheets. And I’m going to return to the Shower 

Power Invoice because really as a practical workbook although we’ve really improved it quite a 

bit it still has some major flaws. And one of the main flaws in it is that although much of the 

content comes from might loosely be called our database, that’s the contents of the Catalogue 

sheet and the Customers sheet. The mechanism that we put in place to do this is actually very 

easily destroyed. Let me show you what I mean. 

Now for the purposes of this exercise I’m going to remove the duck for the moment. I might put 

it back on later. And I want to look at, for example, cell F17. F17 as you know has a formula in 

it. It’s a formula we derived in an earlier section. It includes a VLOOKUP on the Customers 

sheet. But let’s suppose somebody who wasn’t really very familiar with this invoice just typed in 

a date on there. They worked out the due date and they just typed in here something like the 1st 

of the 2nd 2016 and said tick and we had a date in there and everything looked fine. But then 

subsequently because nobody noticed that they’d overwritten the formula maybe we’d be 

surprised that due dates were always the 2nd of January 2016.  

Given that we calculate that date from the order date we should really protect that cell. In fact 

there are many cells on this worksheet that we should protect, including things like the headings 

where it says things like Due Date and Terms. So really the only cells that should not be 

protected are the ones where we will need to enter some data. 

Now there are very few of those. There is the Order Date, there is the Account Number, the Part 

Numbers for the products, and the Order Quantities for the products. Now ultimately when we 

add some of the missing information such as order number, purchase order and so on then some 

of those may need to be available as well. But pretty much everything else ought to be locked. 

And that’s exactly the term that we use in Excel 2016. We need to Lock those cells. 

Now first of all let me Undo that change I just made, put my Formula back in place. And with 

that particular cell selected what I’m going to do is to right click on it, click on Format Cells and 

if you look at the last tab in the Format Cells Dialogue it says Protection. And you may be a little 

surprised to see that that cell is actually already locked. Now you might look at and think well it 

doesn’t look very locked to me. We just managed to delete the formula and type a date in there. 

But cells that are locked on an Excel 2016 worksheet only locked if the sheet itself is in protected 
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mode, if you actually protect the worksheet. So let’s Cancel this and set about protecting the 

worksheet. 

So to protect the worksheet we need to go to the Review Tab. And one of the options there in the 

Changes Group is Protect Sheet. Now note the Screen Tip there. Prevent unwanted changes from 

others by limiting their ability to edit. For example you can prevent from editing locked cells or 

making formatting changes. 

Now when I click on Protect Sheet note the checkbox at the top, Protect worksheet and contents 

of locked cells. So when I click OK that’s exactly what will happen. But there are a couple of 

things to be aware of. First of all sometimes you may want to do this maybe just to prevent 

yourself from accidently changing something. So you may want to protect this sheet so that the 

locking works. But you may or may not want to do it with a password. If I type a password here 

to protect the sheet then the only way it can be unprotected is by the use of that password. So if 

you work in a team, you want other people to fill the invoices in and you don’t want them to be 

able to unprotect the sheet you can use a password.  

The other thing is that when the sheet is protected you may still want to let people do certain 

things. So for instance, if you look at the top here by default people are allowed to select locked 

cells and they’re allowed to select unlocked cells. Now what I’m going to say is I don’t want 

people to even be able to select locked cells. I don’t want them to be able to put the cursor in F17 

because there’s a formula there and even if they can’t change it I’d rather they couldn’t even 

select the cell and look at the formula. So I’m going to uncheck that. I am going to let them 

select unlocked cells. And that means they’ll be able to type content into the cells that I unlock. I 

should point out now that all of the cells on this sheet are currently locked. So I’m going to have 

to unlock the ones that I want people to access. But I’ll worry about that in a moment. 

Now the other options are other things that I can let people do. I could say well even though the 

sheet is protected I might still let people format cells or I might let people insert rows. Inserting 

rows of course might be useful when you’re dealing with an invoice like this and you want to be 

able to insert rows within the sheet so that people can add additional items. Alternatively you 

may just make an allowance say for ten items in the standard invoice and then not let people 

insert rows. But all I’m going to allow on this occasion is selecting unlocked cells. I’m not going 

to apply a password. I’m going to click on OK. The sheet is now protected. 

Now let me click in E17 or F17. Now I can’t. The cell or chart you’re trying to change is on a 

protected sheet. To make a change unprotect the sheet. You might be requested to enter a 

password. Now I’m going to unprotect the sheet. 

Now I suggested four cells that I might want to unlock. First of all the Order Date. Well it 

currently says today. Maybe I should unlock that one. Maybe I should treat =TODAY as a 

default on the basis that I may need to change that Order Date. For instance if somebody placed 

and order a few days ago and my invoice is a little bit late. So I’m going to unprotect that one. 
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Format Cells, Protection Unlock. And then I’m also going to unlock Account Number, the 

Product Code and the Order Quantity.  

Okay I’ve unlocked everything that I need to unlock. I’m going to now protect the sheet again. 

The same settings that I used last time and I’m still not applying a password. And there we are. 

Now notice now that the Order Date cell is selectable. The Account Number cell is selectable. 

But say that, Contact one there is not selectable, and the others are not selectable. I could put a 

different product code in there and I can change the quantity but everything else is locked. 

One very important point to be aware of is that each of the sheets in a workbook can have 

different protection. And in the case of the Catalogue sheet, for example, let’s suppose that it’s 

one member of staff’s job to look after the Catalogue sheet. I may want to protect this with a 

password and not let anybody do anything to it. So for instance, if I say here Protect Sheet. I’m 

going to put in a dummy password. Now I should point out that when you’re looking at any of 

these sample files where there is a password the password will be all lowercase and it will be 

pa55wd. So that’s like password with the two S’s as 5’s. So that’s the password I will use 

anywhere I use a password from now on. Note that I’m going to disable all options, click on OK. 

Now because I put password on there to make sure that I don’t think one thing and type another I 

have to reenter it which I’m doing. And note the cautionary message. And that sheet is now 

protected and every cell on it is locked. And without the password I can’t change anything. And 

with something like this effectively a reference list forming a catalogue for an Excel application 

it’s very likely that you would protect the information in this way. And the person who has to 

maintain that catalogue information would have the password, unprotect the sheet, make the 

changes they need to make, and then protect it again. And of course the same thing might well 

apply to the Customer sheet. It may even be a different person that looks after that one. 

That’s the end of this section. Please join me in the next one. 
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Video: Protecting Workbooks 

Toby: Hello again and welcome back to our course on Excel 2016. 

In the previous section we looked at protecting worksheets and we protected the worksheets of 

the Shower Power Invoice workbook. We’re now going to look at protecting workbooks. And 

one of the most obvious ways in which you may want to protect a workbook is to stop somebody 

from opening it. And that’s the aspect of protecting workbooks that we’re going to look at first of 

all. 

I have here version 08 of the Shower Power Invoice. The sheets are protected. Catalogue and 

Customers are protected so that only the maintainers can change them. Other people can see the 

information but they can’t select cells and make changes. The Invoice sheet is setup in the way 

that we left it setup before so that people can enter date, an account number and they can change 

product codes and order quantities but that’s all. 

If I want to protect the workbook itself to stop somebody from even opening it what I do is to 

save it but to Save it with a password. Now I’m going to save this as Shower Power Invoice 09. 

So select the course files folder, select the name 08 and change it to 09. And next to the Save 

button there is a Tools option with a dropdown and I select General Options. 

Now with the General Options I can specify a password to open which will mean in order for 

somebody to open the file at all they need a password. I can also specify a password to modify. 

And if I set a password to modify somebody can only modify that if they can both open the file 

and modify it. Therefore they would need both passwords. I am going to set both on this 

particular workbook and I’m going to set them both to be the same. Now that’s really bad 

practice but just so that you can open this workbook and modify this workbook later when you’re 

working with the course files yourself. I’m going to set them both to pa55wd. And the checkbox 

near the bottom there, Read Only Recommended is used so that when somebody opens this you 

do recommend that they open it Read Only. You don’t want to encourage them to modify it. So 

even for somebody who knows the modified password you’re still going to present them with the 

question, Do you really want to open this so that you can modify it? We will prefer it if you only 

open it Read Only. Now I’m going to choose that option, Read Only Recommended, and click 

on OK. Note that I normally would have specified two different passwords here. Click on OK. 

I’m asked to enter the open password again. That’s just as usual to make sure that what I typed is 

what I think I typed. And then I’ll also be asked to retype the password for modification for the 

same reason. Having entered both of those I click on Save and now Invoice 09 is saved. Let me 

now just close it and then we’ll try to reopen it again. 

And now I’m going to go to Open, Recent, Shower Power Invoice 09, and in order to even open 

it I need to put in the password. So I’ve typed in the password, click on OK and now it said Enter 

password for write access or open read only. Now if I click on Read Only I will be able to open it 
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but as you see when I’ve got it open in the header to the right of the file name it says Read Only. 

That means I can’t make changes to this workbook. Now of course in the case of an invoice 

workbook maybe that’s not such a bad thing because if I was going to print an invoice I could 

make the changes I want to make here, order date, account number, products and quantities, print 

out the invoice and then when I close the workbook I could close it without saving the changes 

because if I only needed printed copies of the invoice then I wouldn’t need to save the changes. 

But obviously that will depend on whether you’re handling these invoices on paper or 

electronically. 

So let me close this again now. Do I want to save the changes? Well I can say Save of course but 

it won’t let me because it was read only. Now let me reopen it again. Once again put in the open 

password. Now if I want to open it to modify I’ve got to put in the modify password, click on 

OK, again gets a recommendation that I open as read only. My answer is no, I want to open it 

full blown. And now the workbook is open and I can in fact modify it. Although of course with 

protected sheets I still can’t go into the locked cells without unprotecting the sheets, assuming of 

course that I can unprotect the sheets. 

So now we have another couple of instances of workbook protection to look at. You may have 

noticed on the Review Tab in the Changes Group next to the Protect Sheet or Unprotect Sheet 

button there is a Protect Workbook button. And you may have thought well that’s a bit strange. 

Isn’t that how I protect a workbook? Well in fact it isn’t because that particular button doesn’t 

protect the workbook but you can use it to protect the structure of a workbook. Let me just 

demonstrate that to you. 

In the current workbook, the Shower Power Invoice version 09, if I click on the Customers sheet 

I can change the order as you saw earlier on and I can move it before the Catalogue sheet. If I go 

to Protect Workbook this gives you a facility to protect the structure of your workbook. So if I 

want to protect the structure either with or without a password, on this occasion I’m going to use 

a password. I’m going to use the same password I’ve been using all along, pa55wd, click on OK, 

and then reenter the password usual way, click on OK. The workbook is now protected. If I tried 

to move the Customers sheet back to where it was note the No Entry sign that stops me moving 

anything. If I want to remove that kind of protection click on Unprotect and it’s no longer 

protected and I can move the sheets round again. 

A second important protection option for workbooks. Go into Backstage View. There’s a section 

here, Protect Workbook. And if I click on the little dropdown here you can see some of the 

options we’ve looked at already like Protect current sheet, Protect workbook structure, the one 

that I showed you just now. You can restrict access to a workbook which means that you can 

restrict which users are able to access workbooks. You can even add digital signatures to your 

workbooks.  
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Now this last couple of options I’m not looking at on this course but I do want to go back to one 

much earlier on in the list which is Encrypt with password. It’s a very important option to be 

aware of. Even if you protected a workbook so that somebody can’t open it, you’ve protected 

sheets, you’ve locked cells, whatever you’ve done. For people with enough technical knowledge 

they can actually open Excel workbooks in other pieces of software, not Excel that is. And can 

under some circumstances read the contents of your workbooks and the cells on your worksheets 

and so on. Now one way of just about eliminating the possibility of doing this, I should point out 

that it’s pretty much impossible to eliminate every possibility. But a technique you can use which 

is a very strong technique and which makes it very, very difficult for people to access the content 

of your workbooks is to encrypt the contents of the workbook.  

Now in order to do that you choose this option, Encrypt with password. Don’t be confused by the 

blobs already there. That’s just a dummy. I’m going to put in the same password now, click on 

OK and the workbook is now encrypted. If you encrypt a workbook it has no visible difference 

when you work on it in Excel. Many people would argue that particularly with workbooks it 

does slow the workbook down a little bit but for the vast majority of cases this will be so little 

that you probably wouldn’t even notice it. But it does mean that somebody trying to open your 

Excel workbook in a different piece of software and get round the other protection you put on the 

workbook almost without exception will not be able to read what’s in the workbook. Now it is 

true that very determined people who put a lot of value on what’s in your workbooks if they were 

clever enough, had enough information probably could get round this but it would be a very, 

very difficult thing to do. And getting round encryption is getting to be even more difficult 

nowadays because the encryption used in systems like Excel is very strong. 

So that’s an additional step you can take. As with all of the other kinds of password we put on 

here, let’s go back to that encryption, Encrypt with password. To clear the encryption, to clear 

the password at any stage all you need to do is to delete the password, click on OK, and in this 

case it will no longer be encrypted. 

And in general in Excel 2016 where you use either a compulsory or an optional password to do 

with protection of the workbook or worksheets in order to clear the password you really just 

clear the password field in a similar way.  

That’s the end of this section. Please join me in the next one. 
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Chapter 26 – Naming Items 

Video: Giving Items Names 

Toby: Hello again and welcome back to our course on Excel 2016.  

Now hopefully by now you’re starting to feel that your knowledge of Excel is getting up to a 

good level. And many of the tasks that you may want to perform with Excel you might well now 

feel confident in setting to work on. But there are still a few areas that we haven’t looked at at all 

yet and in this and the next few sections I’m going to cover those quite quickly but they will 

form a good basis for you to extend your knowledge and use of Excel. And in this section we’re 

going to look at the use of Names. 

I’ve mentioned Names once or twice already earlier on in the course but I’m going to now 

demonstrate just how useful Names can be. 

So let’s demonstrate this initially with the cell F5. $588. The formulae you can see there in the 

Formula Bar is =Reference!$E$2*E5. Now you may recall that what this represents is a 

multiplication of the budget flooring cost per square meter by the area of the dining room floor in 

square meters. Now somebody looking at this and maybe you looking at it in six month’s time 

when you’ve forgotten what you were doing can look at that and say, “What on earth is 

Reference!$E$2?” And what is sometimes a very helpful thing to do is to give some of the things 

that you use, for instance in formulae, names. It makes it a lot easier to remember what those 

things are. So let’s go to the Reference sheet and look at $E$2. 

Well $E$2, that’s the contents of cell E2, is of course the budget cost of flooring per square 

meter. But instead of referring to it by that rather clumsy reference I can give it a name. Now I 

like to give things meaningful names. Sometimes the names do get a little bit long. Obviously 

there’s a limit to how long and awkward you want the name to be. But one of the techniques for 

giving items names is to give them names by entering the names in the Name box. Now I’ve 

mentioned the Name box a couple of times already. It’s up here to the left of the Formula Bar. 

The Name box is not particularly wide. You can adjust its width using the little dividing line 

between the Name box and the Formula Bar. So I’m going to make the Name box quite a bit 

wider. And then all I need to do to give a name to cell E2, or rather to its contents, I just click in 

the Name box and start typing. Having entered the name hit the Enter key and the name is 

assigned. 

If when you do that you see a blank Name box, if you just click somewhere else on the sheet 

back in there you should see the name there. 

Now let’s go back to the Floors sheet and use that name. So back to Floors, back to cell F5 where 

I’ve got the formula with Reference$E$2 in it. Let’s delete Reference!$E$2. And now I need to 

put in that name instead. Now you may think well that’s rather a nuisance because I’ve got a bit 
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of typing to do now. But in fact what’s called the IntelliSense that’s in use here as I type will 

actually look for appropriate names as I start to type in the formula. So F-L and straightaway 

Excel has found the name, FlooringCostPerSquareMeter. So double click that to use it and it’s 

now using that Name in the formula instead of the rather awkward reference. 

So let’s tick that. Yep, $588. Let’s do a Fill Down. And as you can see my Name is now in use in 

the formula. And the formula is much easier to understand. 

So we’ve introduced a Name into this workbook. The next thing that we’re going to do is to go 

to the Formulas Tab. And in the Formulas Tab there is a group called Defined Names. And 

within that group there is the Name Manager. And this is another way of both defining, deleting, 

editing, maintaining in general Names in a workbook. At the moment this particular workbook 

just has one Name, the name we setup just now. You can adjust the widths of the columns here 

to check it. It’s FlooringCostPerSquareMeter. Its current value is $21. And it also tells us here 

which cell or range this Name refers to. The scope of the Name is the whole workbook. And at 

the bottom you can see where it refers to. 

Now let’s suppose that I want to add another Name and this time I’m going to do this Name in a 

rather different way. I’m going to say that I want a New Name and this is going to be, so that’s 

PaintingCostPerSquareMeter, scope is workbook. And this time I’m going to choose a cell on the 

Reference sheet that I currently have not got anything in. That’s E4. So I’m going to use 

ReferenceE4. Okay? Click on OK. Obviously at the moment it’s empty but the name now 

appears in the Name Manager Dialogue. I’m going to close that. I’m going to go back to 

Reference. And now of course, let’s put a value in there of, there we are. And now if I look in the 

Name Manager I’ll see that that particular Name has a value.  

If at any stage I don’t need a name anymore I can delete it. And at any stage if I’ve got a 

particular name and I want to change something about it select it, click on Edit and I get that Edit 

Name Dialogue. So it’s pretty straightforward really. 

Now we’re going to use Names in the final exercise on the course which I’m going to set you in 

the next section. But for the moment that’s Names. I’ll see you then. 
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Video: Exercise 09 

Toby: Welcome back to our course on Excel 2016. 

It’s time for the final exercise on the course. I should point out that there are still a couple of 

sections of new material to cover but this is the last exercise. 

And what I want you to do is to take the Refurbishment workbook that I’ve sort of pre-prepared 

for you as Exercise 09a and I want you to turn it into Exercise 09b. And of course my sample 

answer is in the usual place. 

Now what I need you to do this time is as follows. You’ve already got the budget cost of flooring 

and the budget cost of painting the walls setup. And they’re both setup as names. And I’d like 

you to treat those two values as locked on the Reference sheet of this Refurbishment workbook. 

So you’re going to need to deal with locking those two values. Mine is locked and if you need a 

password to look at mine the password will be the one that I used earlier, pa55wd, with all the 

letters lowercase.  

Now you should recall the way that I had the Floors sheet set out. I’d like you to set out a Walls 

sheet in the same way. And of course with the area of the walls you need to use a different 

Formula. I’ve giving you a little bit of clue here on the Room Sizes sheet because towards the 

bottom of that sheet I’ve got a Formula for the area of the floor. I’ve also got a Formula for the 

area of the walls. You’ll also see that for each of the rooms the height of the room is in column E 

on that Room Sizes sheet as well.  

So what we need to finish up with is a Walls sheet with all the calculations done and the cost of 

doing all the wall painting as a total. Also, just going back to the Floors sheet, let’s have a total 

cost, a total budget cost for the flooring as well. 

That’s Exercise 09. I’ll see you in the next section. 
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Chapter 27 – Finding and Replacing Words 

Video: Find and Replace 

Toby: Hello again and welcome back to our course on Excel 2016. 

In this section we’re going to look at Find and Replace. In fact the command we’re going to use 

is the Find and Select command that is at the right hand end of the Home Tab on the Ribbon. 

And Find and Replace is just two of the things that you can do using the dropdown menu from 

this command. We’re also going to look at one or two others. And the first one we’re going to 

look at is Go To. 

If I click on Go To I can go to a specific point in the workbook. Now I could type in a reference 

here. So for instance, I could type in Floors A1, click on OK. It’ll take me to that cell in the 

workbook. 

You will have noticed though one of the other options there was to go to and I could choose one 

of the names. So I could say take me to the PaintingCostPerSquareMeter cell. Click there and it 

takes me through to E4 on the Reference sheet. 

One of the ways in which most of the commands that are accessible from the Find and Select can 

be useful is if you’re dealing with perhaps a large workbook, perhaps one you’re not familiar 

with or one you’ve not used for a long time and you want to find particular things it is a great 

way of finding your way around. 

Let me look at another option. This one works in a slightly different way but will also illustrate 

something else about the use of these commands. 

Now note that I’m on the Reference sheet and I’m going to look for Formulas on the Reference 

sheet. Note the Screen Tip there, Go to Formulas. Now this only goes to the formulas on this 

particular sheet and there are none on this sheet. If I went back to the Floors sheet, note that cell 

A1 is selected. Try that again, Go to Formulas. This will go to the formulas on this sheet. And of 

course all of the highlighted cells there, each of them has a formula in it. 

So that’s pretty typical of the sort of thing you can do to find your way around a workbook using 

those commands. 

So they’re a good range of commands there that can be helpful in many situations but I want to 

concentrate now on Find and Replace. Note that the cell selected on this sheet is E5 and I want to 

find the word Room. So I’m going to click on the Find and Select and then select Find and I’m 

going to type in the word Room. And first of all let me click on Find Next. Now notice from E5 

Find Next it will find Living Room. That was the next cell after E5 where it found Room. It 
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didn’t go to Dining Room, it went to Living Room. If I click on Find Next it finds Room within 

the word Bathroom.  

One of the options I have is to do a Find All and this will find all of occurrences of Room. So 

let’s click on Find All and what I get is a little list down here that I can scroll through to find all 

occurrences of the word Room. However one thing you may notice is that all of those 

occurrences are on the sheet Floors. So let’s look at the options.  

The options say Find what? Well I’m finding Room. I can set a format and look for a particular 

format for that word but the key options I have are these. What am I searching within? What am 

I finding within? I’m finding within the sheet. What if I wanted to find within the workbook? 

Search by rows. So it’s going to search a row at a time. And that will normally explain the 

sequence in which it will find occurrences of what you’re looking for. And then you can choose 

what you’re looking in. You could be looking in Formulas, Values, Comments, etcetera. In this 

case I’m going to look in Values because I’ll only have Room as a word within a text value. I 

can say Match the case. What if I say Match case here? It wouldn’t have found Living Room 

because that’s got a capital R, but it would find Bathroom because that’s got a small R. So let’s 

say Match case. And you can also say whether you want to match the entire cell contents or just 

part of it. 

So having set those options let’s do a Find All again and it takes me to the first occurrences, 

Refurbishment Estimation. Let me just pull the bottom of the dialogue down. But you can see 

I’ve actually got quite a long list now of matches. And the matches cover several sheets. So if I 

want to go say to a particular match on the Floor sheet. If I click on that it’ll take me to that cell. 

And there’s Bathroom in B8 on the Floor sheet. 

Now let me run through an example of a Replace. If you look at cell B12 on this sheet you’ll see 

a reference to Master Bath. I think I may have written Master Bath in some places and Master 

Bathroom in others. Wherever it says Master Bath I want to change it to Master Bathroom but I 

don’t want to change Master Bathroom to Bathroomroom. So I need to make sure that I get 

exactly Master Bath. So the Find What I’m going to change and I’m going to change it to Master 

Bath. I’m going to say Match case and I’m also going to say Match entire cell contents. It must 

say all of and only Master Bath. I’m going to look in the whole workbook. I’m going to search 

by rows and I’m going to look in values. And I’m going to replace it with, click on the Replace 

Tab and put in what I want to replace it with. And I’m going to replace it with Master Bathroom. 

So let’s do a Find Next. It’s found Master Bath. When I click on Replace it will replace that one 

and find the next one. Okay that seems to be okay. It’s gone to the next one, Master Bath. I’m 

going to trust my replacement. I’m going to click on Replace All. We have made two 

replacements. Bear in mind that it had done one before which I did the first replacement that I 

did. So click on OK. And wherever it previously said Master Bath it should now say Master 

Bathroom. Three occurrences in total. That’s how to do a Replace. 
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That’s the end of this section. I’ll see you in the next one. 
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Chapter 28 – Borders 

Video: Adding Borders 

Toby: Hello again and welcome back to our course on Excel 2016. 

One last aspect of formatting that I want to cover is the use of Borders. You will have seen 

borders at several points during the course and in some cases such as when we started using 

tables on the invoice the borders were added automatically when we formatted the table. But if 

you need to add borders yourself it’s a pretty straightforward job to do, although in fact the use 

of borders in Excel 2016 provides a lot of flexibility. Now in order to explain and demonstrate 

borders to you I’m going to go back to the Opening Hours workbook that we worked on earlier 

on in the course and I’m looking at the proposed 2016 opening hours for our facility.  

And the first thing I want to do is to put a border around a single cell. Now to put a border 

around a single cell it’s pretty straightforward. If I say click on Wednesday there, if you go up to 

the Font Group on the Home Tab there’s a little dropdown and on the dropdown you have a list 

of available borders. The list is divided into sections and the larger upper section gives you 

standard borders. So for instance if I just wanted a bottom border on that cell I’d select the 

Bottom Border option. If I wanted no border I’d select No Border, All Borders I get all borders 

and so on. Towards the bottom I have the facility to draw my own borders and I’m going to show 

you how you can draw your own borders, sort of custom borders towards the end of this section. 

But to begin with let’s just say that we want a right border on this cell. So select Right Border 

and if I click away from the cell you’ll see the right border on the cell B6. It’s a very thin right 

border at the moment but you should be able to see it okay. 

Apart from setting that border the last border that I’ve used is also shown as the icon on that 

Border button that we used just now. So if I go back up there you can just about see, I hope, that 

Right Border is selected. And in fact the Screen Tip says Right Border. So if I wanted to use 

Right Border again all I would need to do is to select a different cell, say Thursday, click that, 

and automatically I get a right border on that cell as well.  

Now I’m not restricted to just one cell. So for instance, if I selected the whole of the range of 

cells containing information and clicked on Right Border then my selection gets a right border. 

Now this is the important point. It’s the selection. If the selection is a block, a range of cells like 

this then it’s the right border. So it would just be the border between columns D and E from row 

2 to row 12 that will get a border. So let’s click away and there you can see I’ve just got a right 

border there. 

If I were to now select a specific cell such as D4 and I could set a different border on that one 

specific cell. So for instance on that cell I could set a left border. And that setting of course 

doesn’t necessarily replace the setting that’s already there. So the fact that I already had a right 
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border on that cell, when I said Left Border effectively the left border is added. It doesn’t mean 

left border only. It means set a left border. If I choose a range within here such as that block of 

six cells and again click on the dropdown. If I said Thick Outside Borders that thick outside 

border would apply just to that selection. And in this case because we’ve set that thick outside 

border for cells D5, D6 and D7, that’s these three, of course what’s happened is that the right 

hand border that was there before the thin border has effectively been replaced by the thick 

border that was added when this selection of six cells had an outside thick border added.  

Generally speaking when you specify border settings they’re added, you add to what’s there, 

which may mean that they replace a previous border. 

Now there are various ways of clearing borders. Don’t forget that you can always use Undo. So 

in this case if I did an Undo I could remove that thick border. Let me just Redo it again. Other 

options include the fact that you can use the Clear button and clear format, although be aware 

that borders will be cleared but so will other formatting as well. So that’s not always a good 

option. 

Back to the Borders menu, a couple of things there. In the lower section, Draw Borders, there is 

an Erase Border option. It’s a little bit like an eraser. You can actually go and erase a section of 

border like that. The other option given the selection that I’ve got here. If I go back once again is 

to say No Border and then around that selection there is no longer any border. 

Now let me select the whole table of opening hours again and use No Border, click away. You 

see we have no border at all. Let’s now work on the whole of the opening hours table there. So 

let’s select the whole thing. 

Now one option would be to say well I would like all borders. And if I click on All Borders you 

get all borders. So all cells have borders around them. In this case thin borders. Now those thin 

borders of course look different where we have merged cells. Don’t forget that B2 is a merged 

cell and also B12 is a merged cell. 

And another option, let me just select the whole thing again, is back on the menu here to go to 

More Borders. Now More Borders takes us into the Format Cells Dialogue and one of the tabs in 

there is the Order Tab. And using this you can customize the borders that are currently on this 

table, in this case. Now you have a sort of preview picture here and what it shows is that we have 

thin borders on the outside. We have thin horizontal borders, thin vertical borders. 

Let’s suppose that I wanted to make the outer borders thick. Now one way of doing this would 

be to select the whole thing and use thick outside borders from the dropdown. But I can do it 

using the Format Cells Dialogue. Let me select the top horizontal first. Now when I click on 

something it removes the border. You see how that’s now blank? But if I click on this thick line 

to the left in the Style box and then click back on that top line again what that will do is to make 

the top border thick. Let me now click on the bottom row. That makes that thick as well. And let 
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me go for the middle vertical. That makes that thick as well. Click on OK. Let’s see what I’ve 

got. And you can see the top horizontal border is thick, the bottom horizontal border is thick and 

all internal vertical borders are thick. And in that way you can build up pretty much as complex a 

border as you wish.  

Now supposing I wanted the header to be like that. So let me go, just select the header, back into 

More Borders. My selection now applies only to the header. If I click on Outline that gives me a 

full outline. If I click on Thick, click on Outline again, that gives me a thick outer outline. Click 

on OK and that’s what I’ve now got on the selection. 

Let me go now to that middle column. That’s the selection that’s made. What I’m going to do is 

I’m going to leave the top border as thick. I’m going to select this thinner line here for that 

vertical. That vertical is not quite as thin but it’s fairly thin. And then what I’m going to do on 

the horizontal here is I’m going to choose a dot-dash line. Click on OK, click away. That looks 

absolutely horrible but hopefully you get the idea from that. 

Now as I say in that way you can build up pretty much any border pattern that you want to. 

Now when you’re working on borders you can basically mix and match your use of the menu 

and the Border Tab on the Format Cells Dialogue.  

A couple of other things here in the Format Cells Dialogue. Choosing the Style. You’ve seen 

examples of that. Different styles of line. You can actually also choose the color. Now note the 

selection I’ve got here. Let me just change the color here to let’s say quite a bright red and let’s 

choose a double line and let’s put that on this vertical here and let’s put it on both of the outer 

verticals. We’ll see that in just a moment. Note also the presets at the top. You’ve got a simple 

preset for saying None. You’ve got a simple preset for doing an outline and you can choose your 

style of line and your color first. You’ve also got a preset for doing a full set of inside borders. 

And then on these outer ones you’ve got individual buttons for things like top border, middle 

border and so on. There’s plenty there for you to experiment with. And one very good way of 

practicing this would to be go back to the Opening Hours workbook and try some of these things 

yourself. 

Let’s finally then take a look at these nice red double lines. There you are. Very attractive. 

That’s the end of this section. I’ll see you in the next one. 
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Chapter 29 – Workbook Inspection 

Video: Inspecting a Workbook 

Toby: Hello again and welcome back to our course on Excel 2016.  

By now you’ve probably produced quite a few workbooks and hopefully you’re becoming 

increasingly happy with what you’re producing. The time will probably come when you’re going 

to present, publish your workbooks to other people. And there are various things you need to be 

aware of before you let other people use your workbooks. There’s a facility within Excel 2016 

which you can use to check for certain issues that may exist and that may cause other people 

problems or that may actually compromise your own security. And we’re going to look in this 

section at a feature of Backstage View which can help you to make sure that you don’t get 

problems when other people start using your workbooks. 

Now I’m just going to use this Opening Hours workbook again. I’m going to go into Backstage 

View. And on the Info Page I’m going to look at Inspect Workbook.  

Now note the comments there about Inspect Workbook. Before publishing this file be aware that 

it contains comments, document properties, printer path, author’s name, etcetera, invisible 

objects, and content that people with disabilities find difficult to read. So let’s have a look at 

what these issues are. If you click on the Check for Issues button the issues are really in three 

categories. And I’m going to go through these one at a time. 

First of all, Inspect Document. Check the workbook for hidden properties or personal 

information. So let’s do that first. We then have a list of things that you might want to check. Are 

there comments and annotations in it? The sort of thing that can happen here is that if you’ve say 

been working collaboratively on a document there may be comments that people have made at 

various points in it where they’ve said, “I don’t like that bid. That needs to be changed.” Or “We 

can’t say that.” And it may well be that you want to make sure that any review comments or 

anything similar are removed before you publish a document, make it available to other people.  

Now there’s a whole list of potentially problematic things here you can check for. I’m going to 

check for the whole lot. So let’s click on Inspect. And most of the categories, you see I’ve got a 

nice tick saying there’s nothing there to worry about. But there are some things highlighted at the 

top. For instance, it found a comment. Now in this Opening Hours workbook you may remember 

we put in a comment about confirming opening hours for next year. You may or may not want to 

remove that. Of course it’s your option to leave it in. That may also flag to you the fact that that 

comment hasn’t been dealt with. 

We then have Document properties and personal information and it gives a list of various things 

that are in the workbook and you may want to go through and remove some or all of those. For 
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instance, let me close this down. Let’s go into Properties. I know that in the Advanced Properties 

I left the Author Name my name. So you may want to go through and do a bit of a clear up there. 

Let’s look next at Check accessibility. Check the workbook for content that people with 

disabilities might find difficult to read. The warnings that I get here, quite a limited list, but the 

warnings are about merged cells. You may or may not be aware of how people, particularly with 

visual impairment, work with workbooks. But in many cases they use screen readers. So they’ll 

open a workbook and they’ll have something that basically reads the screen, reads the workbook 

out to them. And very often this is one of the situations in which merged cells can cause a 

problem because the structure of the sheet is more complex and in describing and understanding 

that structure it’s much more complicated for somebody who has a visual impairment because 

they have to start to visualize complex arrangements of rows and columns. Now it may well be 

that you need to keep the cells merged and there isn’t a way around that but it may also well be 

and particularly if you’re concerned about users with accessibility issues that you can just 

achieve that in a different way. And it’s very often the case that if you are paying particular 

attention to use of your workbooks by people with various accessibility issues there are 

alternative ways of doing things. And it would be a good idea to look at something like this and 

say, “Is there a different way, another way of getting round this particular issue?” 

So that’s the use of the Accessibility checker. I’m going to close that down, go back into 

Backstage View and I’m going to look at the third option, Check compatibility. Check for 

features not supported by earlier versions of Excel. Now I mentioned already that if you work 

with other people with earlier versions of Excel then you probably need to avoid any new 

features, any features that have been introduced into Excel in recent versions. Now in this case 

there are no compatibility issues found. So if you wanted to provide this workbook to somebody 

else in one of the old formats you could save it in an older format, provide them with this Excel 

workbook and they shouldn’t have any trouble with it at all. 

Note also the option there, that checkbox down there. Check compatibility when saving this 

workbook. This is often a good option to use because it means that while you’re working on the 

workbook, as you’re developing it, Excel is going to flag to you any compatibility issues each 

time you save the workbook. So you don’t sort of save all your problems up until the end when 

you inspect the workbook. 

So that’s it. That’s the three categories of inspection. That’s the end of this section. I’ll see you in 

the next one. 

  

http://www.simonsezit.com/


Learn Excel 2016 for Beginners: Master the Essentials 
 

© Copyright 2008-2016 Simon Sez IT, LLC. All Rights Reserved. 
 

Chapter 30 – Privacy Options 

Video: Trust Center Privacy Options 

Toby: Welcome back to our course on Excel 2016.  

In this section I want to look at one of the Excel Options or I should set of Excel Options that we 

haven’t looked at so far in any detail which is very important from the point of view of security. 

So I want to go into Options and we’re going to look at the Trust Center. 

Now let’s go to the Trust Center settings first of all. There are only two or three of these I 

particularly want to look at now but there are some others which will be particularly important to 

you as and when you start programming, writing your own code in Excel, if that’s going to 

happen. But I want to start with the Trust Center Privacy Options.  

It’s very important to understand the implications of these Privacy Options. For instance by 

default, Send personal information to Microsoft to make improvements to Office. Now I’ve got 

that checked. That personal information is being sent to Microsoft. You need to make sure that 

you’re happy with that. Let Office connect to online services from Microsoft to provide 

functionality that’s relevant to your usage and preferences. Now it’s a little bit vague about what 

that is but bear in mind that once you start using things like Translation, Research, Help, and so 

on virtually all of those things rely on online connections. And if you’re not happy about online 

connections then you might need to consider disabling some of those things. But you do need to 

understand that in consequence you may be disabling other online facilities which means that 

certain things won’t work. 

Still on the Privacy Options page, the Document Inspector option here takes you back to the 

document inspector that we saw in the previous section. And then you have Research and 

Reference, Translation options, and Research options. Now with each of these it take you 

through to a dialogue with a list. In this case of Languages for the Translation options and for the 

Research options which dictionary to use. Mine’s setup to use the UK (English) Encarta 

dictionary. And then for Research sites the version of Bing that’s being used and so on. So there 

are some important settings there and it’s a good idea to make sure that they’re set appropriately 

for you. 

Now the next area that I want to look at is Protected View.  

One of the things that will happen probably and may already have happened is that other people 

send you workbooks. And a lot of the time they’ll be from people you know and trust and they 

won’t be a problem. But if you are going to, for example, get a workbook from a source you 

don’t know, maybe you’re going to download one, somebody you don’t really know is sending 

you a workbook. That workbook may well have program code in it or other content in it which 

might harm your computer. And one way of reducing the chance of harm is to tell Excel that 
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when it gets workbooks from other sources it should open them in Protected View. And the set 

of options I’ve got here, all three checkboxes checked, means that, for example looking at the 

first option. For files originating from the internet they’re opened in Protected View. Protected 

View restricts what those files can do and it restricts what I can do to those files. But if I open a 

file I decide that I’m happy with it I can then switch Protected View off and work on it fully and 

safely. Whereas if I’m really not sure about something and I just want to sort of open it and have 

a quick peek and see what it’s about, if I open it in Protected View there’s virtually no chance of 

it doing any harm to my device. So once again check your Protected View settings. 

And the other settings that you should check are your Macro settings.  

One of the most prevalent ways of Excel workbooks causing problems on your device is when 

they run macros and macros can do all sorts of damage. By default I have my Macro setting at 

Disable all macros with notification. If I open a workbook that isn’t mine and there’s a macro in 

it that tries to run it won’t be able to run. And in order to run Excel will say to me, “Do you want 

to allow this workbook to run Macros?” If I trust it I’ll say Yes and if I don’t I’ll say No. 

I suggest that you have that set at the setting I have there. You can, for instance, set up a more 

sophisticated version of this by, for instance, trusting certain types of documents, trusting 

publishers, trusting documents from certain sources. And there is a set of settings here at the top 

of the Trust Center, Trusted Publishers. I have two there. These document publishers, if I get 

workbooks from them I trust them. So the Roland Corporation and OpenVPN Technologies I 

trust. If get anything from them then they will open without any restrictions anyway. 

You can also say that documents you’ve stored in specific locations you trust. So if you get a 

document from somebody, even if you’ve got the Safe setting set on and you know that you trust 

that person you can put the document there and because of its location it will be treated as 

trusted. You can also have specific trusted documents. 

So I’ve covered the basic Trust Center settings. Very important that you run through the ones 

that I’ve covered and make sure that they’re set appropriately for you. 

That’s the end of this section. Please join me in the next one. 
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Chapter 31 – Sharing Options 

Video: Sharing a Workbook 

Toby: Hello again and welcome back to our course on Excel 2016. In this final section on the 

course I’m going to look at sharing workbooks with other users.  

Now one way that you can easily Share a workbook is to save it to a shared location. And 

traditionally this has been something like a shared drive on a network. Perhaps if you use Excel 

at work and you and your colleagues share a network you could save a workbook in one of the 

network locations and one of your colleagues could open it from the same location and work on 

it. But sharing in this way is not always possible and it’s not always the best way to do things. So 

in this section I’m going to look at some of the main alternatives and we’re going to begin with 

one of the ways of sharing which is pretty straightforward which is to actually send the 

workbook to somebody else. 

Now I’m going to use the Opening Hours workbook for this. To some extent it doesn’t really 

matter which one I use here to demonstrate these techniques. 

So let’s first of all click on File and then click on Share and one of the options, the second option 

there, is Email. Now the main email options there are highlighted. You can send the workbook as 

an attachment to an email. So people will actually get a copy of the workbook. And of course 

subject to any restrictions you might have put on it they may well be able to work on the 

workbook and perhaps email it back to you. This is a pretty straightforward option, Send as 

attachment. And provided that your email client is setup successfully you’ll get something like 

this happening. Now my email is Outlook 2016 so that’s what it looks like. If you have another 

email client setup it may look different to that. The important thing is that you can see that the 

workbook itself has been attached to the email. So I could address the email, perhaps type a 

message, click the Send button and that sent somebody a copy of this workbook. 

So I’m going to send a copy of that to myself using one of my other email addresses. I should 

point out that is an unmonitored email address. So anything that gets sent there normally is 

completely ignored. And I’m going to send it to myself and we maybe look at that later. 

And what we’ve just done there specifically deals with the situation where we’re sending a copy 

of the workbook to somebody who has Microsoft Excel or another piece of software that can 

open Excel workbooks. If somebody doesn’t have Excel or you don’t want them to be able to 

open it and work on the workbook you can send them a copy of the workbook just to read, just to 

look at, something that they can almost certainly read but not change. And two of the options 

there are to send it as a PDF, and Adobe Portable Document Format document or to send it as an 

XPS document which is Microsoft’s equivalent of PDF format. So those two options let you send 
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somebody almost a printout of the document. It’s a little bit more sophisticated than that but the 

important thing is that they’re not getting the workbook itself. 

Now the bottom option, Send as internet fax. Not a lot of people use that nowadays but it’s still 

there. The second option, if you save the workbook to a shared location you can use this option 

to send people a link to the workbook. Now you might use this in a situation where you actually 

have a shared location and you just want to say to people look I’ve put this workbook in the 

shared location and here’s a link to that location. 

So there are the email options. 

What I want to look at next is the option to Share with people. 

When it comes to sharing with people it’s really a two step process. Step one, save your 

document to a OneDrive location. Step two, Share your document. We’ll do this after you’ve 

finished saving. 

Now generally speaking the shared location that we use now for sharing with people is Microsoft 

OneDrive. And if you have a Microsoft account you almost certainly have some OneDrive space 

and almost certainly you have at least some free OneDrive space. Microsoft accounts include 

email accounts such as Hotmail.com accounts or Live.com accounts and so on. And the account 

under which I’m running Excel has OneDrive space. So the first thing I’m going to do is to Save 

this document to the OneDrive location that have as part of my account. That’s what will happen 

when I click on Save to Cloud. So I’ll do the Save first and then I’ll do the sharing. So Save to 

Cloud. There’s my OneDrive location up there, double click on the OneDrive folder and now 

I’m able to Save in my OneDrive location so I’m going to click on Save. And that workbook is 

now saved in that OneDrive location. 

Now let me go back to Share again. Now you can see the option is enabled to Share with people. 

So click on Share with people. Now on the right you can see the Share Panel has opened up. And 

here I can invite people who I want to share this document with. Now before I do let me just look 

at the little dropdown below there. I basically have two options when I Share something. I can 

say people I’m sharing it with can edit it or people I’m sharing it with can view it. On this 

occasion I’m going to share it with myself via that other account and I’m going to give myself 

permission to edit the document. So invite people. I can actually use my Address Books from the 

right there. So if you have an Address Book setup you could select people to share this document 

with from the Address Book. I’m going to type in the specific address of the person that I want to 

share it with. Then a message and I click on Share. And the document is now shared with that 

other user. 

What I’m going to do now is to login to my Microsoft account as that other user and we’ll just 

see the recipients end of this sharing process. 
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So I’m at Live.com and I’m going to login in as Toby.A. So here is the sharing message as seen 

by me in Outlook.com. Toby Arnott wants to share Opening Hours. Click on that. Note the 

message. Hi Toby, This workbook is now shared with you. Enjoy. Let’s open it up, Opening 

Hours. I get a security warning but I’m safe to trust this one. Again. And this particular 

workbook will open in Excel online. So this is the online version of Microsoft Excel rather than 

the desktop version. If the recipient of the invitation to share has a desktop version of Excel then 

they’re going to be able to switch to open it in their desktop version. On this occasion I would 

just work on it in Excel online. You can do most of the regular things that you might want to do 

to such a workbook in Excel online. It’s not as restricted as it used to be but many people, 

including me, still prefer to use the desktop version of Excel when they can. 

So there you are. I’ve shared the workbook with the other account, with the other version of me. 

The other version of me has got the workbook open and the other version of me can go in and do 

a bit of work on it now if I want to. 

That’s the end of this section. This is the last section on the course other than a brief closing 

section to follow. See you in the closing section. 
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Chapter 32 – Recap 

Video: Recap 

Toby: Hello again and welcome to this closing section in our beginner to intermediate course on 

Excel 2016.  

By now I hope that you’ve got a good level of confidence in your use of Excel 2016 but I’m sure 

that one thing you will have realized is that there is plenty more to learn. And it’s worth looking 

out for our advanced training course where we cover a lot more about formulae and functions. 

We also look at Data Analysis and Pivot Tables and do a lot more work on Charts and Graphs, 

including such features as Sparklines. 

Another very important feature of our advanced course is the coverage of methods of connecting 

to other data sources from Excel.  

I hope you’ve enjoyed this basic to intermediate course as much as I’ve enjoyed preparing it and 

presenting it to you. And I look forward to seeing you online again soon. 

That’s it from me. Bye for now. 
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